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CHAPTER 1: Welcome!
About HEMS
The HEMS Enterprise 5.x system (HEMS) is a state‐of‐the‐art preventive maintenance program 
that provides you with all of the tools you need to manage every aspect of your hospital’s opera‐
tion and the clinical and plant equipment within it.

With HEMS, you can:

• Improve patient care by delivering critical clinical and plant asset data to key personnel 
throughout the facility. Clear, comprehensive reports on the environment of care, technology 
acquisitions, equipment downtime, and maintenance help managers improve quality of care 
as well as equipment reliability and availability.

• Reduce risk to both patients and staff by monitoring and managing clinical and facility equip‐
ment risk. HEMS Enterprise 5.x provides risk analysis for all equipment types and models, col‐
lects and archives all equipment incidences and documents all recalls, alerts, and the 
corresponding actions taken to resolve them.

• Reduce health care delivery costs by capturing critical equipment performance and mainte‐
nance data to enable informed decisions to be made on when and why to replace it.

• Improve maintenance service by establishing service priorities and providing benchmarks 
for response and completion times. Detailed reports on events that do not meet benchmarks 
and customer satisfaction surveys enable department managers to initiate improvements.

• Comply with regulations by providing reports that bundle a variety of necessary information 
into clear, actionable reports to identify positive and negative trends related to key require‐
ments from such organizations as the Centers for Medicare & Medicaid Services, The Joint 
Commission, College of American Pathologists, and others. HEMS provides you with the 
information you need to prove your compliance with regulatory agencies.

HEMS can generate scheduled work orders through the Preventive Maintenance (PM) program 
and corrective work orders on demand. EQ2 supports and will integrate any of the standard 
equipment nomenclatures (ASHE, AAMI, or ECRI) and procedures to your standardization pro‐
cess. Please contact EQ2 directly for information and a quote for standardizing processes for 
existing data.

HEMS also includes:

• A risk assessment program that allows you to define your equipment risk management pro‐
gram. 

• Classifications to help you meet TJC regulations pertaining to setting up your utility manage‐
ment program and guidelines for life support.

Note: For simplicity, this guide will refer to the HEMS Enterprise 5.x system as 
“HEMS” throughout. 
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• A robust array of reports that use Microsoft® Reporting Services. You can also integrate 
optional third‐party reporting tools. Please contact EQ2 for more information.

Features and Benefits
Each department in a health care organization—Facilities Engineering, Clinical Engineering, 
Safety, Information Services, Environmental Services, etc. —views its own responsibilities as 
being specific to the services it provides. For example, clinical engineers repair, install, and test 
many kinds of equipment from defibrillators to imaging equipment. Facility engineers maintain 
equipment such as HVAC and electrical power systems. Engineering needs access to its own 
information and the ability to share that information with management, the safety committee 
and other departments. Groups also often exchange information with other departments and 
the safety committee.

HEMS provides all of the benefits of a standardized equipment management program without 
the obvious deficiencies of systems that require a single data view for all Service Areas. Each Ser‐
vice Area has its own unique view of the information it needs to run efficiently. HEMS ensures 
that Service Areas only see the information they need. With HEMS, every technician can use 
handy dashboards to manage:

• The work s/he is responsible for.

• Pending work assignments.

• Work order opening, updating, and closing.

• Reviewing relevant reports.

HEMS eliminates paper reports and time‐consuming performance review meetings. Engineering 
Management personnel can either use the HEMS dashboards to review the performance of a 
particular service department or access performance information across several enterprise‐wide 
service departments. With one click, managers can access graphical reports that show:

• Work order completion rates for individuals and departments.

• Monthly preventative maintenance work schedules.

• Completion rates for preventative maintenance work orders.

• Service hours and costs by both single and aggregated departments.

• Equipment replacement details and schedules.

Need to add a service department or set up a new site, such as a new hospital or outpatient 
clinic? No problem. HEMS quickly and easily scales to your enterprise's size and complexity. 

The HEMS Best Practices version automatically forwards a copy of your organization’s published 
practices to new sites or departments. This immediately lets new staff members know how to 
maximize their contribution to the parent organization. HEMS Best Practices ensures that any 
new Service Area will succeed no matter where it is located.
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What’s New in HEMS Enterprise 5.x
HEMS Enterprise 5.x includes the following new features:

• Fully automated risk and scheduling.

• Automated reports from any window.

• Automated and interactive history review.

• Automated service contract renewal notices.

• All‐new Work Orders dashboard that lets you find, report, open, close, and edit work orders.

• All‐new Equipment Inventory dashboard that lets you find, report, open, close, and edit 
equipment, open work orders, and review histories and contracts.

• Export data to Adobe® Acrobat® (PDF), Microsoft Excel®, and email formats.

• Ability to attach pictures and documents to work orders, equipment, type, model, and ser‐
vice contracts.

• Monitor work events that exceed preset response or close time thresholds.

• Microsoft SQL Server 2005‐2008® ACID‐certified database keeps your sensitive information 
secure.

• Pocket PC‐based access to HEMS.
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About This Guide
This guide provides comprehensive information about using and administering HEMS and also 
uses specific formatting conventions to present special information such as lists, procedures, 
cautions, and tips/hints.

Organization
This guide is organized as follows:

• Welcome: Introduces HEMS and this User & Administrator Guide.

• The HEMS Interface: Describes the HEMS interface in detail. This chapter begins on page 13.

• Adding Values to Fields: Discusses the HEMS search function and describes how to use pre‐
set values to increase speed and accuracy when entering information into HEMS. This chap‐
ter begins on page 49.

• Work Orders: Describes the Work Orders dashboard and provides detailed instructions on 
working with HEMS work orders throughout the complete life cycle from opening to closing. 
This chapter begins on page 55.

• Managing Equipment: Covers the Equipment Inventory dashboard and how to find, add, 
modify, and remove equipment. This chapter also describes how to assign and modify equip‐
ment attributes such as type, model, location, parts, etc. This chapter begins on page 85.

• Information Lists: Describes the HEMS Information Lists and how to access and work with 
each list. This chapter begins on page 123.

• Managing Parts: Contains instructions for managing parts within HEMS. This chapter begins 
on page 169.

• Managing Risk: HEMS uses the ASHE risk scoring model to assign risk to equipment by 
model, type, or individual equipment item. This chapter begins on page 179.

• Managing Contracts: HEMS stores service contract information that can be applied to equip‐
ment. This chapter begins on page 183.

• Reports: Lists all of the reports available in HEMS and describes the information contained in 
each report. This chapter begins on page 195.

• Finding Data: Shows you how to quickly find the information you’re looking for in HEMS. This 
chapter begins on page 219.

• Printing & Exporting Data: Describes how to print HEMS data or export it for use in third‐
party applications. This chapter begins on page 233.

• Administration: Provides detailed administration and management instructions for HEMS 
administrators. This chapter begins on page 237.

• Help & Support: HEMS includes robust help and support options to help you get the most 
from the system and resolve any problem that may occur. This chapter begins on page 273.
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• Add‐on Modules: Briefly describes some of the most commonly used HEMS add‐on modules. 
This chapter begins on page 281.

Formatting Conventions
This manual uses several formatting conventions to present information of special importance.

Text
Lists of items, points to consider, or procedures that do not need to be performed in a specific 
order appear in bullet format:

• Item 1.

• Item 2.

Procedures that must be followed in a specific order appear in numbered steps:

1. Perform this step first.

2. Perform this step second.

Specific keyboard keys are depicted in square brackets and are capitalized, for example: [ESC]. If 
more than one key should be pressed simultaneously, the notation will appear as [KEY1]+[KEY 2], 
for example [ALT]+[F4].

Interface elements such as document titles, fields, windows, tabs, buttons, commands, options, 
and icons appear in bold text.

Menus and submenus are indicated with the notation Menu>Submenu. For example, “Select 
Activities>Work Order” means that you should first select Activities in the menu, and then 
select Work Order in the submenu.

Special Information
The following icons and text format appear throughout this document to provide additional 
information that complements the main text where necessary:

CAUTION: CAUTIONS INDICATE A POSSIBILITY OF UNPREDICTABLE RESULTS 
AND/OR DATA LOSS IF THE SPECIFIED PROCEDURE IS NOT FOLLOWED OR IS 
FOLLOWED INCORRECTLY.

Note: Notes provide tips, hints, and other useful information to make using 
HEMS faster and easier. 

AUTHORED BY ANTHONY HERNANDEZ - (415)786-2081 - anthony94122@outlook.com
6 January 2010 - Revision 1.0



HEMS Enterprise 5.x User & Administrator Guide
Logging into HEMS
To log into HEMS:

1. Launch HEMS by double‐clicking the HEMS Enterprise icon on the Windows® desktop.

2. Enter your login credentials:

‐ If HEMS is set up using HEMS built‐in security, the Logon 
to HEMS Enterprise window appears. Enter your user‐
name and password in the appropriate fields and then 
click OK.

‐ If HEMS is set up using Windows security (LDAP), enter 
your Windows password (you don’t need to enter a user‐
name) and then click OK.

Please see “Password Management” on page 249 for more information on password secu‐
rity.

3. The HEMS Home screen appears. Please see “The Home Screen” on page 14 for more infor‐
mation about the Home screen.

If HEMS is set up to use Windows security, then your password will function the same way with 
HEMS as it does when you log in to your network.

Note: By default, you may log into HEMS from multiple locations. Contact your 
HEMS administrator to disable this feature, if required.
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CHAPTER 1: Welcome!
Common Tasks
This section briefly describes how to perform some of the most basic functions within HEMS. 
Please refer to the indicated cross‐references for additional details and information. Please see 
“CHAPTER 2: The HEMS Interface” on page 13 for more information about the HEMS interface.

Work Orders
Work orders are requests for work to be performed on equipment items for repair, maintenance, 
etc. Clicking the Work Orders button in the HEMS Home screen (see “The Home Screen” on 
page 14) or clicking the Work Orders tab opens the Work Orders dashboard.

Please see “CHAPTER 4: Work Orders” on page 55 for more information about working with work 
orders in HEMS, “The Work Orders Dashboard” on page 17 for more information about the Work 
Orders dashboard, and “The Work Order Window” on page 60 for more information about the 
Work Order window.

Looking Up Work Orders
Enter your desired search criteria in the Search Area and then click Search to display all matching 
work orders in the Search Results Area. Selecting a result displays the work order in the Detail 
Area. By default, HEMS displays pending work orders.
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Opening a Work Order from the Work Orders Dashboard
You may either create a new work order or copy from an existing work order. New work orders 
may be pre‐filled with information depending on how you set up your default work order set‐
tings. Please see “Work Order Defaults” on page 247 for more information about default work 
order settings.

• To create a new work order, click the New button in the Action Area to open a Work Order 
window where you can create a new work order. Please see “Creating a Work Order” on 
page 72 for more information about creating work orders.

• To create a new work order based on an existing work order, find the work order you want to 
copy and then click the Copy button in the Action Area. This opens the Work Order window 
with fields automatically filled based on the current work order. Please see “Copying Work 
Orders” on page 75 for more information about copying work orders.

Updating/Editing a Work Order
To edit a work order, find the work order you want to edit and then either click the Edit button in 
the Action Area or double‐click the work order in the Search Results Area to open the Work 
Order window for the selected work order, allowing you to make changes as needed.

Closing a Work Order
To close a work order, find the work order your want to close and then click the Close WO button 
in the Action Area to open the Work Order window for the selected work order. Enter your labor, 
action text, and any other additional information, and then click the Save button in the Toolbar. 
You will be prompted to save any unsaved changes when you close the Work Orders window.

Note: You may also create work orders from the Equipment Inventory dash‐
board, as described in “Opening a Work Order from the Equipment Inventory 
Dashboard” on page 121. Work orders created from the Equipment Inventory 
dashboard are automatically populated with the equipment’s information such 
as department, location, assigned engineer, etc.
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CHAPTER 1: Welcome!
Equipment Inventory
You can find and manage equipment using the Equipment Inventory dashboard. Clicking the 
Equipment Inventory button in the HEMS Home screen (see “The Home Screen” on page 14) or 
clicking the Equipment Inventory tab opens the Equipment Inventory dashboard.

Please see “CHAPTER 5: Managing Equipment” on page 85 for more information about manag‐
ing equipment in HEMS, “The Equipment Inventory Dashboard” on page 22 for more information 
about the Equipment Inventory dashboard, and “The Equipment Inventory Window” on page 89 
for more information about the Equipment Inventory window.

Looking Up Equipment
Enter your desired search criteria in the Search Area and then click Search to display all matching 
equipment items in the Search Results Area. Selecting a result displays the equipment item in the 
Detail Area. By default, HEMS searches active equipment.

Looking Up Equipment History
To look up history on an equipment item, find the equipment item you want to review and then 
click the H button to open the Equipment History window for the selected equipment item.
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Opening a Work Order from the Equipment Inventory Dashboard
To create a work order for the selected equipment item, check the appropriate Work Order Type 
radio button (such as Routine or PM), and then click the Create WO button to open a Work 
Order window. One benefit of opening a work order from the Equipment Inventory dashboard 
(as opposed to the Work Orders dashboard) is that the equipment information such as depart‐
ment, location, assigned engineer, etc. is automatically populated for you. Please see “Opening a 
Work Order from the Equipment Inventory Dashboard” on page 121 for more information about 
opening work orders.

Adding Equipment to Inventory
You may add a new equipment item to HEMS or copy an existing equipment item.

• To add a new equipment item, click the New button in the Action Area to open a blank Equip‐
ment Inventory window where you can add a new equipment item. Please see “Adding 
Equipment” on page 116 for more information about adding equipment.

• To copy an existing equipment item, find the equipment item you want to copy and then click 
the C button in the Action area to open the Equipment Inventory window with fields auto‐
matically filled based on the current equipment item. Please see “Copying Equipment” on 
page 117 for more information about adding equipment.

Reports
The Reports sidebar allows you to access and run the reports available within HEMS. Selecting a 
report opens a separate browser window that presents filtering options based on the report type 
you selected. Enter your desired criteria and then click View Report to see the generated report.

Please see “Reports Sidebar” on page 39 for information about the Reports sidebar and “CHAP‐
TER 10: Reports” on page 195 for more information about HEMS reports.
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CHAPTER 1: Welcome!
Logging Out of HEMS
To log out of HEMS, you may either:

• Select Activities>Exit.

• Click the Exit HEMS button on the Toolbar. Please see “Toolbar” on page 37 for more infor‐
mation about the Toolbar.

• Press [ALT]+[F4].

You will be prompted to save any unsaved changes.

CAUTION: EXITING HEMS WITHOUT SAVING YOUR UNSAVED CHANGES WILL 
CAUSE THOSE CHANGES TO BE PERMANENTLY LOST.
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CHAPTER 2: The HEMS Interface
The Home Screen
The HEMS Home screen appears when you first log into HEMS.

The Home screen contains the following functional areas.

• Menu Bar (1): Provides access to all HEMS features and functions. Please see “Menu Bar” on 
page 27 for more information about the Menu bar.

• Toolbar (2): Provides quick access to common editing functions. Please see “Toolbar” on 
page 37 for more information about the Toolbar.

• Reports Sidebar (3): Accesses the HEMS reports. Please see “Reports Sidebar” on page 39 for 
more information about the Reports sidebar and “CHAPTER 10: Reports” on page 195 for 
more information about reports.

• Quick Launch Buttons (4): These buttons provide quick access to the most commonly used 
HEMS functions. Please see “Quick Launch Buttons” on page 15 for more information about 
the Quick Launch buttons.

• Home Tab (5): Opens the HEMS Home screen.

• Work Orders Dashboard Tab (6): Opens the Work Orders dashboard. Please see “The Work 
Orders Dashboard” on page 17 for more information about the Work Orders dashboard.

• Equipment Inventory Dashboard Tab (7): Opens the Equipment Inventory dashboard. 
Please see “The Equipment Inventory Dashboard” on page 22 for more information about 
the Equipment Inventory dashboard.
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Quick Launch Buttons
The HEMS Home screen includes the following 
12 Quick Launch buttons:

• Work Orders: Launches the Work Orders 
dashboard, which allows you to find, review, 
open, edit, and close work orders. Please see 
“The Work Orders Dashboard” on page 17 
for more information about the Work 
Orders dashboard.

• Quick Work Orders: Opens the Quick Work 
Orders window, which allows you to quickly 
edit or update multiple work orders at once. Please see “The Quick Work Orders Window” on 
page 66 for more information about the Quick Work Orders window.

• Assign Work Orders: Opens the Assign Work Orders window, which allows you to assign or 
reassign work orders to technicians. Please see “The Assign Work Orders Window” on 
page 68 for more information about the Assign Work Orders window.

• Equipment Inventory: Opens the Equipment Inventory dashboard, which allows you to find, 
add, edit, schedule, and review equipment history as well as open work orders for equip‐
ment. Please see “The Equipment Inventory Dashboard” on page 22 for more information 
about the Equipment Inventory dashboard.

• Equipment Types: Opens the Equipment Types Information List, which allows you to enter or 
update equipment types and set up your preventive maintenance template by type. Please 
see “Equipment Types List” on page 134 for more information about the Equipment Types 
Information List.

• Equipment Models: Opens the Equipment Models Information List, which allows you to 
enter or update equipment models and set up your preventive maintenance template by 
model. Please see “Equipment Models List” on page 131 for more information about the 
Equipment Models Information List.

• Generate Scheduled WO: Opens the Generate Scheduled Work Orders window, which 
allows you to generate scheduled work orders for your selected date range. Please see “Gen‐
erating Scheduled Work Orders” on page 81 for more information about scheduled work 
orders.

• Procedures: Opens the Procedures Information List, which allows you to search for, add, or 
edit preventive maintenance procedures. Please see “Procedures List” on page 146 for more 
information about the Procedures Information List.

• Parts: Opens the Parts Inventory window, which allows to you to view, add, edit, and remove 
parts. Please see “CHAPTER 7: Managing Parts” on page 169 for more information about 
managing parts.

• Reports: Opens the Reports window, which allows you to access HEMS reports. Please see 
“Reports Sidebar” on page 39 and “CHAPTER 10: Reports” on page 195 for more information 
about HEMS reports.
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CHAPTER 2: The HEMS Interface
• Send to medTester: Send work orders to the Fluke Biomedical® medTester® via the EQ2 
medTester Interface.

• Receive from medTester: Receive work orders from the Fluke Biomedical medTester via the 
EQ2 medTester Interface.

AUTHORED BY ANTHONY HERNANDEZ - (415)786-2081 - anthony94122@outlook.com
16 January 2010 - Revision 1.0



HEMS Enterprise 5.x User & Administrator Guide
Dashboards
Day‐to‐day activities will primarily be accomplished with the Equipment Inventory and Work 
Orders dashboards such as looking up individual records, reviewing history, editing, copying and 
creating new records.

The Work Orders Dashboard
The Work Orders dashboard allows you to quickly look up and review work orders.

To open the Work Orders dashboard, you may either:

• Click the Work Orders tab on the right of the HEMS application.

• Click the Work Orders button in the HEMS Home screen.

• Select Activities>Work Orders.

• Press [CTRL]+[W].

The Work Orders dashboard contains the following functional areas:

• Search Area: Allows you to search for work order records. This image shows an example of 
the Work Orders dashboard in Find mode.

• Report/Print Buttons: Allow you to run reports and print/export work order data. Please see 
“CHAPTER 12: Printing & Exporting Data” on page 233 for more information about printing 
and exporting data in HEMS.
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CHAPTER 2: The HEMS Interface
• Search Mode Buttons: Switch between Find and Filter modes, and display records added 
during the current HEMS session.

• Results Area: Search results appear here.

• Details Area: Displays the work order.

• Action Area: Perform various actions on the selected work order, or open a new work order.

Search Area (Find Mode)
When the Work Orders dashboard is in Find mode (shown above), the Search Area contains var‐
ious fields. By default, entering one or more letters in one or more of the search fields returns 
results that begin with the text you entered. For example, entering “def” will return “defibrilla‐
tor.”

Entering values in multiple search field restricts results to values that match all of the search 
terms in all of the fields. For example, entering “def” in the EQ Type field and “phi” in the Manu‐
facturer field would return defibrillators manufactured by Philips® but not defibrillators from dif‐
ferent manufacturers.

Checking the Exact checkbox forces HEMS to return only those results that contain the exact text 
you entered. If you select this option, then entering “def” will not return “defibrillator” because 
the two are not an exact match.

Enter your desired search terms and then click Search to return matching results, or Reset to 
clear the Search Area and begin a new search.

• Searching with all search fields left blank returns all pending work orders stored in HEMS 
(unless the Pending checkbox is cleared, in which case the search will return all pending and 
closed work orders).

• Most fields return matches that begin with the text entered in that field. For example, enter‐
ing “def” retrieve both “defib” and “defibrillator.”

• The EQ Type and ECRI fields return results that contain the text entered in those fields. For 
example, entering “fib” will return “defibrillator.”

• The Work Order Number field returns only an exact match. For example, you must enter 
“6981” to search for Work Order #6981; entering part of the number will not work.

Please see “CHAPTER 11: Finding Data” on page 219 for more information on using Find mode.

Search Area (Filter Mode)
When the Work Orders dashboard is in Filter mode (not shown), the Search Area contains a list 
of selected filter conditions. Please see “Filters” on page 222 for more information about using 
filters.

Note: By default, searches return only pending work orders. 
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Report/Print Buttons
The Report/Print buttons provide quick access to relevant reports. From the left to right, the 
buttons are:

• List Report: Clicking the List Report button opens a summary report that lists all of the items 
in the Results Area.

• Technician’s Copy (Actual) ‐ All: Clicking the Technician’s Copy (Actual) ‐ All button opens a 
report that provides the work order information that a technician sees for each of the items 
in the Results Area.

• Technician’s Copy (Actual) ‐ Current: Clicking the Technician’s Copy (Actual) ‐ Current button 
opens a report that provides the work order information that a technician sees for the cur‐
rently selected item in the Results Area.

• Detail Report ‐ All: Clicking the Detail Report ‐ All button opens a report that provides 
detailed information about each of the items in the Results Area.

• Detail Report ‐ Current: Selecting an item in the Results Area and then clicking the Detail 
Report ‐ Current button opens a report that provides detailed information about the cur‐
rently selected item in the Results Area.

• Group WO Scheduled Report: This report allows you to print a group work order with the 
equipment listed on one work order.

Reports appear in a separate browser window. You can print and/or export these reports, as 
described in “CHAPTER 12: Printing & Exporting Data” on page 233.

Search Mode Buttons
The Search Mode buttons determine how dashboard data will be retrieved. From left to right, 
the buttons are:

• Show Newly Added Items: If the Show Newly Added Items button is active, clicking it will 
display work orders added during your current HEMS session (from the time you logged into 
HEMS). Exiting HEMS ends your session. Clicking this button again returns you to normal 
Search mode.

• Switch to Filter mode: When the Work Orders dashboard is in Find mode, the Switch to Fil‐
ter mode button appears as a small funnel. Clicking this button switches the Search Area to 
Filter mode. Please see “Filters” on page 222 for more information on using filters.

• Switch to Find mode: When the Work Orders dashboard is in Filter mode, the Switch to Find 
mode button appears as a small magnifying glass. Clicking this button switches the Search 
Area to Find mode. Please see “The Find Function” on page 221 for more information on 
using Find mode.
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Search Results Area
The Search Results Area displays the result of the most recent search and includes the following 
navigation functions to help you find the desired work order:

• Clicking a column header sorts the search results by the selected column. You can also reor‐
der and resize columns by dragging them.

• Clicking the << button takes you to the first page of search results.

• Clicking the < button takes you to the previous page of search results.

• Clicking the > button takes you to the next page of search results.

• Clicking the >> button takes you to the last page of search results.

Once you have located the correct work order, click it to open it in the Details Area.

Details Area
The Details Area displays the currently selected work order in the Search Results Area.

Action Area
The Action Area allows you to perform the following actions on the work order:

• Page WO: Clicking the Page WO button pages the work order to the assigned technician.

• Close WO: Clicking the Close WO button opens the Work Order window for the selected 
work order with the status changed to Closed. Enter your labor, action text, and any addi‐
tional information before saving. The work order Status Date field will update to match your 
last labor entry.

• Delete: Clicking the Delete button deletes the selected work order. You are prompted to con‐
firm the deletion.

• Edit: Clicking the Edit button opens the Work Order window for the selected work order, 
allowing you to make changes as needed.

• Copy: Clicking the Copy button opens the Work Order window with a new work order that is 
based on the current work order.

• New: Selecting the New button opens a blank Work Order window so that you can create a 
new work order.

CAUTION: DELETED WORK ORDERS ARE PERMANENTLY REMOVED FROM 
HEMS.
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Using the Work Orders Dashboard
To use the Work Orders dashboard:

1. Enter your desired search term(s) in the Search Area.

2. Click the Search button to run the search.

3. Select the desired work order in the Search Results Area.

4. Review the work order by viewing the work order details in the Details Area.

5. Perform an action on the selected work order using the Action Area.

Please see “CHAPTER 4: Work Orders” on page 55 for more information about working with work 
orders in HEMS and “The Work Order Window” on page 60 for more information about the Work 
Order window.

Equipment History and Labor Hours Reports
The Work Orders dashboard contains two links that allow you to access detailed equipment and 
labor information:

• Selecting a work order and then clicking the Control # link in the Results Area opens an 
Equipment History report in a separate browser window for the selected equipment item. 
You can print and export this report as described in “CHAPTER 12: Printing & Exporting Data” 
on page 233.

• Selecting a work order and then clicking the Assg Eng link in the Results Area opens a Labor 
Hours report in a separate browser window that displays the selected employee’s shift hours 
vs. hours actually worked (hours logged against work orders). You can print and export this 
report as described in “CHAPTER 12: Printing & Exporting Data” on page 233.
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The Equipment Inventory Dashboard
The Equipment Inventory dashboard allows you to quickly look up and manage equipment.

To open the Equipment Inventory dashboard, you may either:

• Click the Equipment Inventory tab on the right of the HEMS application.

• Click the Equipment Inventory button in the HEMS Home screen.

• Select Activities>Equipment Inventory.

• Press [CTRL]+[I].

The Equipment Inventory dashboard contains the following functional areas:

• Search Area: Allows you to search for equipment inventory records. This image shows an 
example of the Equipment Inventory dashboard in Find mode.

• Report/Print Buttons: Allow you to run reports and print/export equipment item data. 
Please see “CHAPTER 12: Printing & Exporting Data” on page 233 for more information about 
printing and exporting data in HEMS.

• Search Mode Buttons: Switch between Find and Filter modes, and display records added 
during the current HEMS session.

• Results Area: Search results appear here.

• Details Area: Displays the current equipment item record.

• Action Area: Perform various actions on the selected equipment item or add a new item to 
inventory.

Search Area

Action Area

Results
Area

Details
Area

Report/
Print

Buttons

Search 
Mode 

Buttons
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Search Area (Find Mode)
When the Equipment Inventory dashboard is in Find mode (shown above), the Search Area con‐
tains various fields. By default, entering one or more letters in one or more of the search fields 
returns results that begin with the text you entered. For example, entering “def” will return 
“defibrillator.”

Entering values in multiple search field restricts results to values that match all of the search 
terms in all of the fields. For example, entering “def” in the EQ Type field and “phi” in the Manu‐
facturer field would return defibrillators manufactured by Philips but not defibrillators from dif‐
ferent manufacturers.

Checking the Exact checkbox forces HEMS to return only those results that contain the exact text 
you entered. If you select this option, then entering “def” will not return “defibrillator” because 
the two are not an exact match.

Enter your desired search terms and then click Search to return matching results, or Reset to 
clear the Search Area and begin a new search.

• Searching with all search fields left blank returns all active equipment in inventory (unless 
Both Active and Inactive is selected, in which case the search will return all pending and 
closed work orders.

• Most fields return matches that begin with the text entered in that field. For example, enter‐
ing “def” retrieve both “defib” and “defibrillator.”

• The EQ Type and ECRI fields return results that contain the text entered in those fields. For 
example, entering “fib” will return “defibrillator.”

• The Control Number field returns only an exact match. For example, you must enter “6981” 
to search for Control Number #6981; entering part of the number will not work.

Please see “The Find Function” on page 221 for more information on using Find mode.

Search Area (Filter Mode)
When the Equipment Inventory dashboard is in Filter mode (not shown), the Search Area con‐
tains a list of selected filter conditions. Please see “Filters” on page 222 for more information 
about using filters.

Note: By default, searches return only active equipment.
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Report/Print Buttons
The Report/Print buttons provide quick access to relevant reports. From the left to right, the 
buttons are:

• List Report: Clicking the List Report button opens a summary report that lists all of the items 
in the Results Area.

• Detail Report ‐ All: Clicking the Detail Report ‐ All button opens a report that provides 
detailed information about each of the items in the Results Area.

• Detail Report ‐ Current: Selecting an item in the Results Area and then clicking the Detail 
Report ‐ Current button opens a report that provides detailed information about the cur‐
rently selected item in the Results Area.

Reports appear in a separate browser window. You can print and/or export these reports, as 
described in “CHAPTER 12: Printing & Exporting Data” on page 233.

Search Mode Buttons
The Search Mode buttons determine how dashboard data will be retrieved. From left to right, 
the buttons are:

• Show Newly Added Items: If the Show Newly Added Items button is active, clicking it will 
display entries added during your current HEMS session (from the time you logged into 
HEMS). Exiting HEMS ends your session.

• Switch to Filter mode: When the Equipment Inventory dashboard is in Find mode, the 
Switch to Filter mode button appears as a small funnel. Clicking this button switches the 
Search Area to Filter mode. Please see “Filters” on page 222 for more information on using 
filters.

• Switch to Find mode: When the Equipment Inventory dashboard is in Filter mode, the 
Switch to Find mode button appears as a small magnifying glass. Clicking this button 
switches the Search Area to Find mode. Please see “The Find Function” on page 221 for more 
information on using Find mode.

Search Results Area
The Search Results Area displays the result of the most recent search and includes the following 
navigation functions to help you find the desired equipment item record:

• Clicking a column header sorts the search results by the selected column. You can also reor‐
der and resize columns by dragging them.

• Clicking the << button takes you to the first page of search results.

• Clicking the < button takes you to the previous page of search results.

• Clicking the > button takes you to the next page of search results.

• Clicking the >> button takes you to the last page of search results.

• Once you have located the correct equipment item record, click it to open it in the Details 
Area.
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Details Area
The Details Area displays the currently selected equipment item record in the Search Results 
Area.

Action Area
The Action Area allows you to perform the following actions on the currently selected equipment 
item:

• Create Work Order: Select the type of work order you want to open (such as Routine, Recall/
Alert, etc.) by checking the appropriate radio button and then click the Create WO button to 
create a new work order of the selected type for the equipment item. Information associated 
with the equipment will automatically be populated such as department, location, assigned 
engineer, work order notes, etc. Please see “Opening a Work Order from the Equipment 
Inventory Dashboard” on page 121 for information about creating work orders from the 
Equipment inventory dashboard.

• View History: Click the H button to open the interactive Equipment History window for the 
selected equipment item. You may sort by column by clicking the desired column’s header 
and may also resize and reposition columns by clicking and dragging. Double‐clicking a work 
order opens the Work Order window for the selected work order. Please see “Viewing Equip‐
ment History” on page 122 for information about creating work orders from the Equipment 
inventory dashboard.

• View Schedule: Click the S button to see the equipment’s maintenance schedule in a sepa‐
rate browser window.

• View Contract Information: Click the C button to open the Equipment Contract History win‐
dow for the selected equipment item and view all current and previous contract information 
for the selected equipment item. Please see “The Equipment Contract History Window” on 
page 104 for information about creating work orders from the Equipment inventory dash‐
board.

• Delete: Clicking the Delete button deletes the selected equipment item from HEMS, pro‐
vided that no action has been performed on that item. You are prompted to confirm the 
deletion.

• Edit: Clicking the Edit button opens the Equipment Inventory window for the selected equip‐
ment item, allowing you to make changes as needed.

Note: You cannot delete equipment if any action has been performed on it, 
because that action is part of your maintenance history, which includes work 
orders, an equipment group, equipment assigned to a contract, etc. 

CAUTION: DELETED EQUIPMENT IS PERMANENTLY REMOVED FROM HEMS.
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• Copy: Clicking the Copy button opens the Equipment Inventory window with a new equip‐
ment item that is based on the equipment item. This is useful if you already have another 
identical equipment item in HEMS and want to save time when adding your new equipment 
item to the database.

• New: Selecting the New button opens a blank Equipment Inventory window so that you can 
add a new equipment item to HEMS.

Using the Equipment Inventory Dashboard
To use the Equipment Inventory dashboard:

1. Enter your desired search term(s) in the Search Area.

2. Select the desired equipment item in the Search Results Area.

3. Confirm that you have opened the correct equipment item by reviewing the data in the 
Details Area.

4. Perform an action on the selected equipment item using the Action Area.

Please see “CHAPTER 5: Managing Equipment” on page 85 for more information about manag‐
ing equipment in HEMS and “The Equipment Inventory Window” on page 89 for more informa‐
tion about the Equipment Inventory window.

Note: By default, searches return only active equipment.
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Menu Bar
The Menu Bar covers the topmost portion of the HEMS window.

This section describes all of the functions available from the Menu Bar.

The Activities Menu
The Activities menu provides quick access to the HEMS windows and dashboards.

Change Service Areas
Selecting Activities>Change Service Areas opens the Choose Service Area window, which allows 
you to switch to another Service Area (depending on your security rights).

In the Choose Service Area window, click the Service Area you want to access. HEMS displays 
data for the selected Service Area.

Work Orders
Selecting Activities>Work Orders opens the Work Orders dashboard, which allows you to find, 
review, open, edit, and close work orders. Please see “The Work Orders Dashboard” on page 17 
for more information about the Work Orders dashboard.

Generate Scheduled Work Orders
Selecting Activities>Generate Scheduled Work Orders opens the Generate Scheduled Work 
Orders window, which allows you to generate scheduled work orders for your selected date 
range. Please see “Generating Scheduled Work Orders” on page 81 for more information about 
generating scheduled work orders.

Assign Work Orders
Selecting Activities> Assign Work Orders opens the Assign Work Orders window, which allows 
you to assign or reassign work orders to technicians. Please see “Assigning Work Orders” on 
page 82 for more information about assigning work orders.

Quick Work Order
Selecting Activities>Quick Work Order opens the Quick Work Orders window, which allows you 
to quickly edit, update, or close multiple work orders at once, such as changing status or the 
employee who performed labor. Please see “The Quick Work Orders Window” on page 66 for 
more information about the Quick Work Orders window.
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Equipment Inventory
Selecting Activities>Equipment Inventory opens the Equipment Inventory dashboard, which 
allows you to find, add, edit, schedule, and review equipment history as well as open work 
orders for equipment. Please see “The Equipment Inventory Dashboard” on page 22 for more 
information about the Equipment Inventory dashboard.

Quick Equipment Activities
Selecting Activities>Quick Equipment Activities opens the Quick Equipment Activities window, 
which allows you to take an action on multiple pieces of equipment at once, such as moving hun‐
dreds of equipment items to a new department, retiring, or placing in storage. Please see “The 
Quick Equipment Activities Window” on page 101 for more information about the Quick Equip‐
ment Activities window.

Contracts
Selecting Activities>Contracts opens the Contracts window, which allows you to view, add, edit, 
or remove service contract information. Please see “CHAPTER 9: Managing Contracts” on 
page 183 for more information about working with contracts.

Parts
Selecting Activities>Parts opens the Parts submenu, which allows you to manage and track 
parts. The available options are:

• Inventory: Selecting Activities>Parts>Inventory opens the Parts Inventory window, which 
allows to you to view, add, edit, and remove parts. Please see “CHAPTER 7: Managing Parts” 
on page 169 for more information about managing parts.

• Transactions: Selecting Activities>Parts>Transactions opens the Parts Transactions window, 
which allows you to track parts movements. Please see “Part Transactions” on page 174 for 
more information about tracking part movements.

Exit
Selecting Activities>Exit exits the HEMS application.

The Edit Menu
The Edit menu provides quick access to the most commonly used HEMS editing functions.

Edit
Selecting Edit>Edit allows you to edit the current record. You may also press [CTRL]+[E].

New
Selecting Edit>New opens a window to create a new entry in your current Information List, as 
appropriate depending on where you are in HEMS when you select this option. You may also 
press [CTRL]+[N].
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Create Copy
Selecting Edit>Create Copy creates a copy of the current work order, equipment record, etc. as 
appropriate depending on which Information List you are using when you select this option. You 
may also press [CTRL]+[K].

Delete
Selecting Edit>Delete deletes the current work order, equipment record, etc. as appropriate 
depending on where you are in HEMS when you select this option. You may also press 
[CTRL]+[D].

Save
Selecting Edit>Save saves the current record, including all changes you have made since the last 
save. You may also press [CTRL]+[S].

Cancel
Selecting Edit>Cancel cancels your most recent record creation, save, or deletion. You may also 
press [CTRL]+[U].

Close
Selecting Edit>Close closes the current HEMS window. You may also press [CTRL]+[F4].

The Information Lists Menu
The Information Lists menu provides quick access to the HEMS Information Lists. Please see 
“CHAPTER 6: Information Lists” on page 123 for more information about Information Lists.

Departments
Selecting Information Lists>Departments opens the Departments Information List, which lists all 
of the available departments in the current Service Area (such as Emergency, Plant, etc.). Please 
see “Departments List” on page 124 for more information about departments.

Device Inclusions
Selecting Information Lists>Device Inclusions opens the Device Inclusions Information List, 
which allows you to classify equipment for easy identification. For example, you could include 
fire extinguishers in a list called Fire Safety. Please see “Device Inclusions List” on page 126 for 
more information about device inclusions.
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Employees
Selecting Information Lists>Employees opens the Employees Information List, which allows you 
to add, edit, and deactivate employees. Please see “Employees List” on page 126 for more infor‐
mation about managing employees within HEMS.

Equipment Inventory Lists
Selecting Information Lists>Equipment Inventory Lists opens the Equipment Inventory Lists 
submenu, which allows you to access the various equipment‐related Information Lists. The avail‐
able options are:

• Equipment Models: Opens the Equipment Models Information List, which allows you to add, 
edit, define a preventive maintenance template, and assign risk, parts, and attachments to 
equipment models. This is also where you indicate other information such as service manu‐
als, operator manuals, and alarms. This information then appears in all individual equipment 
records that include this model. Please see “Equipment Models List” on page 131 for more 
information about equipment models.

• Equipment Types: Opens the Equipment Types Information List, which allows you to view, 
add, edit, define a preventive maintenance template, and assign risk, parts, and attachments 
to equipment types. Please see “Equipment Types List” on page 134 for more information 
about equipment types.

• Equipment Groups: Opens the Equipment Groups Information List, which allows you group 
equipment items for scheduling, if no other schedule template is available. Please see 
“Equipment Groups List” on page 137 for more information about equipment groups.

• Equipment Classes: Opens the Equipment Classes Information List, which allows you to iden‐
tify equipment, such as Life Support, Non‐Life Support, etc. This is especially important for 
reporting purposes. Please see “Equipment Classes List” on page 139 for more information 
about equipment classes.

• Equipment Systems: Opens the Equipment Systems Information List, which allows you to 
further identify and report on equipment. For example, equipment classified as “Cooling” 
and “Heating” may be assigned to the “HVAC” system. Please see “Equipment Systems List” 
on page 139 for more information about equipment systems.

Locations
Locations lists describe equipment placement and help mechanics and technicians find what 
they are looking for. Selecting Information Lists>Locations opens the Locations submenu, which 
allows you to access the various location‐related Information Lists. The available options are:

• Locations: Selecting Information Lists>Locations>Locations opens the Locations Information 
List, which allows you to add, edit, or deactivate locations. Please see “Locations List” on 
page 140 for more information about locations.

Note: Define engineering staff by checking the Eng Emp checkbox. These are 
employees who will be assigned work and provide the services documented in 
HEMS work orders.
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• Campuses: Campuses are typically clusters of buildings that share a common location. 
Selecting Information Lists>Locations>Campuses opens the Campuses Information List, 
which allows you to add, edit, or deactivate campuses. Please see “Campuses List” on 
page 141 for more information about campuses.

• Buildings: Buildings are typically freestanding structures that may be either standalone or 
grouped into a campus. Selecting Information Lists>Locations>Buildings opens the Buildings 
Information List, which allows you to add, edit, or deactivate buildings. Please see “Buildings 
List” on page 142 for more information about buildings.

• Wings: Wings typically designate separate sections of buildings that can span multiple floors. 
Selecting Information Lists>Locations>WIngs opens the Wings Information List, which allows 
you to add, edit, or deactivate wings. Please see “Wings List” on page 142 for more informa‐
tion about wings.

• Floors: Floors typically designate a given floor number. A floor may span one or more wings. 
Selecting Information Lists>Locations>Floors opens the Floors Information List, which allows 
you to add, edit, or deactivate floors. Please see “Floors List” on page 143 for more informa‐
tion about floors.

• Rooms: Rooms are typically enclosed spaces on a certain floor. Selecting Information 
Lists>Locations>Rooms opens the Rooms Information List, which allows you to add, edit, or 
deactivate rooms. Please see “Rooms List” on page 143 for more information about rooms.

• Spaces: Spaces are typically separately designated areas within a room, such as above a cabi‐
net. Selecting Information Lists>Locations>Spaces opens the Spaces Information List, which 
allows you to add, edit, or deactivate spaces. Please see “Spaces List” on page 144 for more 
information about spaces.

Maintenance Specialties
Maintenance specialties include trades, crafts, and other functions of employees who perform 
work based on work orders. Selecting Information Lists>Maintenance Specialties opens the 
Maintenance Specialties Information List, which allows you to add, edit, and remove mainte‐
nance specialties. Please see “Maintenance Specialties List” on page 144 for more information 
about maintenance specialties.

Part Types
Part type lists describe groups of like parts (such as batteries.) Selecting Information Lists>Parts 
Types opens the Part Types Information List, which allows you to add, edit, and deactivate part 
types. Please see “Part Types List” on page 145 for more information about part types.

Predefined Text
Predefined text simplifies data entry and helps ensure consistency across multiple records. 
Selecting Information Lists>Predefined Text opens the Predefined Text Information List, which 
allows you to add, edit, and remove predefined text entries. Please see “Predefined Text List” on 
page 145 for more information about predefined text.
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Procedures and Tasks
Procedure and task Information Lists describe how to maintain and/or service equipment. 
Selecting Information Lists>Procedures & Tasks opens the Procedures & Tasks submenu. The 
available options are:

• Procedures: A procedure is a group of tasks designed to maintain a piece of equipment in 
optimum running condition while trying to ensure that it meets its life expectancy. Selecting 
Information Lists>Procedures & Tasks>Procedures opens the Procedures Information List, 
which allows you to add, edit, and deactivate procedures. Please see “Procedures List” on 
page 146 for more information about procedures.

• Procedure Types: Procedure types categorize procedures by specialty (such as plumbing, 
electrical, etc.). Selecting Information Lists>Procedures & Tasks>Procedure Types opens the 
Procedure Types Information List, which allows you to add, edit, and deactivate procedure 
types. Please see “Procedure Types List” on page 148 for more information about procedure 
types.

• Tasks: A task is a specific item of work that must be accomplished as part of a procedure. 
Selecting Information Lists>Procedures & Tasks>Tasks opens the Tasks Information List, 
which allows you to add, edit, and deactivate tasks. Please see “Tasks List” on page 149 for 
more information about tasks.

• Task Types: Task types group tasks by specialty, such as plumbing or electrical. Selecting 
Information Lists>Procedures & Tasks>Task Types open the Task Types Information List, 
which allows you to add, edit, and deactivate task types. Please see “Task Types List” on 
page 150 for more information about task types.

Purchase Orders
HEMS tracks purchase order numbers and descriptions. Selecting Information Lists>Purchase 
Orders opens the Purchase Orders Information List, which allows you to add, edit, and deacti‐
vate purchase orders. Please see “Purchase Orders List” on page 150 for more information about 
purchase orders.

Seasons
Seasons restrict scheduled work order generation to specific date ranges. Selecting Information 
Lists>Seasons opens the Seasons Information List, which allows you to add, edit, and deactivate 
season information. Please see “Seasons List” on page 151 for more information about seasons.

Shifts
Selecting Information Lists>Shifts opens the Shifts Information List, which allows you to add, 
edit, and remove work shifts and department shifts, or hours of operation. Shifts must be 
assigned to employees to view a comparison of shift hours vs. labor hours in the Labor Hours 
report from the Work Orders dashboard and the Employees Information List. Shifts must be 
defined in the Departments Information List to view the Equipment Downtime report. Please 
see “Departments List” on page 124 and “Shifts List” on page 152 for more information about 
managing work shifts within HEMS.
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Subcodes
Subcodes provide additional tracking information, such as “PM Successful” or “Failure.” Selecting 
Information Lists>Subcodes opens the Subcodes Information List, which allows you to add, edit, 
and deactivate subcodes. Please see “Managing Work Orders” on page 56 and “Subcodes List” 
on page 152 for more information about subcodes.

Vendors
Vendors comprise all equipment and part vendors, including suppliers and manufacturers. 
Selecting Information Lists>Vendors opens the Vendors Information List, which allows you to 
add, edit, and deactivate all equipment and parts vendors, including suppliers and manufactur‐
ers. Please see “Vendors List” on page 153 for more information about vendors.

Work Order Lists
Work order Information Lists allow work orders to be classified by several criteria for easy track‐
ing and resource management. Selecting Information Lists>Work Order Lists opens the Work 
Order Lists submenu, which allows you to access the various work order lists. The available 
options are:

• Work Order Codes: Work order codes recognize labor actions in the work order Labor and 
Parts tabs such as travel, ordering parts, training, waiting for the device, etc. Selecting Infor‐
mation Lists>Work Order Lists>Work Order Codes opens the Work Order Codes Information 
List, which allows you to add, edit, and deactivate work order codes. Please see “Work Order 
Codes List” on page 155 for more information about work order codes.

• Work Order Priorities: Work order priorities allow department management to review open 
work orders and determine their importance and urgency. Selecting Information Lists>Work 
Order Lists>Work Order Priorities opens the Work Order Priorities Information List, which 
allows you to add, edit, and deactivate work order priorities. Please see “Work Order Priori‐
ties List” on page 156 for more information about work order priorities.

• Work Order Status: Work order statuses allow department management to track work prog‐
ress and identify bottlenecks or delays. Selecting Information Lists>Work Order Lists>Work 
Order Status opens the Work Order Status Information List, which allows you to add, edit, 
and deactivate work order priorities. Please see “Work Order Status List” on page 157 for 
more information about work order priorities.

• Work Order Types: Work order types classify work orders in a predetermined manner for 
tracking and regulatory management. Selecting Information Lists>Work Order Lists>Work 
Order Types opens the Work Order Types Information List, which allows you to add, edit, 
and deactivate work order types. Please see “Work Order Types List” on page 158 for more 
information about work order types.
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The Utilities Menu
The Utilities menu accesses HEMS administrative functions. Please see “CHAPTER 13: Adminis‐
tration” on page 237 for more information about administering and managing HEMS and “HEMS 
Security Modes” on page 238 for more information about using HEMS security vs. Windows 
(LDAP) security.

Security
• Users: Selecting Utilities>Users opens the Users window, which allows you to add, update, 

and delete HEMS users. Please see “User Management” on page 242 for more information 
about the Users window.

• Passwords: Selecting Utilities>Passwords opens the Passwords window, which allows you to 
view user passwords, if you are using HEMS security. Please see “Viewing and Changing Pass‐
words” on page 249 for more information about the Passwords window.

• Password Setup: Selecting Utilities>Password Setup opens the Password Setup window, 
which allows you to specify various password parameters if you are using HEMS security. 
Please see “Controlling Password Usage” on page 250 for information about the Password 
Setup window.

• Users Report: Selecting Utilities>Users Report opens the Users report in a browser window, 
which presents the list of all current and former HEMS users.

• Passwords Report: Selecting Utilities>Passwords Report opens the HEMS security Pass‐
words report in a browser window, which presents the list of HEMS users and their pass‐
words.

•  Permission Groups: Selecting Utilities> Permission Groups opens the Control Permission 
Group window, which defines what the selected user can do, such as adding, copying, edit‐
ing, or deactivating/deleting records within each window and Information List. Please see 
“Control Groups” on page 252 for more information about the Control Permissions Group 
window.

• Menu Permission Groups: Selecting Utilities>Menu Permission Groups opens the Menu 
Permission Groups window, which defines what windows and Information Lists the selected 
user has access to, such as work orders, equipment inventory, generating schedules, or secu‐
rity. Please see “Menu Groups” on page 257 for more information about the Menu Permis‐
sions Group window.

Reports
Selecting Utilities>Reports opens the Reports window, which allows you to run reports. Please 
see “Reports” on page 271 for more information about the Reports window.
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User Configuration:
Selecting Utilities>User Configuration opens the User Configuration window, which allows you 
to customize your Reports sidebar by determining what reports you want displayed and the 
order in which you want them displayed. You can also set your individual work order defaults by 
Service Area (if you have access to multiple Service Areas), which makes opening work orders 
faster and more accurate. Each user can set up her or his own report and work order defaults.

Please see “Configuring User Defaults” on page 246 for more information about the User Config‐
uration window.

Management Tools
Selecting Utilities>Management Tools opens the Management Tools submenu, which allows 
management to define policies. This includes determining the default for how you schedule 
equipment (date), assigning a work coordinator, determining the department/location prefer‐
ences for new work orders, when to lock closed work orders, etc. The available options are:

• Equipment Management: Selecting Utilities>Management Tools>Equipment Management 
opens the Equipment Management window, which allows you to take an action on multiple 
pieces of equipment at once, such as moving hundreds of equipment items to a new depart‐
ment, retiring, placing in storage, changing schedule information, and other administrative 
functions. Please see “Equipment Management” on page 260 for more information about 
the Equipment Management window.

• Service Area Configuration: Selecting Utilities>Management Tools>Service Area Configura‐
tion opens the Service Area Configuration window, which allows you to specify work order 
and equipment defaults by Service Area. Please see “Service Area Configuration” on 
page 263 for more information about the Service Area Configuration window.

• Service Area and Specialty Rates: Selecting Utilities>Management Tools>Service Area and 
Specialty Rates opens the Service Area and Specialty Rates window, which allows you to 
determine both a standard Service Area rate by maintenance specialty or Service Area (Stan‐
dard Rate). If both standard and specialty rates are defined, HEMS will use the Specialty Rate 
first where applicable. If neither Standard nor Specialty rates are defined, the maintenance 
employee hourly rate (from the Employees Information List) will be used. Please see “Service 
Area and Specialty Rates” on page 266 for more information about the Service Area and Spe‐
cialty Rates window.

Note: Some work order defaults (such as Location) are overridden when creat‐
ing work orders from the Equipment Inventory dashboard. In this example, 
Department, Location, and Assigned Engineer (if specified) are fields associ‐
ated with an equipment record and the work order will auto‐fill with informa‐
tion from equipment.
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Errors
Selecting Utilities>Errors opens the Errors window, which displays detailed information from the 
application’s error log. Please see “Error Logs” on page 267 for more information about the 
Errors window.

Replace Values
Replacement values help remove nonstandard entries from HEMS records by replacing them 
with standard entries. Selecting Utilties>Replace Values opens the Replace Values submenu, 
which allows you to replace values by Departments, Device Inclusion, Employees, EQ Class, EQ 
Model, EQ System, EQ Types, Locations, Maintenance Specialty, Parts, Part Types, Priority, Proce‐
dure Types, Procedures, Purchase Orders, Seasons, Subcodes, Task Types, Tasks, Vendor Suppli‐
ers, Vendor Manufacturers, WO Codes, WO Status, and WO Types. Selecting a replacement value 
list then opens the Replacement Module window, which allows you to replace the selected 
value. Please see “Replacing Values” on page 269 for more information about the Replacement 
Module window.

Window Menu
The Window menu displays all of the windows you currently have open in HEMS. To switch 
between windows, select Window and then click the window you wish to bring to the top.

The Help Menu
The Help menu accesses the available HEMS program support options.

Search for Help On
Selecting Help>Search for Help On opens the Help window, which displays the HEMS online Help 
system. You can navigate the online Help using the navigation display, hyperlinks within individ‐
ual Help pages, the included index, or by using the handy Search function.

User Guide
Selecting Help>User Guide opens this User & Administrator Guide in Adobe Acrobat (PDF) for‐
mat.

About
Selecting Help>About opens the About window, which displays HEMS version and copyright 
information, plus contact information for EQ2, Inc.
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Toolbar
The Toolbar contains buttons that provide quick access to commonly used functions. The but‐
tons included on the Toolbar vary depending on whether the Toolbar is in Normal or Admin 
mode. Please see “Admin Toolbar” on page 239 for information about the Toolbar buttons avail‐
able in Admin mode.

The Toolbar contains the following buttons when in Normal mode: 

Exit HEMS Button
Clicking the Exit HEMS button logs you out of HEMS and exits the application.

Edit Button
Clicking the Edit button allows you to edit the record you are currently viewing.

New Button
Clicking the New button creates a new record of the same type you are currently working with.

Copy Button
Clicking the Copy button creates a copy of the record you are currently viewing. You can then 
edit this record as needed. This can speed repetitive tasks such as adding multiple pieces of the 
same type and model of equipment to your inventory.

Note: For clarity, this image shows all Toolbar buttons active. The active but‐
tons you will actually see depend on the functions available at the moment. 
Unavailable buttons will appear grayed out.

Exit HEMS

Edit

New

Copy

Delete

Save

Cancel

Refresh

Close
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Delete Button
Clicking the Delete button deletes the record you are currently viewing. A confirmation dialog 
appears, asking you to confirm or cancel the deletion.

Save Button
Clicking the Save button saves the record you are currently working on to the HEMS database.

Cancel Button
Clicking the Cancel button cancels your most recent action.

Refresh Button
Clicking the Refresh button refreshes the record you are currently viewing with the most recent 
information from the HEMS database.

Close Button
Clicking the Close button closes the window you are currently viewing. You will be prompted to 
save any unsaved changes.

Note: You cannot delete any record that has had an action performed on it or 
that has been used in HEMS because it is part of your history. You can deacti‐
vate a record by clearing the selected record’s Active checkbox, and can config‐
ure HEMS to not display deactivated records. Please see “Service Area 
Configuration” on page 263 for more information.

CAUTION: DELETED RECORDS CANNOT BE RECOVERED. DO NOT DELETE 
RECORDS UNLESS YOU ARE ABSOLUTELY SURE THAT THEY SHOULD BE PER‐
MANENTLY REMOVED FROM THE HEMS DATABASE.

AUTHORED BY ANTHONY HERNANDEZ - (415)786-2081 - anthony94122@outlook.com
38 January 2010 - Revision 1.0



HEMS Enterprise 5.x User & Administrator Guide
Reports Sidebar
The Reports sidebar allows you to quickly run any of the available HEMS 
reports. Please see “Reports Sidebar Defaults” on page 246 for information 
about configuring report defaults. 

You may access reports by either:

• Clicking a category button at the bottom of the Reports sidebar and then 
double‐clicking the icon of the report you want to run, or

• Entering a report name or keyword into the Search field at the top of the 
Reports sidebar and then running one of the matching reports by double‐
clicking its icon.

Reports appear in a separate browser window. Available filtering options, if 
any, will also appear in the browser window. To filter a report, enter your 
desired criteria and then click the View Report button. You can hide filtering 
options by clicking the double up‐arrow button, or display these options by 
clicking the double‐down arrow button.

This section describes the standard HEMS reports. EQ2 can design custom 
reports for you, or provide assistance for users with report design experience.

Work Order Reports
HEMS includes the following work order reports, which are available by clicking 
the Work Order category button at the bottom of the Reports sidebar:

Work Order Review (Summary)
Review pending versus closed work orders including percentages, costs, and 
hours. Please see “Work Order Review (Summary)” on page 198 for more infor‐
mation about this report.

Work Order Review (Detail)
Review pending versus closed work orders with details, including the request 
and the action taken. Please see “Work Order Review (Detail)” on page 198 for 
more information about this report.

Work Order Equipment Review (Summary)
Review pending versus closed work orders based on the equipment including 
percentages, costs and hours. This report includes equipment related items 
(such as equipment type, equipment model, device inclusion). Please see 
“Work Order Equipment Review (Summary)” on page 199 for more information 
about this report.
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Work Order Equipment Review (Detail)
Review pending versus closed work orders with details, including the request and action taken 
based on the equipment on the work order. This report includes equipment related items (such 
as equipment type, equipment model, device inclusion). Please see “Work Order Equipment 
Review (Detail)” on page 199 for more information about this report.

Work Order Labor Review (Summary)
Review labor hours on work orders based on one or more date(s) when the work orders were 
opened, closed, or the date(s) actual services were provided. Please see “Work Order Labor 
Review (Summary)” on page 200 for more information about this report.

Management Reports
HEMS includes the following management work order reports, which are available by clicking the 
Management category button at the bottom of the Reports sidebar:

Work Order Response Time (Detail)
How quickly you are responding to work with details, including the request and/or action. This 
report can be used for safety committee and quality control committee meetings. When running 
the report, you can define the response time in hours. You can also filter for your high‐priority 
work orders and set the response time to the appropriate number of hours according to your 
policy. Please see “Work Order Response Time (Detail)” on page 201 for more information about 
this report.

Work Order Response Time (Summary)
How quickly you are responding to work. This report can be used for safety committee and qual‐
ity control committee meetings. When running the report, you can define the response time in 
hours. You can also filter for your high‐priority work orders and set the response time to the 
appropriate number of hours according to your policy. Please see “Work Order Response Time 
(Summary)” on page 202 for more information about this report.

Work Order Close Time (Summary)
How quickly you are completing work. This report can be used for safety committee and quality 
control committee meetings. When running the report, you can define the close time in hours. 
You can also filter for your high‐priority work orders and set the close time to the appropriate 
number of hours according to your policy. Please see “Work Order Close Time (Summary)” on 
page 202 for more information about this report.

Work Labor Close Time (Detail)
How quickly you are completing work with details, including the request and/or action. This 
report can be used for safety committee and quality control committee meetings. When running 
the report, you can define the close time in hours. You can also filter for your high‐priority work 
orders and set the close time to the appropriate number of hours according to your policy. 
Please see “Work Order Close Time (Detail)” on page 202 for more information about this report.
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Work Order Summation by Priority
Summarizes total work orders count, percentage, hours, and costs by priority. To report on pre‐
ventive maintenance work orders only, filter the report by setting the WO Type to Scheduled. 
Please see “Work Order Summation by Priority” on page 203 for more information about this 
report.

Work Order Summation by Department
Summarizes total work orders count, percentage, hours, and costs by department. To report on 
preventive maintenance work orders only, filter the report by setting the WO Type to Scheduled. 
Please see “Work Order Summation by Department” on page 203 for more information about 
this report.

Regulatory Compliance Report
Encapsulates all of the information required for regulatory compliance, active inventory, cost 
spent on work orders for user error and/or equipment abuse. This report lets you look at how 
your hospital is performing in one click. Please see “Regulatory Compliance” on page 203 for 
more information about this report.

Quality Survey Remarks
This report shows the remarks submitted by users in response to quality surveys about the ser‐
vices provided by your department. Surveys are conducted after work is completed. This report 
is only available if you have the optional EQ2 Web Enterprise add‐on installed. Please see “EQ2 
Web Enterprise” on page 285 for more information about the EQ2 Web Enterprise add‐on.

Quality Survey
This report shows the satisfaction level of departments for services performed for them. This 
information is based on quality surveys conducted after work is completed. This report is only 
available if you have the optional EQ2 Web Enterprise add‐on installed. Please see “EQ2 Web 
Enterprise” on page 285 for more information about the EQ2 Web Enterprise add‐on.

Equipment Reports
HEMS includes the following equipment reports, which are available by clicking the Equipment 
category button at the bottom of the Reports sidebar:

Equipment Detail Report
Detailed information about equipment in inventory. Please see “Equipment Detail” on page 205 
for more information about this report.
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Management Program Inventory
This report only covers equipment in the preventive maintenance management program. Man‐
agement program inventory contains all equipment items that have a higher risk factor than the 
minimum required for placing the equipment into the management program as well any equip‐
ment that does not have risk defined. This report also compares the number of preventive main‐
tenance and repair work orders. Please see “Management Program Inventory” on page 206 for 
more information about this report.

Equipment List
This report shows the equipment inventory in list format. Technicians can run this report for a 
quick glance at equipment with next due date for preventive maintenance. Please see “Equip‐
ment List” on page 206 for more information about this report.

Equipment Overdue for PM
Displays equipment that is more than 30 days overdue for preventive maintenance. Please see 
“Equipment Overdue for PM” on page 207 for more information about this report.

Equipment List with Purchase Information
Shows the equipment inventory in a list format including purchase information. This report is 
useful when the owner department needs information regarding purchasing decisions or equip‐
ment age. Please see “Equipment List with Purchase Information” on page 207 for more informa‐
tion about this report.

Equipment Summary
Summary information about equipment in inventory. Please see “Equipment Summary” on 
page 208 for more information about this report.

Equipment List with Schedule Information
Shows the equipment inventory in list format, including schedule information. This can be used 
to review equipment schedule information with the next due date. Please see “Equipment List‐
ing with Schedule Information” on page 208 for more information about this report.

Equipment Downtime
Lists equipment with its downtime. Please see “Equipment Downtime” on page 209 for more 
information about this report.

Equipment History
Lists equipment items and the maintenance history for each item. Please see “Equipment His‐
tory” on page 209 for more information about this report.

Equipment with Parts
Lists equipment items and their associated parts. Please see “Equipment with Parts” on page 210 
for more information about this report.
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Rate of Occurrence of Failure
Identifies the equipment is failing most frequently according to unscheduled (repair) events. 
Failed equipment slows production and incurs costs. Failures are a metric for management to 
review and determine wither preventive maintenance must be increased, equipment replaced, 
etc. This is the flip side of the Maximum Expenditure Limit report. Please see “Rate of Occur‐
rence of Failure” on page 210 for more information about this report.

Maximum Expenditure Limit
Lists equipment items with life expectancy, purchase, and purchase price defined. This report 
provides a baseline for establishing a equipment replacement program. If the Repair Cost is more 
than the Maximum Expenditure Limit (MEL) then it is time to purchase new equipment. The new 
cost that appears in the report is a straight line calculation that adds 3% to the equipment’s orig‐
inal cost per annum. Please see “Maximum Expenditure Limit” on page 211 for more information 
about this report.

Closed Percentage per Month
This report only covers equipment in the preventive maintenance management program. Shows 
the count of scheduled equipment in the preventive maintenance program per month per prior‐
ity and the count of equipment closed within that month. Please see “Closed Percentage per 
Month” on page 212 for more information about this report.

Schedule (PM) Reports
HEMS includes the following preventive maintenance schedule reports, which are available by 
clicking the Schedule (PM) category button at the bottom of the Reports sidebar:

Procedure Review
Displays a procedure and its associated tasks in sequence. This report also shows all of the equip‐
ment associated with the procedure, if selected. Please see “Procedure Review” on page 213 for 
more information about this report.

Preventive Maintenance Summary
Lists preventive maintenance schedules based on your search criteria. Please see “Preventive 
Maintenance Summary” on page 213 for more information about this report.

Annual Schedule Load
Review your scheduled load to see equipment scheduled per month and estimated hours per 
month. Define the grouping based on how you perform preventive maintenance (such as by 
department, equipment type, etc.). Please see “Annual Schedule Load” on page 214 for more 
information about this report.

Note: The fact that a piece of equipment is approaching or beyond its projected 
useful life expectancy is not by itself a sufficient reason to replace the item.
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PM Parts Due - Shortage
Lists parts that need to be ordered to cover the selected preventive maintenance period. HEMS 
calculates the shortage by subtracting stock on hand from the parts required for preventive 
maintenance for the selected period. Please see “PM Parts Due ‐ Shortage” on page 214 for more 
information about this report.

PM Parts Due
Lists parts required for preventive maintenance without considering stock on hand. Please see 
“PM Parts Due” on page 215 for more information about this report.

Risk Reports
HEMS includes the following risk reports, which are available by clicking the Risk category button 
at the bottom of the Reports sidebar:

Risk Interval
Displays preventive maintenance intervals and priority based on risk factor. Please see “Risk 
Interval” on page 216 for more information about this report.

Risk Category
Displays statements sorted by risk category. Please see “Risk Category” on page 216 for more 
information about this report.

Other Reports
HEMS includes the following other reports, which are available by clicking the Other category 
button at the bottom of the Reports sidebar:

Parts with Equipment
Lists parts and their associated equipment. Please see “Parts with Equipment” on page 217 for 
more information about this report.

Equipment with Network Information
This is a sample custom report with custom fields pertaining to network information defined in 
the equipment inventory. Please see “Equipment with Network Information” on page 217 for 
more information about this report.
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Shortcuts
HEMS includes keyboard, mouse, and calendar shortcuts to make your work faster and easier.

Keyboard Shortcuts
HEMS contains several keyboard shortcuts (or “hot keys”) that allow users to open windows or 
quickly perform common functions in the Activities and Information Lists windows. The avail‐
able keyboard shortcuts are:

Editing Shortcuts
• [CTRL]+[A]: Selects all of the text in the current field.

• [CTRL]+[C]: Copies the current text to the Windows Clipboard.

• [CTRL]+[V]: Paste the contents of the Windows Clipboard to the current field.

• [CTRL]+[X]: Removes the current text and places it in the Windows Clipboard.

• [CTRL]+[Z]: Undoes the last action.

• [DEL]: Clears the current text or record.

Record Shortcuts
• [CTRL]+[D]: Deletes the current record.

• [CTRL]+[E]: Edits the current record.

• [CTRL]+[N]: Adds a new record.

• [CTRL]+[K]: Creates a copy of the current record.

• [CTRL+[S]: Saves the current record.

Interface Shortcuts
• [CTRL]+[Q]: Opens the Quick Work Orders window. Please see “The Quick Work Orders Win‐

dow” on page 66 for more information about the Quick Work Orders window.

• [CTRL]+[I]: Opens the Equipment Inventory dashboard. Please see “The Equipment Inven‐
tory Dashboard” on page 22 for more information about the Equipment Inventory dash‐
board.

• [CTRL]+[T]: Opens the Parts Inventory window. Please see “Parts Inventory Window” on 
page 170 for more information about the Parts Inventory window.

• [CTRL]+[W]: Opens the Work Orders dashboard. Please see “The Work Orders Dashboard” 
on page 17 for more information about the Work Orders dashboard.

• [CTRL]+[F4]: Closes the current window.

• [ALT]+[F4]: Exits HEMS.
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Dashboard Shortcuts
• [ALT]+[C]: Copies the selected record.

• [ALT]+[D]: Deletes the current record.

• [ALT]+[N]: Creates a new record.

• [ALT]+[T]: Edits the current record.

Miscellaneous Shortcuts
• [F1]: Opens the searchable HEMS Help.

• [F2]: Opens a search window when resting on a field, or a pick list that contains predefined 
text for text fields.

• [F7]: Opens a spell checker.

• [F8]: Enter your signature (your HEMS Login ID) and date/time stamp in the currently 
selected text field.

• [F10]: Enlarge the current text field.

Mouse Shortcuts
Right‐clicking in HEMS allows you to:

• Add a new record that currently isn’t in your Information List.

• Edit a record.

• Access the Search window to search for a value from an Information List.

Note: You must have Microsoft Word® 2000 or later installed on your system to 
access this function. The HEMS spell checker uses the spelling and grammar 
defaults defined within Word. To change these defaults, launch Word and then 
select Tools>Options>Spelling & Grammar. If you are using Word 2007, click 
the Microsoft Office button and then select Word Options.

Note: Adding and editing a record using the right‐click function retrieves the 
appropriate information list (see “CHAPTER 6: Information Lists” on page 123), 
which ensures that you are properly editing records in your list and not adding 
nonstandard values or other entries “on the fly,” which can lead to data discrep‐
ancies caused by variant spellings and abbreviations, misspellings, etc.
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Calendar
HEMS generates all default dates and times based on the system date and time, and uses military 
(24‐hour) time. For added speed, you can enter a single year digit. For example, entering 9 
defaults to 2009.

Calendars are available on all date fields within HEMS. You can enter 
dates manually, or you can select the Calendar icon next to the date field 
to open the Calendar window. To use the Calendar window:

• Navigate months by selecting the forward or backward arrow.

• View a list of months by clicking on the month.

• Change the year by clicking the year and using the forward and back‐
ward arrows to select your desired year.

• Click a date to select it and input into the date field.
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Adding Values to Fields
Different fields get information from various sources, including:

• Manual text entry.

• Read‐only fields inherit information from different fields.

• Date fields have a calendar icon next to them. Please see “Calendar” on page 47 for more 
information about the HEMS Calendar function.

• Information Lists. These lists often contain specific values, such as equipment model num‐
bers (from the Equipment Models Information List) or work order type (from the Work 
Order Types Information List). Fields that use this function have a blue down arrow next to 
them. Please see “CHAPTER 6: Information Lists” on page 123 for more information about 
Information Lists.

• The Predefined Text Information List. This Information List contains text that can be added to 
text fields with just a few mouse clicks. Please see “Predefined Text List” on page 145 for 
more information about the Predefined Text Information List.

Obtaining values from the HEMS Calendar function and Information Lists increases both speed 
and data accuracy by providing a library of standard terminology and text that can be quickly 
selected and inserted where needed with just a few keystrokes and/or mouse clicks.

Using Information List Values
To add an Information List value to a field:

1. Select the field where you want to insert the Information List value.

2. Click the down arrow to the right of the selected field to open a list of possible values for that 
field.

3. Scroll as needed, then click your desired value to update the field.

Using Predefined Text
To add predefined text to a text field:

1. Right‐click the selected text field, and then select Predefined Text to open a list of text strings 
available for your currently selected text field. (You can also press [F2].)

2. Scroll as needed, then click your desired value to update the field.

3. Please see “Working with Information Lists” on page 159 for information about adding, edit‐
ing, and removing text from the Predefined Text Information List.

Note: Some fields allow multiple means of data entry. For example, you can 
enter dates either manually or by using the HEMS Calendar function.
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Searching Information Lists
You can search the Information List for the correct value if you're not sure what entry to use or 
are unable to locate the correct value. To search the Information List for your currently selected 
field:

1. Open the Information List window by either:

‐ Right‐clicking the field and selecting Search, or

‐ Pressing [F2].

2. The Information List window appears with the name of the appropriate Information List in its 
title bar. For example, if you are adding a value to the Model # field in the Equipment Inven‐
tory window, the Information List window will say Equipment Models.

3. Search for the appropriate Information List value by entering your desired search term(s) and 
click Search. Matching results appear as a list below the search fields.

4. Highlight your desired value and click Select. The value appears in the selected field and 
other fields may also be populated with related information.

The Information List Window
The Information List window appears as 
shown here and contains the following 
functional areas:

• Search Area: Allows you to search for 
Information List values. This image 
shows an example of a Find mode 
search area. The actual search 
options available will depend on the 
field you are entering a value for. 
Please see “Search Area (Find Mode)” 
on page 159 and “Search Area (Filter 
Mode)” on page 160 for more infor‐
mation about using the Search Area.

• Report/Print Buttons: Allow you to 
run reports and print/export data. 
Please see “CHAPTER 12: Printing & 
Exporting Data” on page 233 for more 
information about printing and 
exporting data in HEMS.

• Search Mode Buttons: Switch between Find and Filter modes, and display records added 
during the current HEMS session. Please see “Search Mode Buttons” on page 160.

• Results Area: Search results appear here.

• Action Buttons: Place your desired value into the selected field.

Search
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Search 
Mode 

Buttons
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• Open List Button: Opens the full Information List window for the current Information List.

Results Area
The Results Area displays the results of your search. You can:

• Highlight a result to add it to the current text field by either clicking Select or by double‐click‐
ing the value.

• Sort in ascending (A‐Z) order by clicking the header of the column you want to sort by.

• Rearrange the order in which columns appear by clicking and dragging the column headers 
left or right. HEMS remembers this and will present your selected column order in the future.

• Navigate the results using the following navigation buttons:

‐ To go to the first page of results, click the << button.

‐ To go to the previous page of results, click the < button.

‐ To go the next page of results, click the > button.

‐ To go to the last page of results, click the >> button.

Action Buttons
The Information List window has two Action buttons:

• Select: Clicking Select places the value you highlighted in the Results area into your currently 
selected field and closes the Information List window.

• Cancel: Clicking Cancel closes the Information List window without placing a value in your 
currently selected field.

Open List Button
Clicking the Open List button opens the appropriate Information List. Please see “CHAPTER 6: 
Information Lists” on page 123 for more information about Information Lists.

Adding Information List Values
Adding a new Information List value adds a new entry to the appropriate Information List. Please 
see “CHAPTER 6: Information Lists” on page 123 for more information about the Information 
Lists. To add a new Information List value:

1. If you do not find the value you are trying to add after searching as described above, right‐
click the field you want to add the new Information List value to, and then select Add New.

2. Add the new Information List value as described in “Adding a Record” on page 161.
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Editing Information List Values
Editing an existing Information List value modifies the corresponding entry in the appropriate 
Information List. Please see “CHAPTER 6: Information Lists” on page 123 for more information 
about the Information Lists. To edit an Information List value:

1. Enter the value you want to edit in the selected field, as described above.

2. Right‐click the field and then select Edit. A window appears with the current value. The fields 
in this window will vary depending on the value you are editing.

3. Edit the Information List value as described in “Editing a Record” on page 167.
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This page intentionally left blank.
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CHAPTER 4:
Work Orders
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Managing Work Orders
HEMS uses two basic categories of work orders:

• Scheduled: Preventive maintenance work orders. These work orders have a HEMS system 
value of Scheduled.

• Unscheduled: Work orders created on demand to address corrective maintenance such as 
Routine, Hazard, Education, Failure, Project, etc. You can add to this list as needed.

Preventive Maintenance (WO Type = Scheduled)
Once configured, HEMS automatically schedules newly added equipment items for preventive 
maintenance based on the schedule template defined in the equipment type, model, or individ‐
ual item. Please see “Scheduling Equipment” on page 107 for more information about schedul‐
ing equipment.

Generate scheduled work orders every month using the Generate Scheduled Work Orders win‐
dow, as described in “Generating Scheduled Work Orders” on page 81. You may also issue on‐
demand preventive maintenance work orders using either the Work Orders dashboard (as 
described in “Creating from the Work Orders Dashboard” on page 72) or the Equipment Inven‐
tory dashboard (as described in “Opening a Work Order from the Equipment Inventory Dash‐
board” on page 121).

After generating the scheduled work orders, you may print copies for each technician. If you are 
using EQ2 Mobile, the technicians will automatically receive their assigned work orders on their 
Pocket PC devices.

Technicians can update the work order with the appropriate action taken, labor, and parts if 
required, change the work order Status to Closed, and change the Subcode as appropriate, to 
either:

• PM Successful: If preventive maintenance succeeded, or

• PM Failed: If preventive maintenance revealed a problem that was repaired when the main‐
tenance was performed, or the technician discovered a more severe problem that required 
tagging out the equipment item. In the latter case, the technician can open a new corrective 
work order and update it as necessary.

Note: System‐generated scheduled work orders have a System Generated 
stamp in order to easily identify system‐generated preventive maintenance 
work orders from on‐demand preventive maintenance work orders.
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The following lists contain recommended subcodes, work order statuses, and labor codes for 
scheduled work orders:

• Subcodes:

‐ Device in Use: If preventive maintenance was not performed because the device was in 
use.

‐ Unable to Locate: If preventive maintenance was not performed because the technician 
was unable to locate the device.

‐ PM Failure: If the preventive maintenance was performed and a failure was found.

‐ PM Successful: If the preventive maintenance was successful and no failure was found.

• Work Order Statuses:

‐ Open: Status of the work order when a new request is made.

‐ Closed: Status of the work order once the request has been completed.

‐ Hold: If the job is on hold due to any reason other than awaiting parts.

‐ Awaiting Parts: If the job is on hold while awaiting parts.

• Labor Codes:

‐ Locating Equipment: Time spent locating an equipment item.

‐ Wait Time: Time spent waiting for an in‐use equipment item to become available.

‐ Travel Time: Time spent traveling.

‐ PM: Time spent performing the preventive maintenance procedure.

Corrective Maintenance (WO Type=Routine, Failure, etc.)
Corrective maintenance work orders are opened whenever a problem occurs with or without an 
equipment item. Enter the user’s request in the work order Request Text field with enough detail 
for the technician to be able to diagnose the problem and make the repair. The work order 
should be updated with action taken, labor, and parts if required, then closed once the repair is 
completed.

The following lists contain recommended subcodes, work order statuses, and labor codes for 
unscheduled work orders:

• Subcodes:

‐ Operator Error: If the work request occurred due to operator error.

‐ Abuse/Physical Damage: If the work request occurred due to equipment abuse or other 
damage.

‐ Battery Failure: If the work request occurred because of battery failure.

‐ Accessory Failure: If the work request resulted because of any accessory failure (such as 
broken cords, lead wires, etc.).
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• Work Order Statuses:

‐ Open: Status of the work order when a new request is made.

‐ Closed: Status of the work order once the request has been completed.

‐ Hold: If the job is on hold due to any other reason than awaiting parts.

‐ Awaiting Parts: If the job is on hold while awaiting parts.

‐ Sent for Repair: If the work order is on hold because the equipment has been sent out for 
repair.

• Labor Codes

‐ Overtime: Job performed after work hours or on holidays, if that is considered overtime 
at your facility.

‐ Callback After Hours: Job performed after hours due to call back.

‐ Locating Equipment: Time spent locating an equipment item.

‐ Wait Time: Time spent waiting for an in‐use equipment item to become available.

‐ Travel Time: Time spent in travelling.

‐ Repair: Time spent repairing.

Recall/Alert
The EQ2 HEMS ECRI Interface makes adding recall/alert work orders for equipment fast, easy, 
and automatic. Please see “EQ2 Alert & Recall” on page 284 for more information about the 
HEMS ECRI interface.

In HEMS Enterprise, open a new work order, select Recall/Alert as the type, and paste the recall/
alert text into the request text. Make sure to add all of the required equipment to the work 
order. 

Retiring Equipment
Retiring one or more equipment items from service requires a Retired type work order if the 
equipment needs any kind of inspection or other maintenance prior to being retired. HEMS auto‐
matically generates the work orders. Please see “Retiring Equipment” on page 119 for more 
information about retiring equipment.
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HEMS Work Order Windows
HEMS includes the following work order windows:

• Work Orders dashboard: The Work Orders dashboard allows you to find, view, open, update, 
and close work orders and also run reports for printing or exporting. Please see “The Work 
Orders Dashboard” on page 17 for more information about the Work Orders dashboard.

• Work Order window: The Work Order window allows you to open work orders and docu‐
ment work performed on work orders. Please see “The Work Order Window” on page 60 for 
more information about the Work Order window.

• Quick Work Orders window: The Quick Work Orders window lets you save time by updating 
and/or closing multiple work orders at once (such as adding the same action text or labor 
entry to multiple work orders). Please see “The Quick Work Orders Window” on page 66 for 
more information about the Quick Work Order window.

• Assign Work Orders window: The Assign Work Orders window allows a manager to quickly 
assign or reassign work orders to a technician. Please see “The Assign Work Orders Window” 
on page 68 for more information about the Assign Work Orders window.

The Work Orders Dashboard
Clicking the Work Orders button in the HEMS Home screen (see “The Home Screen” on page 14) 
or clicking the Work Orders tab opens the Work Orders dashboard, which allows you to quickly 
look up and review work orders. You can also open, update, copy, and/or close work orders.

Search Area

Action Area

Results
Area

Details
Area

Report/
Print

Buttons

Search 
Mode 

Buttons
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Please see “The Work Orders Dashboard” on page 17 for more information about the Work 
Orders dashboard layout.

The Work Order Window
The Work Order window allows you 
to open, update, and/or close work 
orders. You may configure both 
individual user work order defaults 
and Service Area department/loca‐
tion work order preferences to have 
certain fields automatically filled in 
when you open work orders. Please 
see “Work Order Defaults” on 
page 247 for information on setting 
individual user work order defaults 
and “Service Area Configuration” 
on page 263 for information on set‐
ting department/location prefer‐
ences.

The Work Order window contains 
the following information:

• Requester: Initials of the person who is requesting the work order. This field uses values from 
the Employees Information List, which is described in “Employees List” on page 126.

• Name: Requester’s name. Use this field if the requester is not entered in the Employees 
Information List. Once entered, this name will also appear in the work order Request Text 
field.

• Cost Center: This number is used for accounting purposes. This field uses values from the 
Departments Information List, which is described in “Departments List” on page 124.

• Department: Department making the request (typically the department that owns the 
equipment item). This field uses values from the Departments Information List, which is 
described in “Departments List” on page 124.

• Location: Location of the equipment (if the work order is for an equipment item). This field 
uses values from the Locations Information List, which is described in “Locations List” on 
page 140.

• Phone #: Phone number of the requester. This field uses values from the Employees Informa‐
tion List, which is described in “Employees List” on page 126.

• Priority: Priority of the work order. This field uses values from the Work Order Priorities 
Information List, which is described in “Work Order Priorities List” on page 156.

• Print After Save: Checking the Print After Save checkbox prints a technician’s copy of the 
work order after you save it.
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• Type: Work order type. Please see “Managing Work Orders” on page 56 for more information 
about work order types. This field uses values from the Work Order Types Information List, 
which is described in “Work Order Types List” on page 158.

• Est Hours: Estimated number of hours required to complete the work order. This field uses 
values from the Procedures Information List, if defined, which is described in “Procedures 
List” on page 146. You may manually enter hours for corrective work.

• Issue Date: Date the work order was issued (or requested, if the work order was entered 
using EQ2 Web Enterprise).

• Assigned Engineer: Engineer assigned to work on the work order and/or equipment item(s). 
This field uses values from the Employees Information List, which is described in “Employees 
List” on page 126.

• Specialty: Maintenance specialty or trade required to complete the work order (such as 
BMET, Carpentry, etc.). This field uses values from the Maintenance Specialties Information 
List, which is described in “Maintenance Specialties List” on page 144.

• Subcode: Additional tracking information for the work order. For preventive maintenance 
work orders, this documents the outcome (such as “PM Successful”), as described in “Pre‐
ventive Maintenance (WO Type = Scheduled)” on page 56. For corrective work orders, this 
field documents the cause (such as “Failure”), as described in “Corrective Maintenance (WO 
Type=Routine, Failure, etc.)” on page 57. This field uses values from the Subcodes Informa‐
tion List, which is described in “Subcodes List” on page 152.

• Status Date: Date the work order was closed, or, if the work order is still pending, you can 
manually enter the date and time of the last action taken on the work order.

• Status: Most recent status of the work order (such as “Awaiting Parts,” etc. as described in 
“Preventive Maintenance (WO Type = Scheduled)” on page 56 and “Corrective Maintenance 
(WO Type=Routine, Failure, etc.)” on page 57) until work is complete and the work order sta‐
tus is changed to Closed. This field uses values from the Work Order Statuses Information 
List, which is described in “Work Order Status List” on page 157.

• Procedure: The preventive maintenance procedure. HEMS automatically fills the procedure 
for both system‐generated scheduled work orders and on‐demand preventive maintenance 
work orders. You may manually define a procedure for corrective work orders as needed. This 
field uses values from the Procedures Information List, which is described in “Procedures 
List” on page 146. For corrective work orders, you can manually enter the procedure, if 
known.

• Request Text: The Request Text field is where the work request is documented. This field 
contains the procedure and tasks for scheduled work orders. You may use predefined text to 
quickly add frequently used text. Predefined text is stored in the Predefined Text Information 
List, which is described in “Predefined Text List” on page 145.
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• Action Text: The Action Text field is where the action taken on the work order is docu‐
mented. You may use predefined text to quickly add frequently used text. You may add your 
signature (HEMS user ID and date/time stamp) to this field by pressing [F8].Predefined text is 
stored in the Predefined Text Information List, which is described in “Predefined Text List” on 
page 145.

Equipment Tab
The Equipment tab of the Work 
Order window contains the follow‐
ing information about the equip‐
ment item(s) included in the current 
work order:

• Control #: Equipment item con‐
trol number.

• Equipment Type: Type of equipment. This is obtained from the Equipment Types Informa‐
tion List, which is described in “Equipment Types List” on page 134.

• Closed: For a work order with multiple pieces of equipment, you may indicate that work on a 
particular equipment item has been completed to track your progress on the work order.

• Group: If the equipment is part of a group, the equipment group name is displayed.

To add an equipment item to a work order, simply enter the item’s control number in the Control 
# field.

Clicking the Select Equipment button opens the Select Equipment window, which lets you 
search for and add one or more equipment item(s) to the work order. Please see “The Select 
Equipment Window” on page 69 for more information about the Select Equipment window.

Selecting an equipment item in the list and then checking the Closed checkbox indicates that 
work on that equipment item has been completed.

Equipment history can be viewed in the Equipment History window (H button) from the Equip‐
ment Inventory dashboard. Please see “The Equipment History Window” on page 103 for more 
information about the Equipment History window.

Labor Tab
The Labor tab of the Work Order win‐
dow allows technicians to record 
labor performed on the current work 
order. You may add or delete labor 
entries by clicking the New or Delete 
button on the right side of the tab as 
appropriate.

The Labor tab contains the following information for each labor entry in the selected work order:

• Initials: Initials of the engineer who performed the work. This field defaults to the initials of 
the assigned engineer (if any). You may edit the default entry or can add or delete labor 
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entries. This field uses values from the Employees Information List, which is described in 
“Employees List” on page 126.

• Start Date/Time: Date and time the selected labor entry began. The first entry defaults to 
the work order issue date and time. Subsequent entries default to the date/time. You may 
also manually enter the date/time work was performed.

• Total Time: Total time spent responding to the work order for the selected labor entry. This 
field uses decimal entries. For example, half an hour is entered as 0.5.

• End Date/Time: Date and time the selected labor entry ended. HEMS calculates this using 
the Start Date/Time and Total Time fields.

• Rate: The rate may default to the technician's labor rate, maintenance specialty rate, or stan‐
dard Service Area rate based on your HEMS system configuration. Labor rates are defined in 
the Employees Information List. Specialty and standard Service Area rates are defined in the 
Service Area and Specialty Rates window. Please see “Service Area and Specialty Rates” on 
page 266 for more information about the Service Area and Specialty Rates window.

• Premium: Indicates whether an employee is on overtime or not. The default is straight time 
(1.00 x pay rate). Enter the appropriate overtime rate, if needed (typically 1.50 depending on 
local labor regulations and contracts). You must have a valid hourly rate entered in the 
employee’s record for HEMS to calculate the premium amount. Please see “Employees List” 
on page 126 for more information about the Employees Information List.

• Lump Sum: Any additional labor costs that are not otherwise accounted for such as overhead 
or external costs.

• Codes: Labor codes provide more detailed information on the labor entry, such as “Locating 
Equipment,” “Travel time,” etc. Please see “Managing Work Orders” on page 56 for more 
information about labor codes. This field uses values from the Work Order Codes Informa‐
tion List, which is described in “Work Order Codes List” on page 155.

• PO: Purchase order that covers the selected labor entry, if any. This field uses values from the 
Purchase Orders Information List, which is described in “Purchase Orders List” on page 150.

• Control #: Control number of the equipment item that the technician worked on during the 
selected labor entry.

• Shift: Checking the Shift checkbox automatically calculates the labor according to the shift 
defined in the Shifts Information List, which is described in “Shifts List” on page 152. 

• Vendor: This checkbox is included for backward compatibility with older versions of HEMS. 
Checking the Vendor checkbox indicates that the assigned engineer is a contractor or outside 
vendor. 

• Avg: This checkbox is included for backward compatibility with older versions of HEMS. 
Checking the Avg checkbox averages labor time and costs among equipment items if the 
work order contains multiple equipment items.
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Parts Tab
The Parts tab of the Work Order win‐
dow lists all of the parts required for 
this work order. You can add and 
remove parts from this list if needed. 

The Parts tab contains the following 
information for each part entry in the 
selected work order:

• Part #: HEMS part number. This number is unique for each part entered in HEMS.

• Part # (Non Inventory): Part number (if the part is not stored in the HEMS parts inventory). 
You may manually enter part numbers in this field.

• Quantity: How many units of the selected part were used.

• On Date: Date and time the listed part was used.

• Lump Sum: Any additional costs for parts such as overhead or shipping.

• Codes: Labor codes provide more detailed information on the part entry, such as “Ordering 
Parts,” “Travel time,” etc. Please see “Managing Work Orders” on page 56 for more informa‐
tion about part codes. This field uses values from the Work Order Codes Information List, 
which is described in “Work Order Codes List” on page 155.

• PO: Purchase order that covers the selected part, if any. This field uses values from the Pur‐
chase Orders Information List, which is described in “Purchase Orders List” on page 150.

• Control #: Equipment item that the part was used for.

• Avg: This checkbox is included for backward compatibility with older versions of HEMS. 
Checking the Avg checkbox averages parts costs among equipment items if the work order 
contains multiple equipment items.

• Units: How the part is measured.

• Unit Cost: How much each unit of the part costs. This field is automatically filled from the 
Standard Price value in the Parts Inventory List record for the selected part. If the Standard 
Price is not entered for this part, HEMS will use the Last Price value stored in the Parts Inven‐
tory List record for the part. This field uses values from the Parts Inventory window, which is 
described in “Parts Inventory Window” on page 170. You may manually enter cost informa‐
tion for parts not in inventory.
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Attachment Tab
The Work Order window includes an 
Attachments tab that allows you to 
attach documents and/or images 
related to the current work order.

• To add an attachment, select 
Attach to open a standard Win‐
dows dialog that allows you to 
select the file name, type, and location to attach. HEMS supports the DOC, GIF, ICON, JPEG, 
PDF, TXT, XLS, and ZIP formats.

• To scan an image from a local scanner, select Scan to open a standard Windows dialog that 
allows you to scan and name the file. Click OK to scan the file.

• To delete an attached or scanned file, select the item to delete and then click the Delete but‐
ton. You are prompted to confirm your decision.

Note: To attach a file in a format that HEMS does not support, ZIP the file and 
then attach the ZIP file to the desired record.
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The Quick Work Orders Window
The Quick Work Orders window allows you to update and/or close multiple work orders at once 
to save time (such as adding the same action text or labor entry to multiple work orders). You can 
open the Quick Work Orders window by either:

• Clicking the Quick Work Orders button in the Home screen.

• Selecting Activities>Quick Work Orders.

• Pressing [CTRL]+[W].

The Quick Work Orders window appears as follows:

To use the Quick Work Orders window:

1. Search for the work order(s) you want to update or close using the Search Area.

2. Select the work order(s) to update or close in the Search Results Area and then move that 
information to the Selection Area using the following Selection buttons:

‐ Clicking the >> button moves all of the work orders in the Search Result Area to the Selec‐
tion Area.

‐ Clicking the > button moves the currently selected work order in the Search Result Area 
to the Selection Area.

‐ Clicking the < button removes the currently selected work order from the Selection Area 
back to the Search Results Area.

‐ Clicking the << button removes all of the work orders in the Selection Area back to the 
Search Results Area.
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3. Update the work order(s) by entering the appropriate information in the fields in the Action 
Area. This information will be added to all selected work orders. If you need to run a new 
search, click the Reset button in the Search Area. If you make a mistake and need to start 
over, click the Reset button in the Action Area to clear your changes.

4. Click the Apply button to save your updates to the selected work order(s). Updated work 
orders return to the Search Results Area and are highlighted in blue. You may then continue 
updating work orders by either repeating Steps 2‐4 of this process to work with your current 
search results or by clicking the Reset button in the Search Area and then starting at Step 1 to 
run a new search.

The Report/Print buttons provide quick access to relevant reports. From the left to right, the 
buttons are:

• List Report: Clicking the List Report button opens a summary report for all of the work orders 
in the Selection Area.

• Detail Report ‐ All: Clicking the Detail Report ‐ All button opens a detailed report for all of 
the work orders in the Selection Area.

• Detail Report ‐ Current: Selecting a work order in the Selection Area and then clicking the 
Detail Report ‐ Current button opens a report that provides detailed information about the 
currently selected work order.

Reports appear in a separate browser window. You can print and/or export these reports, as 
described in “CHAPTER 12: Printing & Exporting Data” on page 233.

Note: To close the selected work order(s), select Closed using the Status field.

AUTHORED BY ANTHONY HERNANDEZ - (415)786-2081 - anthony94122@outlook.com
67Copyright 2010, EQ2, Inc. All rights reserved.



CHAPTER 4: Work Orders
The Assign Work Orders Window
The Assign Work Orders window allows you to quickly assign or reassign multiple work orders to 
a maintenance technician. You can open the Assign Work Orders window by either:

• Selecting Activities>Assign Work Orders, or

• Clicking the Assign Work Orders button in the HEMS Home screen.

The Assign Work Orders window appears as follows:

To use the Assign Work Orders window:

1. Search for the work order(s) you want to assign or reassign using the Search Area.

2. Select the work order(s) to assign in the Search Results Area and then move that information 
to the Selection Area using the following Selection buttons:

‐ Clicking the >> button moves all of the work orders in the Search Result Area to the Selec‐
tion Area.

‐ Clicking the > button moves the currently selected work order in the Search Result Area 
to the Selection Area.

‐ Clicking the < button removes the currently selected work order from the Selection Area 
back to the Search Results Area.

‐ Clicking the << button removes all of the work orders in the Selection Area back to the 
Search Results Area.

3. Assign the work order(s) by entering the appropriate technician’s name in the Assigned Engi‐
neer field.

4. Add any extra information needed in the Notes field, such as the reason for assigning or reas‐
signing the work order(s). Checking the Add Text At Top checkbox places this information at 
the top of the Action Text field in the work order(s).
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5. Click the Apply button to finish assigning the selected work order(s) to the selected techni‐
cian.

The Report/Print buttons provide quick access to relevant reports. From the left to right, the 
buttons are:

• List Report: Clicking the List Report button opens a summary report for all of the work orders 
in the Selection Area.

• Detail Report ‐ All: Clicking the Detail Report ‐ All button opens a detailed report for all of 
the work orders in the Selection Area.

• Detail Report ‐ Current: Selecting a work order in the Selection Area and then clicking the 
Detail Report ‐ Current button opens a report that provides detailed information about the 
currently selected work order.

Reports appear in a separate browser window. You can print and/or export these reports, as 
described in “CHAPTER 12: Printing & Exporting Data” on page 233.

The Select Equipment Window
The Select Equipment window allows you to search for and add one or more equipment item(s) 
to a work order. You can open the Select Equipment window by clicking the Select Equipment 
button in the Equipment tab of the Work Order window, as described in “Equipment Tab” on 
page 62.

The Select Equipment window appears as follows:

To use the Select Equipment window:

1. Search for the equipment item(s) you want to add to the work order using the Search Area.
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2. Select the equipment item(s) to add in the Search Results Area and then move that informa‐
tion to the Selection Area using the following Selection buttons:

‐ Clicking the >> button moves all of the equipment items in the Search Result Area to the 
Selection Area.

‐ Clicking the > button moves the currently selected equipment item in the Search Result 
Area to the Selection Area.

‐ Clicking the < button removes the currently selected equipment item from the Selection 
Area back to the Search Results Area.

‐ Clicking the << button removes all of the equipment items in the Selection Area back to 
the Search Results Area.

3. Add the equipment item(s) to the work order by clicking the Apply button.

The Report/Print buttons provide quick access to relevant reports. From the left to right, the 
buttons are:

• List Report: Clicking the List Report button opens a summary report for all of the equipment 
items in the Selection Area.

• Detail Report ‐ All: Clicking the Detail Report ‐ All button opens a detailed report for all of 
the equipment items in the Selection Area.

• Detail Report ‐ Current: Selecting an equipment item in the Selection Area and then clicking 
the Detail Report ‐ Current button opens a report that provides detailed information about 
the currently selected equipment item.

Reports appear in a separate browser window. You can print and/or export these reports, as 
described in “CHAPTER 12: Printing & Exporting Data” on page 233.
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Working with Work Orders
This section describes how to work with work orders including opening new work orders, editing 
and closing existing work orders, and generating scheduled work orders.

Viewing Work Orders
HEMS allows you to view work orders in two ways:

• Using the Work Orders dashboard to find specific work orders.

• Using the Equipment History window from the Equipment Inventory dashboard for a 
selected equipment item, which displays that item’s work order history.

Viewing from the Work Orders Dashboard
To view a work order using the Work Orders dashboard:

1. Open the Work Orders dashboard by either:

‐ Clicking the Work Orders tab on the right of the HEMS application.

‐ Clicking the Work Orders button in the HEMS Home screen.

‐ Selecting Activities>Work Orders.

‐ Pressing [CTRL]+[W].

2. Search for and select the work order you want to view. The selected work order information 
appears in the Selection Area. Please see “The Work Orders Dashboard” on page 17 for more 
information about the Work Orders dashboard.

Viewing from the Equipment History Window
To view a work order using the Equipment History window:

1. Open the Equipment Inventory dashboard by either:

‐ Clicking the Equipment Inventory tab on the right of the HEMS application.

‐ Clicking the Equipment Inventory button in the HEMS Home screen.

‐ Selecting Activities>Equipment Inventory.

‐ Pressing [CTRL]+[I].

2. Search for the equipment for which you want to view the work order and then select that 
equipment item in the Search Results Area. Please see “Search Area (Find Mode)” on page 23 
for more information about searching for equipment using the Equipment Inventory dash‐
board.

3. Click the H button in the Action Area to open the Equipment History window, which displays 
all of the work orders for the current equipment item. Please see “The Equipment History 
Window” on page 103 for more information about the Equipment History window.
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4. Open the work order you want to view by selecting the desired work order and then either 
double‐clicking it or clicking the Edit button to open the Work Order window for the selected 
work order. Please see “The Work Order Window” on page 60 for more information about 
the Work Order window.

Creating a Work Order
HEMS allows you to create work orders from either the Work Orders dashboard or the Equip‐
ment Inventory dashboard.

Creating a work order from the Work Orders dashboard allows you to open a work order with or 
without equipment. Work order fields may automatically fill in based on your individual user 
work order defaults and department/location defaults. Please see “Configuring User Defaults” 
on page 246 for information about configuring user work order defaults and “Service Area Con‐
figuration” on page 263 for information about configuring Service Area department/location 
defaults.

Creating a work order from the Equipment Inventory dashboard automatically adds equipment 
information (control number, equipment type, department, location, assigned engineer, and 
work order type) to the work order. Please see “Opening from the Equipment Inventory Dash‐
board” on page 74 for more information about opening work orders from the Equipment Inven‐
tory dashboard.

Creating from the Work Orders Dashboard
To open an unscheduled work order using the Work Orders dashboard:

1. Open the Work Orders dashboard by either:

‐ Clicking the Work Orders tab on the right of the HEMS application.

‐ Clicking the Work Orders button in the HEMS Home screen.

‐ Selecting Activities>Work Orders.

‐ Pressing [CTRL]+[W].

2. In the Work Orders dashboard, open the Work Order window by either:

‐ Clicking the New button in the Action area.

‐ Pressing [ALT]+[N].

Note: These instructions assume that you have not defined any individual user 
or department/location work order defaults. Work order defaults save you time 
when opening unscheduled work orders from the Work Orders dashboard. 
Please see “Configuring User Defaults” on page 246 for information about con‐
figuring user work order defaults and “Service Area Configuration” on page 263 
for configuring Service Area department/location preferences.
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3. Select the initials of the person requesting the work order using the Requester field. If the 
requester is not entered in the Employees Information List, enter that person’s name in the 
Name field. This will also add the person’s name to the Request Text field.

4. Enter the Cost Center and Department information for the department making the request 
in the appropriate fields (if they were not automatically filled in).

5. Select the equipment location using the Location field (if this work order is for equipment). 
This will help the assigned technician locate the equipment.

6. Define the work order priority using the Priority field (if not automatically filled in).

7. Checking the Print After Save button prints a technician’s copy of the current work order 
after you save that work order.

8. Select the work order type using the Work Order Types field. Please see “Managing Work 
Orders” on page 56 and “Work Order Types List” on page 158 for more information about 
work order types.

9. Estimate the hours to complete the work using the Est Hours field. For preventive work 
orders, this field uses values from the Procedures Information List (if defined), which is 
described in “Procedures List” on page 146. You may enter estimated hours manually for cor‐
rective work.

10. The Issue Date is the date and time the work order was issued.

11. Select the technician to assign to this work order using the Assigned Engineer field. The Spe‐
ciality field will automatically fill depending on the assigned engineer. You can also manually 
select the specialty, if needed.

12. Select the appropriate subcode using the Subcode field. For preventive maintenance work 
orders, this field documents the outcome, such as “PM Successful.” For corrective work 
orders, this field documents the cause, such as “Battery Failure.”

13. The Status Date field displays the time and date the work order was closed. If the work order 
is still pending, you may manually enter the date and time of the last action taken.

14. Enter the most recent work order status in the Status field, such as “Awaiting Parts,” “Device 
in Use,” etc. until work is completed and the Status is Closed.

15. The preventive maintenance procedure. HEMS automatically enters this information for sys‐
tem‐generated work orders and on‐demand preventive maintenance work orders. You may 
manually define a procedure for corrective work orders.

Note: You may either click a field or press [TAB] to move from field to field.
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16. For corrective work orders, enter your request in the Request Text field, making sure to be as 
detailed as possible so that the technician can better diagnose and repair any problem. This 
field contains the procedures and tasks for preventive maintenance work orders. You may 
right‐click in this field or press [F2] to add predefined text, which saves time and increases 
consistency. Please see “CHAPTER 3: Adding Values to Fields” on page 49 for more informa‐
tion about predefined text. You may also press [F10] to expand this field.

17. The Action Text field is where action taken is documented. You may use predefined text for 
commonly used text. You may right‐click this field or press [F2] to add predefined text to this 
field. You may also press [F8] to enter your signature (HEMS user ID and date/time stamp) in 
this field. Please see “CHAPTER 3: Adding Values to Fields” on page 49 for more information 
about predefined text. To expand this field, press [F10].

18. If this work order includes equipment, go to the Equipment tab and then either enter the 
control number of the equipment item to add in the Control # field or click the Select Equip‐
ment button (down arrow) to open the Select Equipment window and add one or more 
equipment item(s). Please see “The Select Equipment Window” on page 69 for more infor‐
mation about the Select Equipment window.

19. You may add a labor entry in the Labor tab. Please see “Adding/Editing Labor Entries” on 
page 77 if you need to add a labor entry.

20. You may add a part entry in the Parts tab. Please see “Adding/Editing Part Entries” on 
page 78 if you need to add parts information.

21. You may add attachments such as field reports, photos of damaged equipment, etc. in the 
Attachments tab. Please see “Attachment Tab” on page 65 for more information about the 
Attachments tab.

22. Save your work order by clicking the Save button in the Toolbar. You are also prompted to 
save any unsaved changes if you exit without saving.

Opening from the Equipment Inventory Dashboard
To open a work order using the Equipment Inventory dashboard:

1. Open the Equipment Inventory dashboard by either:

‐ Clicking the Equipment Inventory tab on the right of the HEMS application.

‐ Clicking the Equipment Inventory button in the HEMS Home screen.

‐ Selecting Activities>Equipment Inventory.

‐ Pressing [CTRL]+[I].

2. Search for the equipment for which you want to open the work order and select that equip‐
ment item in the Search Results Area. Please see “Search Area (Find Mode)” on page 18 for 
more information about searching for equipment using the Equipment Inventory dashboard.

3. In the Action Area, check the radio button that corresponds to the type of work order you are 
creating for the current equipment item. Please see “Managing Work Orders” on page 56 for 
more information about work order types.

AUTHORED BY ANTHONY HERNANDEZ - (415)786-2081 - anthony94122@outlook.com
74 January 2010 - Revision 1.0



HEMS Enterprise 5.x User & Administrator Guide
4. Click the Create WO button to open the Work Order window with the current equipment 
item and type information already filled in. Please see “The Work Order Window” on page 60 
for more information about the Work Order window.

5. Complete Steps 3‐22 of the procedure outlined in “Creating from the Work Orders Dash‐
board” on page 72, above, being sure to verify the equipment information in Step 18.

Copying Work Orders
Opening a new work by copying and editing an existing work order can save time and improve 
information accuracy. HEMS allows you to copy work orders from either the Work Orders dash‐
board or the Equipment Inventory dashboard.

Copying from the Work Orders Dashboard
To copy a work order using the Work Orders dashboard:

1. Open the Work Orders dashboard by either:

‐ Clicking the Work Orders tab on the right of the HEMS application.

‐ Clicking the Work Orders button in the HEMS Home screen.

‐ Selecting Activities>Work Orders.

‐ Pressing [CTRL]+[W].

2. Search for and select the work order you want to copy.

3. Click the Copy button in the Action Area to open the Work Order window with the values 
from the copied work order already filled in.

4. Edit the work order as appropriate.

5. Save your work order by clicking the Save button in the Toolbar. You are also prompted to 
save any unsaved changes if you exit without saving.

Copying from the Equipment Inventory Dashboard
To copy a work order using the Equipment Inventory dashboard:

1. Open the Equipment Inventory dashboard by either:

‐ Clicking the Equipment Inventory tab on the right of the HEMS application.

‐ Clicking the Equipment Inventory button in the HEMS Home screen.

‐ Selecting Activities>Equipment Inventory.

‐ Pressing [CTRL]+[I].

2. Search for the equipment for which you want to copy the work order and then select that 
equipment item in the Search Results Area. Please see “Search Area (Find Mode)” on page 18 
for more information about searching for equipment using the Equipment Inventory dash‐
board.
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3. Click the H button in the Action Area to open the Equipment History window, which displays 
all of the work orders for the current equipment item. Please see “The Equipment History 
Window” on page 103 for more information about the Equipment History window.

4. Select the work order you want to copy and then click the Copy WO button to open the Work 
Order window for the selected work order with the values from the copied work order 
already filled in.

5. Edit the work order as appropriate.

6. Save your work order by clicking the Save button in the Toolbar. You are also prompted to 
save any unsaved changes if you exit without saving.

Updating/Editing a Work Order
HEMS allows you to edit or update work orders from either the Work Orders dashboard or the 
Equipment Inventory dashboard. You will typically do this when adding parts and/or labor 
entries to a work order, but you can edit or update a work order for any reason.

Updating from the Work Orders Dashboard
To edit or update an unscheduled work order using the Work Orders dashboard:

1. Open the Work Orders dashboard by either:

‐ Clicking the Work Orders tab on the right of the HEMS application.

‐ Clicking the Work Orders button in the HEMS Home screen.

‐ Selecting Activities>Work Orders.

‐ Pressing [CTRL]+[W].

2. Search for and select the work order you want to edit or update.

3. Highlight the selected work order in the Search Results Area and then click the Edit button. 
This opens the Work Order window for the current work order. Please see “The Work Order 
Window” on page 60 for more information about the Work Order window.

4. Update the work order as described in “Creating from the Work Orders Dashboard” on 
page 72.

Note: You can quickly edit multiple work orders at once using the Quick Work 
Orders window, such as adding the same labor or action entries. Please see 
“The Quick Work Orders Window” on page 66 for more information about the 
Quick Work Orders window.
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Updating from the Equipment Inventory Dashboard
To edit or update a work order using the Equipment Inventory dashboard:

1. Open the Equipment Inventory dashboard by either:

‐ Clicking the Equipment Inventory tab on the right of the HEMS application.

‐ Clicking the Equipment Inventory button in the HEMS Home screen.

‐ Selecting Activities>Equipment Inventory.

‐ Pressing [CTRL]+[I].

2. Select the equipment item for which you want to update the work order, and then click the H 
button to open the Equipment History window for that equipment item.

3. Select the work order you want to update, and then click the Edit button. This opens the 
Work Order window for the current work order. Please see “The Work Order Window” on 
page 60 for more information about the Work Order window.

4. Update the work order as described in “Opening from the Equipment Inventory Dashboard” 
on page 74.

General
After opening the work order as described above:

1. Enter all of the updated information for the work order you are editing in the appropriate 
fields. Please see “The Work Order Window” on page 60 for information about the work 
order fields.

2. Add any labor or part entries as described in “Adding/Editing Labor Entries” on page 77 and 
“Adding/Editing Part Entries” on page 78, respectively.

3. Either click the Save button in the Toolbar or press [CTRL]+[S] to save the edited work order.

Adding/Editing Labor Entries
The Labor tab of the Work Order window allows technicians to record labor performed on the 
current work order. To add a labor entry to a work order:

1. Open the Work Order window for the work order you want to update, as described above, 
and then go to the Labor tab.

2. You may either:

‐ Click the New button to add a new labor entry to the current work order.

‐ Select an existing labor entry and modify it by entering updated values in the fields. The 
fields automatically fill with the information from the selected labor entry.

‐ Select an existing labor entry and click the Delete button to remove it from the current 
work order.

3. Enter the information for the current labor entry in the appropriate fields. See “Labor Tab” 
on page 62 for more information about the Labor tab fields.
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4. Enter the action(s) taken during this time in the Action Text field, making sure to be as 
detailed as possible. You may right‐click in this field or press [F2] to add predefined text, 
which saves time and increases consistency. You may also add your signature (HEMS user ID 
and date/time stamp) by pressing [F8]. Please see “CHAPTER 3: Adding Values to Fields” on 
page 49 for more information about predefined text. To expand this field, press [F10].

5. Repeat Steps 2‐4 if you are entering multiple labor entries.

6. Either click the Save button in the Toolbar or press [CTRL]+[S] to save the edited work order.

Adding/Editing Part Entries
The Parts tab of the Work Order window allows technicians to record parts used while respond‐
ing to the current work order. To add a part entry to a work order:

1. Open the Work Order window for the work order you want to update, as described above, 
and then go to the Parts tab.

2. You may either:

‐ Click the New button to add a new part entry to the current work order.

‐ Select an existing part entry and modify it by entering updated values in the fields. The 
fields automatically fill with the information from the selected part entry.

‐ Select an existing part entry and click the Delete button to remove it from the current 
work order.

3. Enter the information for the current part entry in the appropriate fields. See “Parts Tab” on 
page 64 for more information about the Part tab fields.

4. Repeat Step 2‐3 for each part you used.

5. Either click the Save button in the Toolbar or press [CTRL]+[S] to save the edited work order.

Closing Work Orders
HEMS allows you to close work orders from either the Work Orders dashboard, the Equipment 
Inventory dashboard, or the Quick Work Orders window.

Closing from the Work Orders Dashboard
To close a work order from the Work Orders dashboard:

1. Open the Work Orders dashboard by either:

‐ Clicking the Work Orders tab on the right of the HEMS application.

‐ Clicking the Work Orders button in the HEMS Home screen.

‐ Selecting Activities>Work Orders.

‐ Pressing [CTRL]+[W].

2. Search for and select the work order you want to close.
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3. Highlight the selected work order in the Search Results Area and then click the Close WO but‐
ton to open the Work Order window for the selected work order with the Labor tab selected. 
Please see “Labor Tab” on page 62 for more information about the Labor tab of the Work 
Order window. HEMS automatically updates the Status Date to the most recent Labor Date 
and changes the work order Status to Closed.

4. Update the work order as necessary (such as by adding a labor entry and updating the action 
text).

5. Save your changes by clicking the Save button in the Toolbar.

Closing from the Equipment Inventory Dashboard
To close a work order using the Equipment Inventory dashboard:

1. Open the Equipment Inventory dashboard by either:

‐ Clicking the Equipment Inventory tab on the right of the HEMS application.

‐ Clicking the Equipment Inventory button in the HEMS Home screen.

‐ Selecting Activities>Equipment Inventory.

‐ Pressing [CTRL]+[I].

2. Search for the equipment for which you want to close the work order and then select that 
equipment item in the Search Results Area. Please see “Search Area (Find Mode)” on page 18 
for more information about searching for equipment using the Equipment Inventory dash‐
board.

3. Click the H button in the Action Area to open the Equipment History window, which displays 
all of the work orders for the current equipment item. Please see “The Equipment History 
Window” on page 103 for more information about the Equipment History window.

4. Select the work order you want to close and then click the Close WO button to open the 
Work Order window for the selected work order with the Labor tab selected. Please see 
“Labor Tab” on page 62 for more information about the Labor tab of the Work Order win‐
dow. HEMS automatically updates the Status Date to the most recent Labor Date and 
changes the work order Status to Closed.

5. Update the work order as necessary (such as by adding a labor entry and updating the action 
text).

6. Save your changes by clicking the Save button in the Toolbar.

Closing from the Quick Work Orders Window
The Quick Work Orders window allows you to close multiple work orders at once that have the 
same action and labor by selecting the work order(s) to close and then setting the Status field to 
Closed. Please see “The Quick Work Orders Window” on page 66 for information about using the 
Quick Work Orders window.
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Deleting a Work Order
HEMS allows you to delete work orders from either the Work Orders dashboard or the Equip‐
ment Inventory dashboard.

Deleting from the Work Orders Dashboard
To delete a work order from the Work Orders dashboard:

1. Open the Work Orders dashboard by either:

‐ Clicking the Work Orders tab on the right of the HEMS application.

‐ Clicking the Work Orders button in the HEMS Home screen.

‐ Selecting Activities>Work Orders.

‐ Pressing [CTRL]+[W].

2. Locate the work order you want to delete and select it in the Search Results Area.

3. Click the Delete button in the Action Area.

Deleting from the Equipment Inventory Dashboard
To delete a work order using the Equipment Inventory dashboard:

1. Open the Equipment Inventory dashboard by either:

‐ Clicking the Equipment Inventory tab on the right of the HEMS application.

‐ Clicking the Equipment Inventory button in the HEMS Home screen.

‐ Selecting Activities>Equipment Inventory.

‐ Pressing [CTRL]+[I].

2. Search for the equipment for which you want to delete the work order and then select that 
equipment item in the Search Results Area. Please see “Search Area (Find Mode)” on page 18 
for more information about searching for equipment using the Equipment Inventory dash‐
board.

3. Click the H button in the Action Area to open the Equipment History window, which displays 
all of the work orders for the current equipment item. Please see “The Equipment History 
Window” on page 103 for more information about the Equipment History window.

4. Select the work order you want to delete and then click the Delete button.
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Generating Scheduled Work Orders
The Generate Scheduled Work Orders window allows you to generate your scheduled work 
orders. You should generally do this at regular intervals such as at the beginning of the month.

To generate scheduled work orders:

1. Open the Generate Scheduled Work Orders 
window by either selecting Activities>Gener‐
ate Scheduled Work Orders or by clicking the 
Generate Scheduled WO button in the HEMS 
Home screen.

2. Set the period for which you want to generate 
scheduled work orders by either:

‐ Entering the number of weeks from the 
current date in the Weeks to Run field, or

‐ Entering the end date through which to 
generate scheduled work orders in the 
Date Through field. This generates all scheduled work orders through the specified date.

3. Click the Sort Order button to open the Select Sort 
Order window, which allows you to specify how to 
sort the generated work orders. You can sort by one or 
more of the following:

‐ Assigned Engineer: Engineer assigned to the work 
order or equipment.

‐ Control Number: Equipment control number.

‐ Department Name: Name of the department that 
owns the scheduled equipment.

‐ Issue Date: Date the work order was issued. For 
scheduled work orders, the issue date is based on your schedules.

‐ Location: Where the equipment is located.

‐ Priority: Work order priority.

Note: When multiple users are using the Generate Scheduled Work Orders win‐
dow at once, the first user to begin scheduling work orders may proceed or can‐
cel. Other users receive a prompt that someone else is generating work orders. 
If the first user decides to cancel, the next user can then generate scheduled 
work orders.

Note: The Date Through field automatically fills in when you enter a number in 
the Weeks to Run field.
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‐ Procedure Name: Name of the maintenance procedure.

‐ Specialty: Maintenance technician specialty or trade (such as BMET or Carpenter).

4. Select one or more values by which to sort the scheduled work orders as follows:

‐ Clicking the > button moves the selected sort type into the Selected Sort Orders list.

‐ Clicking the >> button moves all of the sort types into the Selected Sort Orders list.

‐ Clicking the < button removes the selected sort type back to the Available Sort Orders 
list.

‐ Clicking the << button removes all of the sort types back to the Available Sort Orders list.

5. Rearrange the selected sort orders using the up and down arrows to specify the order in 
which HEMS will sort the generated work orders. For example, if you are sorting by Depart‐
ment Name and then Control Number, your results will be sorted by department (such as 
Dermatology, Internal Medicine, and Pediatrics) and then by control number.

6. Click OK to close the Select Sort Order window and return to the Generate Scheduled Work 
Orders window with your selected sort order listed in the Schedule Sorted By list.

7. Click the Preview button to open a separate browser window with a summary of the sched‐
uled work orders that will be generated. This allows you to review your scheduled work 
orders and make any needed changes before generating the work orders.

8. Click the Generate button to generate the scheduled work orders. These work orders appear 
in a separate browser window. You may print these work orders by clicking the Print button 
in the browser window.

9. Click the Exit button to close the Generate Scheduled Work Orders window.

Assigning Work Orders
The Assign Work Orders window allows you to assign or reassign multiple work orders to a main‐
tenance technician at once. You can open the Assign Work Orders window by either selecting 
Activities>Assign Work Orders or by clicking the Assign Work Orders button in the HEMS Home 
screen.

Please see “The Assign Work Orders Window” on page 68 for more information about assigning 
work orders.

Note: You may print and/or export scheduled work orders at any time by using 
the Work Orders dashboard. Search for work orders with the Scheduled type 
(WO Type=Scheduled), Pending status, (Pending checkbox checked) and an 
Issue Date within your desired date range (Issue Date=is Between). Click the 
Technician’s Copy (Actual) ‐ All button to run the report from which to print or 
export. Please see “CHAPTER 12: Printing & Exporting Data” on page 233 for 
more information about printing and exporting data in HEMS.
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Updating/Closing Multiple Work Orders
You can quickly update and/or close multiple work orders at once using the Quick Work Orders 
window (such as adding the same labor and action entries). Please see “The Quick Work Orders 
Window” on page 66 for more information about the Quick Work Orders window.

Configuring Work Order Defaults
You can save time when opening work orders from the Work Orders dashboard by configuring 
work order default values and department/location preferences. To configure work order 
defaults, select Utilities>User Configuration to open the User Configuration window, and then 
go to the Work Order Defaults tab.

Please see “Work Order Defaults” on page 247 for more information about customizing work 
order defaults.

AUTHORED BY ANTHONY HERNANDEZ - (415)786-2081 - anthony94122@outlook.com
83Copyright 2010, EQ2, Inc. All rights reserved.



CHAPTER 4: Work Orders
This page intentionally left blank.

AUTHORED BY ANTHONY HERNANDEZ - (415)786-2081 - anthony94122@outlook.com
84 January 2010 - Revision 1.0



HEMS Enterprise 5.x User & Administrator Guide
CHAPTER 5:
Managing Equipment

AUTHORED BY ANTHONY HERNANDEZ - (415)786-2081 - anthony94122@outlook.com
85Copyright 2010, EQ2, Inc. All rights reserved.



CHAPTER 5: Managing Equipment
Managing Equipment
Managing equipment is the core HEMS function. This section describes control numbers, how 
HEMS classifies equipment for easy management, and the ways in which you can schedule pre‐
ventive maintenance.

Control Numbers
Control numbers are unique numbers assigned to individual pieces of equipment. The numbers 
may be alphanumeric and up to twelve characters in length. You should use a consistent num‐
bering system to make tracking and managing equipment faster and easier. Some ideas include:

• A purely numerical system, such as 0001 through x.

• An alphanumeric system with a prefix indicating the type of equipment, such as AHU01 to 
indicate an air handling unit in a facility with fewer than 100 air handling units.

• An alphanumeric system that incorporates location as well as equipment type, such as 
AHU01‐2, to indicate an air handling unit on the second floor.

These are just a few examples of the many options available to you. Create and implement the 
equipment numbering policy that best suits your needs.

How HEMS Classifies Equipment
HEMS uses the following categories to classify equipment to manage, schedule, and/or report 
on:

• System: Equipment systems offer a larger group that equipment items can belong to, such as 
HVAC, Water System, or Electrical System, if applicable. HEMS does not schedule by system.

• Class: Equipment classes identify equipment such as Life Support, Diagnostic, Non‐patient 
Care, Laboratory Equipment, Electrical, Patient Support, or Cooling. HEMS odes not schedule 
by class.

• Type: Equipment types identify and group like pieces of equipment, such as defibrillators 
that are not all necessarily of the same make and model. EQ2 can provide a standard list of 
equipment types that includes life expectancy, equipment class, system, ECRI number, and 
ECRI name information. EQ2 can also provide standard schedule information that includes 
standard maintenance procedures and maintenance schedule interval and risk related to 
equipment types. Please contact EQ2 for more information.

Note: Consistency is the single most important factor when entering informa‐
tion for easy retrieval and management. Be sure to address potential issues 
such as “O” versus “0”, “l” versus “I” versus “1”, etc. as interchanging these val‐
ues can cause problems when running reports and searches.
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• Model: Equipment models identify specific models within a type. This makes it easy to sched‐
ule maintenance, purchase parts in volume, respond to recalls and alerts, compare the reli‐
ability of an individual item against other identical items in your inventory, and salvage parts 
when an item is taken out of service.

• Equipment: Equipment is made up of a relationship of type and manufacturer/model. HEMS 
maintains a dedicated record of every piece of equipment in your inventory. This record 
includes particulars about the equipment item (such as serial number, cost, etc.), the mainte‐
nance and service contract histories, and where the item is used or stored.

• Group: Equipment groups allow you to schedule preventive maintenance on groups of equip‐
ment where scheduling by type or model is difficult. For example, you may have hundreds of 
fire extinguishers and may decide to create a number of manageably‐sized groups for sched‐
uling purposes. Individual preventive maintenance work orders will be created for each 
equipment item within the group.
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HEMS Equipment Windows
HEMS includes the following equipment windows:

• Equipment Inventory dashboard: The Equipment Inventory dashboard allows you to find, 
view, edit, add, remove, and view equipment items and item history. Please see “The Equip‐
ment Inventory Dashboard” on page 22 for more information about the Equipment Inven‐
tory dashboard.

• Equipment Inventory window: The Equipment Inventory window is where you add or edit 
information for a single equipment item record. Please see “The Equipment Inventory Win‐
dow” on page 89 for more information about the Equipment Inventory window.

• Equipment History window: The Equipment History window lets you view and update work 
order information for the selected equipment item. Please see “The Equipment History Win‐
dow” on page 103 for more information about the Equipment History window

• Equipment Contract History window: The Equipment Contract History window lets you view 
and update contract information for the selected equipment item. Please see “The Equip‐
ment Contract History Window” on page 104 for more information about the Equipment 
Contract History window.

• Quick Equipment Activities window: The Quick Equipment Activities window allows techni‐
cians to edit multiple equipment items at once. Please see “The Quick Equipment Activities 
Window” on page 101 for more information about the Quick Equipment Activities window.

• Equipment Management window: The Equipment Management window allows managers 
to edit multiple equipment items at once, such as updating scheduling information. Please 
see “Equipment Management” on page 260 for more information about the Equipment 
Management window.

AUTHORED BY ANTHONY HERNANDEZ - (415)786-2081 - anthony94122@outlook.com
88 January 2010 - Revision 1.0



HEMS Enterprise 5.x User & Administrator Guide
The Equipment Inventory Dashboard
The Equipment Inventory dashboard allows you to search for and update equipment records. 
You can also view equipment history and contract history, and can also open work orders for 
equipment items.

Please see “The Equipment Inventory Dashboard” on page 22 for more information about the 
Equipment Inventory dashboard layout.

The Equipment Inventory Window
The Equipment Inventory window allows you to add or edit information for a single equipment 
item record. This window consists of the following tabs:

• Main: The Main tab contains detailed information about the current equipment item.

• Schedule: The Schedule tab displays the preventive maintenance schedule for the current 
equipment item. Please see “Scheduling Equipment” on page 107 for more information 
about scheduling equipment.

• Other Details: The Other Details tab displays risk information as well as the incoming inspec‐
tion and retirement procedure. Please see “CHAPTER 8: Managing Risk” on page 179 for 
more information about managing risk in HEMS.

• Parts: The Parts tab displays parts defined for the equipment model plus any additional parts 
for the current equipment item. Please see “CHAPTER 7: Managing Parts” on page 169 for 
more information about managing parts in HEMS.
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• Attachments: The Attachments tab allows you to scan and/or attach documents and/or 
images to the current equipment item. If you have added attachments to the item’s model or 
type, those attachments will be visible here as well.

Main Tab
The Main tab of the Equipment 
Inventory window contains the fol‐
lowing information about the cur‐
rent equipment item:

• Control #: Unique number 
assigned to the equipment 
item. Clicking the Control # link 
opens a window that displays 
the equipment history (work 
orders opened for the equip‐
ment item). Please see “Control 
Numbers” on page 86 for more 
information about control num‐
bers.

• Serial #: Unique number 
assigned to the equipment item 
by the manufacturer.

• Model #: Equipment model number. Equipment models group multiple identical equipment 
items. This field uses values from the Equipment Models Information List. Please see “Equip‐
ment Models List” on page 131 for more information about the Equipment Models Informa‐
tion List. HEMS links types, manufacturers, and models.

• Manf: Equipment manufacturer. This field uses values from the Vendors Information List. 
Please see “Vendors List” on page 153 for more information about the Vendors Information 
List. HEMS links types, manufacturers, and models.

• Type: Equipment type. Equipment types identify and group like pieces of equipment, such as 
defibrillators that are not all necessarily of the same make and model. This field uses values 
from the Equipment Types Information List. Please see “Equipment Types List” on page 134 
for more information about the Equipment Types Information List. HEMS links types, manu‐
facturers, and models.

• Class: Equipment class. Equipment classes identify equipment such as Life Support, Diagnos‐
tic, Non‐patient Care, Laboratory Equipment, Electrical, Patient Support, or Cooling. This field 
uses values from the Equipment Classes Information List. Please see “Equipment Classes 
List” on page 139 for more information about the Equipment Classes Information List.

• System: Equipment system. Equipment systems offer a larger group that equipment items 
can belong to, such as HVAC, Water System, or Electrical System, if applicable. This field uses 
values from the Equipment Systems Information List. Please see “Equipment Systems List” 
on page 139 for more information about the Equipment Systems Information List.

AUTHORED BY ANTHONY HERNANDEZ - (415)786-2081 - anthony94122@outlook.com
90 January 2010 - Revision 1.0



HEMS Enterprise 5.x User & Administrator Guide
• Device Inclusion: Device inclusion category for the equipment item. Device inclusions allow 
you to classify equipment for identification purposes such as, “Utility Management,” “Fire 
Safety,” etc. This field uses values from the Device Inclusions Information List. Please see 
“Device Inclusions List” on page 126 for more information about the Device Inclusions Infor‐
mation List.

• Life Expectancy: Life expectancy of the equipment item, in years.

• Supplier: Vendor who supplies the equipment item. This field uses values from the Vendors 
Information List. Please see “Vendors List” on page 153 for more information about the Ven‐
dors Information List.

• Revision: The software/firmware version that is running on the equipment. You may use this 
as a custom field if revision is not applicable.

• Department: Department that owns the equipment item. This field uses values from the 
Departments Information List. Please see “Departments List” on page 124 for more informa‐
tion about the Departments Information List.

• Location: Physical location of the equipment item. This field uses values from the Locations 
Information List. Please see “Locations List” on page 140 for more information about the 
Locations Information List.

• Active: When checked, indicates that the equipment item is active.

• UPS: When checked, indicates that the equipment item is connected to an Uninterruptible 
Power Supply.

• Emergency Power: When checked, indicates that the equipment item is connected to an 
emergency power source (such as a generator).

• Service Manual: When checked, indicates that there is a service manual available for the 
equipment item. This is defined by equipment model.

• Operator Manual: When checked, indicates that the there is an operator manual available 
for the equipment item. This is defined by equipment model.

• Alarm: When checked, indicates that the equipment item has a failure alarm. This is defined 
by equipment model.

• Warranty Exp Date: Date the warranty for the equipment item expires.

• Service Exp Date: Date the service contract for the equipment item expires. If configured, 
this field will automatically update from the contract end date. Please see “CHAPTER 9: Man‐
aging Contracts” on page 183 for information about managing service contracts in HEMS.

• Purchase Date: Date the equipment item was purchased.

• Purchase Price: How much the equipment item cost to purchase.

• PO: Purchase order that covered the purchase of the equipment item. This field uses values 
from the Purchase Orders Information List. Please see “Purchase Orders List” on page 150 for 
more information about the Purchase Orders Information List.

• Retire Date: Date the equipment item was retired from service.

AUTHORED BY ANTHONY HERNANDEZ - (415)786-2081 - anthony94122@outlook.com
91Copyright 2010, EQ2, Inc. All rights reserved.



CHAPTER 5: Managing Equipment
• Last Maintenance: Date the equipment item was last maintained.

• Storage Date: Date the equipment item was placed into storage.

• Storage Location: Location where the equipment item is stored.

• ECRI#: ECRI's Universal Medical Device Nomenclature System™ (UMDNS™) number. This field 
uses values from the Equipment Models Information Lists. Please see “Equipment Models 
List” on page 131 for more information about the Equipment Models Information List.

• ECRI Name: ECRI name from ECRI's Universal Medical Device Nomenclature System 
(UMDNS). This field uses values from the Equipment Models Information Lists. Please see 
“Equipment Models List” on page 131 for more information about the Equipment Models 
Information List.

• Ownership: Entity that owns the equipment item.

• Placed in Service Date: Date the equipment item was placed into service.

• Equipment Text: Additional information about the equipment item.

• Work Order Notes: Text to display in the Request Text field of work orders for the equipment 
item.

Note: Entering the ECRI # and type from ECRI's Universal Medical Device 
Nomenclature System (UMDNS) in the ECRI # and ECRI Name fields allows you 
to efficiently open and respond to work orders for device recall and alerts. 
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Schedule Tab

The Schedule tab of the Equipment 
Inventory window displays sched‐
ule information for the current 
equipment item. Please see “Sched‐
uling Equipment” on page 107 for 
more information about scheduling 
equipment.

The Schedule tab contains the fol‐
lowing information:

• Schedule by Date: The Sched‐
ule by Date checkbox indicates 
where the schedule date is 
defined and displays the sched‐
ule date. You may use schedule 
dates defined by EQ Type, 
Manf/Model, Department, 
Location, and Equipment.

• Schedule Template: The Schedule Template displays where the preventive maintenance 
template is defined, including the procedure, interval, and assigned engineer. If necessary, 
you may manually define a schedule template for the equipment item by checking the 
Schedule Template checkbox.

• PM Procedure: Displays the preventive maintenance procedure. If necessary, you may define 
a different preventive maintenance procedure for the equipment item. Procedures are drawn 
from the Procedures Information List. Please see “Procedures List” on page 146 for more 
information about the Procedures Information List.

• Assigned Engineer: Displays the assigned engineer based on the schedule template.

• Priority: The Priority field displays the priority for the equipment item based on risk if you 
have risk defined. If you have minimum frequency for scheduling based on risk configured, 
the maintenance interval may vary depending on the risk factor; review risk‐related mainte‐
nance intervals using the Risk Interval report, which is described in “Risk Interval” on 
page 216. You may also define the priority manually if you are not using risk. Please see 
“Other Details Tab” on page 94 for information about the Other Details tab of the Equipment 
Inventory window.

Note: The Schedule tab displays schedule information, including how an equip‐
ment item is scheduled. Define your preventive maintenance template by equip‐
ment item when scheduling by type or model does not fit your needs. 
Scheduling by type or model takes full advantage of HEMS automatic schedul‐
ing functions and ensures that all of the items of a particular type or model are 
consistently maintained according to the same schedule template and fre‐
quency.

AUTHORED BY ANTHONY HERNANDEZ - (415)786-2081 - anthony94122@outlook.com
93Copyright 2010, EQ2, Inc. All rights reserved.



CHAPTER 5: Managing Equipment
• Schedule Frequency: The Schedule Frequency Area of the Schedule tab indicates schedule 
interval(s) for the equipment item.

‐ Clicking the New button opens the Schedule Frequency window, which allows you to 
define an interval for the equipment item. Please see “The Schedule Frequency Window” 
on page 97 for more information about the Schedule Frequency window.

‐ Double‐clicking an existing schedule frequency opens the Schedule Frequency window 
for the selected frequency and allows you to make edits.

‐ Clicking the Delete button deletes the selected schedule frequency.

• Schedule Date for Multi Year: The seed date for multi year‐scheduling based on the equip‐
ment item’s Placed in Service Date or Purchase Date. For example, you may need to replace 
batteries every two years based on the date the equipment was purchased.

• Groups: Displays the group(s) that the equipment item belongs to, if any. To add or remove 
groups, click the button to open the Select groups window. Please see “The Select Groups 
Window” on page 99 for more information about the Select groups window.

Other Details Tab
The Other Details tab of the Equipment Inventory window displays where the risk information is 
defined as well as the incoming inspection and retirement procedures. Please see “Service Area 
Configuration” on page 263 for more information about setting up the default Incoming Inspec‐
tion and Retirement Procedures for the current Service Area. You may define the risk and/or 
procedures for the current equipment item, if required.

This tab contains the following 
information:

• Risk Assessment: Checking the 
Risk Assessment checkbox 
allows you to assign risk to the 
equipment item when the 
item’s risk is different from the 
risk defined for the equipment 
type or model. Please see 
“CHAPTER 8: Managing Risk” on 
page 179 for more information 
about managing risk in HEMS.

Note: In general, both the risk and incoming inspection/retirement procedures 
are defined by equipment type or model, and not by individual equipment item. 
For consistency and convenience, defining these items for an individual equip‐
ment item should be the exception and not the norm.
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• Risk Statement Groups: If you are assigning risk by equipment item, use the pull‐down menu 
to answer each of the five following statements. HEMS calculates the risk factor, which deter‐
mines the priority.

‐ Equipment Function: What the equipment item is used for.

‐ Clinical Application: How the equipment item impacts clinical functions.

‐ PM Requirement: How often preventive maintenance needs to be performed.

‐ Likelihood of Failure: How likely the equipment item is to fail. This is a measure of equip‐
ment reliability.

‐ Environment of Use: Where the equipment is used.

• Risk Factor: HEMS displays the calculated risk factor in the Risk Factor field. HEMS calculates 
the risk factor, which determines the priority. Please see “CHAPTER 8: Managing Risk” on 
page 179 for information about managing risk in HEMS.

• Incoming Inspection: Checking the Incoming Inspection checkbox allows you to manually 
define the incoming inspection procedure for the equipment item, if necessary. You may also 
define a default incoming inspection by Service Area. Please see “General Service Area 
Options” on page 263 for more information about defining a default incoming inspection 
procedure. The current incoming procedure source (such as type, model, etc.) is also dis‐
played here.

• Retirement Procedure: Checking the Retirement Procedure checkbox allows you to manu‐
ally define the retirement procedures for the equipment item, if necessary. You may also 
define a default retirement procedure by Service Area. Please see “General Service Area 
Options” on page 263 for more information about defining a default retirement procedure. 
The current retirement procedure source (such as type, model, etc.) is also displayed here.

Note: In general, both the Incoming Inspection and Retirement Procedure are 
defined by equipment type or model. Defining these procedures by equipment 
item should be the exception. You may also define a default Incoming Inspection 
and Retirement Procedure by Service Area.
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Parts Tab
The Parts tab of the Equipment 
Inventory window lists all of the 
parts defined by the equipment 
model. You may define additional 
parts for the current equipment 
item, if needed.

To add, edit, or remove the parts 
associated with the equipment 
item, click the Update Part Infor‐
mation button to open the Select 
Parts window. Please see “The 
Select Parts Window” on page 98 
for more information about the 
Select Parts window.

Attachments Tab
The Equipment Inventory window 
includes an Attachments tab that 
allows you to attach documents 
and/or images related to the cur‐
rent equipment item.

• To add an attachment, select 
Attach to open a standard Win‐
dows dialog that allows you to 
select the file name, type, and 
location to attach. HEMS sup‐
ports the DOC, GIF, ICON, JPEG, 
PDF, TXT, XLS, and ZIP formats.

• To scan an image from a local 
scanner, select Scan to open a 
standard Windows dialog that 
allows you to scan and name 
the file. Click OK to scan the file.

• To delete an attached or scanned file, select the item to delete and then click the Delete but‐
ton. You are prompted to confirm your decision.

Note: To attach a file in a format that HEMS does not support, ZIP the file and 
then attach the ZIP file to the desired record.
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The Schedule Frequency Window
The Schedule Frequency window 
allows you to review, add, or edit a 
schedule interval for the current 
equipment item. You may also 
schedule parts for an equipment 
item that have not been scheduled 
by model.

Please see “Scheduling Equipment” 
on page 107 for information about 
scheduling equipment and “Sched‐
ule Tab” on page 93 for more information about the Schedule tab of the Equipment Inventory 
window.

To review, add, or edit a schedule interval or schedule parts for an equipment item that have not 
been scheduled by model:

1. Open the Schedule Frequency window from the Schedule tab of the Equipment Inventory 
window by either:

‐ Clicking the New button in the Schedule Frequency Area to create a new schedule inter‐
val or,

‐ Double‐clicking an existing schedule template in the Schedule Frequency Area to edit an 
existing schedule interval.

2. Select the interval and part, if required, by checking the Select checkbox(es) for the selected 
part(s).

3. Select the correct interval by checking the appropriate Interval radio button.

4. If necessary, adjust the frequency using the Occurs Every pull‐down menu. For example, to 
schedule every 18 months, you would select Monthly and then Occurs Every 18.

5. Enter any additional information for a part in the Notes field for that part and, if necessary, 
check the Conditional checkbox to indicate any unique conditions.

6. Click OK to close the Schedule Frequency window and return to the Schedule tab of the 
Equipment Inventory window.
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The Select Parts Window
The Select Parts window allows you to search for parts and select parts to add to or remove from 
association with the current equipment item or model. This window appears as follows:

To use the Select Parts window:

1. Search for the part(s) you want to associate with the current equipment item or model using 
the Search Area.

2. Select the part(s) to associate in the Search Results Area and then move that information to 
the Selection Area using the following Selection buttons:

‐ Clicking the >> button moves all of the parts in the Search Result Area to the Selection 
Area.

‐ Clicking the > button moves the currently selected part in the Search Result Area to the 
Selection Area.

‐ Clicking the < button removes the currently selected part from the Selection Area back to 
the Search Results Area.

‐ Clicking the << button removes all of the parts in the Selection Area back to the Search 
Results Area.

3. Add the selected part(s) to the Parts tab of the Equipment Inventory window by clicking the 
Apply button.

Note: To remove a part that is currently associated with the current equipment 
item or model, select the part to remove in the Selection Area and then click the 
< button. A warning message appears if you remove a part that is currently 
scheduled for the currently equipment item or model.
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The Report/Print buttons provide quick access to relevant reports. From the left to right, the 
buttons are:

• List Report: Clicking the List Report button opens a summary part inventory report for all of 
the parts in the Selection Area.

• Detail Report ‐ All: Clicking the Detail Report ‐ All button opens a detailed part inventory 
report for all of the parts in the Selection Area.

• Detail Report ‐ Current: Selecting a part in the Selection Area and then clicking the Detail 
Report ‐ Current button opens a report that provides detailed inventory information about 
the currently selected part.

Reports appear in a separate browser window. You can print and/or export these reports, as 
described in “CHAPTER 12: Printing & Exporting Data” on page 233.

The Select Groups Window
The Select Groups window opens when you click the down arrow button in the Schedule tab of 
the Equipment Inventory window. This window allows you to add the current equipment item to 
a group or remove it from a group. You may schedule equipment in more than one group, if 
needed.

The Select groups window appears as follows:

To use the Select groups window:

1. Search for the group(s) you want to update using the Search Area.
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2. Select the group(s) to add in the Search Results Area and then move that information to the 
Selection Area using the following Selection buttons:

‐ Clicking the >> button moves all of the groups in the Search Result Area to the Selection 
Area.

‐ Clicking the > button moves the currently selected group in the Search Result Area to the 
Selection Area.

‐ Clicking the < button removes the currently selected group from the Selection Area back 
to the Search Results Area.

‐ Clicking the << button removes all of the groups in the Selection Area back to the Search 
Results Area.

3. Add the selected equipment item to the group by clicking the Apply button.

4. Right‐click the group name to preview, add, edit or copy the group.

The Report/Print buttons provide quick access to relevant reports. From the left to right, the 
buttons are:

• List Report: Clicking the List Report button opens a summary report for all of the equipment 
items in the Selection Area.

• Detail Report ‐ All: Clicking the Detail Report ‐ All button opens a detailed report for all of 
the equipment items in the Selection Area.

• Detail Report ‐ Current: Selecting an equipment item in the Selection Area and then clicking 
the Detail Report ‐ Current button opens a report that provides detailed information about 
the currently selected equipment item.

Reports appear in a separate browser window. You can print and/or export these reports, as 
described in “CHAPTER 12: Printing & Exporting Data” on page 233.

Note:  Run the Schedule report from the Equipment Inventory dashboard to see 
how your equipment is scheduled.
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The Quick Equipment Activities Window
The Quick Equipment Activities window allows maintenance technicians to quickly update mul‐
tiple equipment items at once, such as adding equipment text, adding work order notes, deacti‐
vating/retiring equipment, or placing equipment in storage. You can open the Quick Equipment 
Activities window by selecting Activities>Quick Equipment Activities.

The Quick Equipment Activities window appears as follows:

To use the Quick Equipment Activities window:

1. Search for the equipment item(s) you want to update using the Search Area.

2. Select the equipment item(s) to update in the Search Results Area and then move that infor‐
mation to the Selection Area using the following Selection buttons:

‐ Clicking the >> button moves all of the equipment item records in the Search Result Area 
to the Selection Area.

‐ Clicking the > button moves the currently selected equipment item record in the Search 
Result Area to the Selection Area.

‐ Clicking the < button removes the currently selected equipment item record from the 
Selection Area back to the Search Results Area.

‐ Clicking the << button removes all of the equipment item records in the Selection Area 
back to the Search Results Area.

Note: The Equipment Management window allows managers to perform all of 
the above actions as well as perform management tasks such as changing 
schedule information, departments, or assigned engineers. Select Utili‐
ties>Management Tools>Equipment Management to open the Equipment 
Management window. Please see “Equipment Management” on page 260 for 
more information about the Equipment Management window.
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3. Update the equipment item(s) by using the Selection pull‐down menu to select the informa‐
tion you want to update and then updating that information in the field(s) that appear. Avail‐
able options are:

‐ Activate: Activate the selected equipment item(s).

‐ Add Equipment Text: Add notes to the Equipment Text field in the selected equipment 
item record(s).

‐ Add Work Order Notes: Add text to the Work Order Notes field. This text will appear in 
the work order Request Text field for work orders created for the selected equipment 
item(s).

‐ Deactivate: Deactivate the selected equipment item(s).

‐ Retire: Retire the selected equipment item(s) and assign an engineer to perform retire‐
ment maintenance on those items. Please see “Service Area Configuration” on page 263 
for more information about default retirement procedures.

‐ Storage In: Date the selected equipment item(s) were moved into storage, and the loca‐
tion they were moved to.

‐ Storage Out: Date the selected equipment item(s) were moved from storage, and the 
location they were moved to.

4. Checking the Add Text at Top checkbox adds text to the top of the Request Text field in work 
orders created for the current equipment item.

5. Either click the Apply button or press [CTRL]+[S] to save your updates to the selected equip‐
ment item record(s).

The Report/Print buttons provide quick access to relevant reports. From the left to right, the 
buttons are:

• List Report: Clicking the List Report button opens a summary report for all of the equipment 
items in the Selection Area.

• Detail Report ‐ All: Clicking the Detail Report ‐ All button opens a detailed report for all of 
the equipment items in the Selection Area.

• Detail Report ‐ Current: Selecting an equipment item in the Selection Area and then clicking 
the Detail Report ‐ Current button opens a report that provides detailed information about 
the currently selected equipment item.

Reports appear in a separate browser window. You can print and/or export these reports, as 
described in “CHAPTER 12: Printing & Exporting Data” on page 233.
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The Equipment History Window
Clicking the H button in the Action 
Area of the Equipment Inventory 
dashboard opens the dynamic 
Equipment History window, which 
allows you to view, edit, copy, close, 
and delete work orders for the cur‐
rent equipment item. You can sort 
columns by clicking the desired col‐
umn header and can also resize col‐
umns by clicking and dragging.

• To view a work order, click it to 
see the selected work order’s 
request and action text in the 
Req Text and Act Text fields, 
respectively. You may expand 
these fields by either double‐clicking or pressing [F10].

• To close a work order, select the work order and then click the Close WO button to open the 
Work Order window for the selected work order. HEMS automatically updates the Status 
Date/Time to the last Labor Date/Time and changes the work order status to Closed. Save 
your changes by either:

‐ Clicking the Save button in the Toolbar, or

‐ Pressing [CTRL]+[S].

Please see “Closing Work Orders” on page 78 for more information about closing work 
orders.

• To edit a work order, either:

‐ Select the work order and then click the Edit button, or

‐ Double‐click the selected work order.

This opens the Work Order window with the current work order information listed. Please 
see “The Work Order Window” on page 60 for information about the Work Order window 
and “Updating/Editing a Work Order” on page 76 for information about editing work orders.

• To copy a work order, select the work order and then click the Copy button to open a new 
work order based on the current work order in the Work Order window. Please see “Copying 
Work Orders” on page 75 for more information about closing work orders.
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Work Order Reports
To run a work order report from the Equipment History window:

1. Select the report type you want to run by checking the appropriate radio button. Your avail‐
able options are:

‐ List Report: Checking the List Report radio button opens a summary report that lists all of 
the work order records in the Equipment History window.

‐ Actual (Technician’s Copy): Checking the Actual (Technician’s Copy) radio buttons opens 
a technician’s copy of the currently selected work order.

‐ Summary: Checking the Summary radio button opens a report that provides summary 
information about the currently selected work order.

‐ Checking the All checkbox runs the reports for all of the listed work orders.

2. Click the Preview button to run the report. Reports appear in a separate browser window. 
You may print reports, as described in “CHAPTER 12: Printing & Exporting Data” on page 233.

The Equipment Contract History Window
Clicking the C button in the Action 
Area of the Equipment Inventory 
dashboard opens the Equipment 
Contract History window, which 
lists the service contract(s) that 
cover the current equipment item. 
Please see “CHAPTER 9: Managing 
Contracts” on page 183 for more 
information about managing con‐
tracts in HEMS.

• To view a contract, click it to see 
the selected contract’s notes 
and equipment coverage in the 
Notes and Equipment Coverage 
fields, respectively.

• To delete a contract, select the contract and then click the Delete button. Review the con‐
tract before deletion, to make sure that no other pieces of equipment are affected.

CAUTION: DELETING A CONTRACT REMOVES THE CONTRACT IN ITS ENTIRETY, 
WHICH MAY IMPACT OTHER EQUIPMENT ITEMS.
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• To edit a contract, either:

‐ Select the contract and then click the Edit button, or

‐ Double‐click the selected contract.

This opens the Contracts window with the currently selected contract listed. Please see “The 
Contracts Window” on page 184 for information about the Contracts window.

• To copy a contract, select the contract and then click the Copy button to open a new contract 
based on the current contract in the Contracts window. Please see “Editing Contracts” on 
page 192 for more information about editing contracts.

Contract History Reports
To run a work order report from the Equipment Contract History window:

1. Select the report type you want to run by checking the appropriate radio button. Your avail‐
able options are:

‐ List Report: Checking the List Report radio button opens a summary report for the cur‐
rently selected contract in the Equipment Contract History window.

‐ Detail: Checking the Detail radio button opens a detailed report for the currently 
selected contract in the Equipment Contract History window.

‐ Checking the All checkbox runs the reports for all of the listed contracts.

2. Click the Preview button to run the report. Reports appear in a separate browser window. 
You may print reports, as described in “CHAPTER 12: Printing & Exporting Data” on page 233.

The Equipment Models Window
The Equipment Models window automatically appears when you 
add a new equipment item into inventory. This window allows 
you to select an existing equipment model, which auto‐fills infor‐
mation for the equipment item you are adding to inventory. If 
needed, you may also add a new equipment model record to the 
Equipment Models Information List.

To use the Equipment Models window:

1. Search for the model you want to select using the Search 
Area.

2. Select the model to add in the Search Results Area and then 
click the Select button.

To add a new equipment model, click the ‐> button in the lower 
right corner to open the Equipment Models Information List. 
Please see “Equipment Models List” on page 131 for more infor‐
mation about the Equipment Models Information List.
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The Report/Print buttons provide quick access to relevant reports. From the left to right, the 
buttons are:

• List Report: Clicking the List Report button opens a summary report for all of the equipment 
models in the Selection Area.

• Detail Report ‐ All: Clicking the Detail Report ‐ All button opens a detailed report for all of 
the equipment models in the Selection Area.

• Detail Report ‐ Current: Selecting an equipment item in the Selection Area and then clicking 
the Detail Report ‐ Current button opens a report that provides detailed information about 
the currently selected equipment model.

Reports appear in a separate browser window. You can print and/or export these reports, as 
described in “CHAPTER 12: Printing & Exporting Data” on page 233.
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Scheduling Equipment
The ability to schedule equipment maintenance is a core HEMS feature. When scheduling equip‐
ment, you must define the following:

• The preventive maintenance template.

• The schedule date.

Defining Preventive Maintenance Templates
HEMS allows you to define preventive maintenance templates in several ways. Most templates 
(procedures and intervals) are defined by equipment type, model, or (less commonly) individual 
equipment item or group. You may define your template by equipment type but have particular 
models that require additional tasks or parts. You should define the preventive maintenance 
template by model for those particular models. There may also be rare cases when an equip‐
ment item requires even more specific tasks and/or parts.

If you have defined multiple possible templates for a given equipment item, HEMS will prioritize 
the preventive maintenance for that item as follows (in order of increasing precedence):

• By Equipment Type: Defining a preventive maintenance template by equipment type is the 
most efficient when you have many like equipment items.

• By Equipment Model: Define the preventive maintenance template by model when you have 
particular models that require additional tasks than other items of the same type and/or 
have model‐specific parts.

• By Equipment Item(s): Define the preventive maintenance template by equipment item 
when you have particular items that require additional tasks and/or parts than other items of 
the same model or type.

Defining Preventive Maintenance Templates by Equipment Type
Preventive maintenance templates 
are normally defined by equipment 
type using the Equipment Types 
Information List. All equipment 
inherits the preventive mainte‐
nance template for its assigned 
type.
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To define a preventive maintenance template by equipment type:

1. Select Information Lists>Equipment Inventory Lists>Equipment Types to open the Equip‐
ment Types Information List.

2. Search for and select the equipment type for which you want to define a preventive mainte‐
nance template.

3. Go to the Schedule tab.

4. Select the maintenance procedure using the PM Procedure pull‐down menu.

5. Define how often the selected procedure should be performed by adding one or more sched‐
ule intervals in the Schedule Frequency window.

6. Define the Assigned Engineer if all of the equipment items of this type are assigned to a par‐
ticular technician.

7. The Priority is defined by the equipment type’s risk score in the Other Details tab.

8. Either click the Save button in the Toolbar or press [CTRL]+[S].

Defining Preventive Maintenance Templates by Equipment 
Model
You can define preventive mainte‐
nance templates by equipment 
model using the Equipment Mod‐
els Information List. All equipment 
inherits the maintenance schedule 
for its assigned model.

To define a preventive maintenance 
template by equipment model:

1. Select Information Lists>Equip‐
ment Inventory Lists>Equip‐
ment Models to open the 
Equipment Models Informa‐
tion List.

2. Go to the Schedule tab.

3. Search for and select the equipment model for which you want to define a preventive main‐
tenance template. If a preventive maintenance template is already defined for the equip‐
ment type, this will be indicated. To proceed with defining the template by model, check the 
Schedule Template checkbox.

4. Select the maintenance procedure using the PM Procedure pull‐down menu.

5. Define how often the selected procedure should be performed by adding one or more sched‐
ule intervals in the Schedule Frequency window.
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6. Define the Assigned Engineer if all of the equipment items of an equipment model are 
assigned to a particular technician.

7. If necessary, schedule parts as described below.

8. Either click the Save button in the Toolbar or press [CTRL]+[S].

Scheduling Parts
Equipment items inherit part schedule information 
defined by the equipment model. To schedule parts for 
an equipment model:

1. In the Equipment Models Information List, go to the 
Parts tab.

2. Assign a part to the model by clicking the Update 
Part Information button to open the Select Parts 
window.

3. Select the part(s) to add as described in “The Select Parts Window” on page 98.

4. Go to the Schedule tab to schedule the selected 
part(s).

5. Either click the New button or double‐click an exist‐
ing frequency to open the Schedule Frequency win‐
dow.

6. Schedule the part by clicking the part’s checkbox and 
then entering the required quantity.

7. Add any notes that apply for replacing this part dur‐
ing preventive maintenance, and check the Conditional checkbox if this part is to be replaced 
based on a condition.

Defining Preventive Maintenance Templates by Equipment Item
If necessary, you may easily define a preventive maintenance template for an individual equip‐
ment item that requires a different maintenance procedure, additional maintenance interval(s), 
parts, and/or a different assigned technician using the Schedule tab of the Equipment Inventory 
window.

To define a preventive maintenance template for an equipment item:

1. Select the equipment item in the Equipment Inventory dashboard, as described in “The 
Equipment Inventory Dashboard” on page 22.

Note: The schedule date for multi‐year part scheduling is defined in the Sched‐
ule tab of the Equipment Inventory window. Please see “Defining the Multi‐
Year Seed Date for Equipment with Parts” on page 110 for more information 
about defining the multi‐year seed date for parts.
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2. Click the Edit button to open the Equipment Inventory window for the selected item.

3. Go to the Schedule tab.

4. Check the PM Template checkbox to define the preventive procedure for equipment, change 
the schedule frequency for the equipment, or change the assigned engineer.

Defining the Multi-Year Seed Date for Equipment with Parts
Parts that require multi‐year scheduling (such as battery replacement) will automatically be 
scheduled on a cycle based on the Seed Date for Multi Year date in the Schedule tab of the 
Equipment Inventory window. By default, this date is selected from either the Placed in Service 
date (if specified) or the equipment Purchase Date. You may manually enter a different date by 
checking the checkbox and entering a date, if needed.

Defining Preventive Maintenance Templates by Equipment 
Group
Equipment items should only be 
scheduled using groups if the 
equipment item has multiple 
schedules with different proce‐
dures.

To define a preventive maintenance 
template by equipment group:

1. Select Information Lists>Equip‐
ment Inventory Lists>Equip‐
ment Groups to open the 
Equipment Groups Information 
List.

2. Search for and select the equip‐
ment group for which you want to define a preventive maintenance template. If a preventive 
maintenance template is already defined for the equipment group, this will be indicated. To 
proceed with defining the template by group, check the Schedule Template checkbox.

3. Check the Schedule checkbox and then go to the Schedule Template tab.

4. Select the maintenance procedure using the PM procedure pull‐down menu.

5. Define the Schedule Frequency by either double‐clicking an entry or clicking the New but‐
ton.

6. Define the Assigned Engineer, if you want to assign by group.

7. Enter the Schedule Date.

8. Define the Priority, if required.

9. Either click the Save button in the Toolbar or press [CTRL]+[S].
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Defining Schedule Dates
HEMS allows you to define the schedule date by department, location, or equipment type, 
model, item, or group. The schedule date is the base date for generating your schedules. For 
example, if you set a department’s schedule date to February 1, then:

• The annual preventive maintenance will be scheduled for February 1.

• The semi‐annual preventive maintenance will be scheduled six months from February 1 
(August 1).

• The quarterly preventive maintenance will be scheduled three months from February 1 (May 
1).

Schedule dates are most commonly defined by department, location, or equipment type. If 
needed, schedule dates may also be defined by equipment model, item, or group.

Defining the Schedule Date by Department
You can define a schedule date for a 
department to meet your require‐
ments.

To define a schedule date by 
department:

1. Select Information 
Lists>Departments to open the 
Departments Information List.

2. Select the department and click 
the Edit button in the Toolbar.

3. Select the schedule date using 
the Start Date field.

4. Either click the Save button in 
the Toolbar or press [CTRL]+[S].

Note: The Schedule by Date field in the Schedule tab of the Equipment Inven‐
tory window indicates how an equipment item is scheduled and the date.
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Defining the Schedule Date by Location
You can define a schedule date for a 
location to meet your require‐
ments.

To define a schedule date by loca‐
tion:

1. Select Information Lists>Loca‐
tions>Locations to open the 
Locations Information List.

2. Select the location and click the 
Edit button in the Toolbar.

3. Select the schedule date using 
the Start Date field.

4. Either click the Save button in 
the Toolbar or press [CTRL]+[S].

Defining the Schedule Date by Equipment Type
You can define a schedule date for an equipment type to 
meet your requirements.

To define a schedule date by equipment type:

1. Select Information Lists>Equipment Inventory 
Lists>Equipment Types to open the Equipment 
Types Information List.

2. Select the type and click the Edit button in the Tool‐
bar.

3. Go to the Schedule tab.

4. Select the schedule date using the Schedule Date field.

5. Either click the Save button in the Toolbar or press [CTRL]+[S].

Defining the Schedule Date by Equipment Model
If required, you can define a schedule date for an equip‐
ment model to meet your requirements.

To define a schedule date by equipment model:

1. Select Information Lists>Equipment Inventory 
Lists>Equipment Models to open the Equipment 
Models Information List.

2. Select the model and click the Edit button in the 
Toolbar.
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4. Select the schedule date using the Schedule Date field.

5. Either click the Save button in the Toolbar or press [CTRL]+[S].

Defining the Schedule Date by Equipment Group
If required, you can define a schedule date for an equip‐
ment group to meet your requirements. 

To define a schedule date by equipment group:

1. Select Information Lists>Equipment Inventory 
Lists>Equipment Groups to open the Equipment 
Groups Information List.

2. Select the group and click the Edit button in the Tool‐
bar.

3. Go to the Schedule tab.

4. Select the schedule date using the Schedule Date field.

5. Either click the Save button in the Toolbar or press [CTRL]+[S].

Defining the Schedule Date by Equipment Item
If required, you can define a schedule date for an equipment item to meet your requirements.

To define a schedule date by equipment item:

1. Locate the equipment item for which you want to update in the Equipment Inventory dash‐
board and then click the Edit button in the Action Area to open the Equipment Inventory 
window for the selected item.

2. Go to the Schedule tab. Please see “Schedule Tab” on page 93.

3. Check the Schedule by Date checkbox.

4. Check the Equipment radio button.

5. Select the schedule date using the Schedule Date fields.

6. Either click the Save button in the Toolbar or press [CTRL]+[S].

Scheduling by Season
You may schedule by season (such as maintaining cooling equipment from April to October) 
using the Seasons Information List. When the season is over, the schedule date automatically 
advances to the next season. Please see “Seasons List” on page 151 for more information about 
the Seasons Information List.

To schedule by season:

1. Select Information>Seasons to open the Seasons Information List.

2. Define your season.
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3. Select Information Lists>Procedures & Tasks>Procedures to open the Procedures Informa‐
tion List.

4. Either select an existing procedure or create a new procedure and then select the season for 
that procedure using the Seasons field.

5. Select a schedule interval.

6. Define your preventive maintenance template by equipment type, model, or item.

7. Open the Schedule tab of the Equipment Inventory window for the desired equipment item 
and then check the Equipment radio button in the Schedule by Date area.

8. Define the base date for which to base your schedules in the Schedule By Date field. This 
date should be the same as the season start date you defined in Step 2.

Scheduling Multiple Equipment Items
You can quickly define or edit how equipment is scheduled (such as by department, type, or loca‐
tion) and assigned engineer using the Equipment Management window. Please see “Equipment 
Management” on page 260 for more information about the Equipment Management window.

To schedule multiple equipment items:

1. Select Utilities>Management Tools>Equipment Management to open the Equipment Man‐
agement window.

2. Search for the desired equipment items.

3. Select the appropriate items.

4. Select the Schedule By Date in the Action Area, select the schedule date to use (such as by 
Department, Equipment, etc.), and then enter a date. Click the Apply button to apply your 
changes.

5. Select an Assigned Engineer in the Action Area, and then click the Apply button.

Defining Frequency for Department or Location
If required, you can define a preventive maintenance frequency for a department or location (to 
ensure that all of the scheduled equipment has at least this frequency) using the Schedule Fre‐
quency field in the Departments or Locations Information Lists. Please see “Departments List” 
on page 124 and “Locations List” on page 140 for more information about the Departments and 
Locations Information Lists, respectively.

Defining a preventive maintenance frequency by department or location will assign the selected 
frequency to all equipment assigned to that department or location. This frequency will override 
any higher frequency assigned for the equipment. For example, if the department frequency is 
quarterly but the equipment preventive maintenance frequency is semi‐annual, the new fre‐
quency for the equipment will be quarterly. If only some of the equipment in a department 
require a different interval, then use the Equipment Inventory dashboard to add the new inter‐
val for these equipment items. Please see “Defining Preventive Maintenance Templates by 
Equipment Item” on page 109 for more information about scheduling by equipment item.
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Generating Scheduled Work Orders
Please see “Generating Scheduled Work Orders” on page 81 for information on generating 
scheduled work orders.

Note: When multiple users are using the Generate Scheduled Work Orders win‐
dow at once, the first user to begin scheduling work orders may proceed or can‐
cel. Other users receive a prompt that someone else is generating work orders. 
If the first user decides to cancel, the next user can then generate scheduled 
work orders.
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Working with Equipment
This section describes how to work with equipment including viewing equipment, adding a new 
equipment item to inventory, editing, deactivating, and retiring equipment. It also includes infor‐
mation on creating work orders from the Equipment Inventory dashboard and viewing the inter‐
active equipment history.

Viewing Equipment
Find and view equipment using the Equipment Inventory dashboard. Please see “The Equipment 
Inventory Dashboard” on page 22 for more information about the Equipment Inventory dash‐
board.

Adding Equipment
HEMS allows you to add a new equipment item to inventory either directly or by copying an 
existing equipment item.

New
To add an equipment item to inventory:

1. Open the Equipment Inventory dashboard by either:

‐ Clicking the Equipment Inventory tab on the right of the HEMS application.

‐ Clicking the Equipment Inventory button in the HEMS Home screen.

‐ Selecting Activities>Equipment Inventory.

‐ Pressing [CTRL]+[I].

2. In the Equipment Inventory dashboard, open the Equipment Inventory window by either:

‐ Clicking the New button in the Action area.

‐ Pressing [ALT]+[N].

By default, the Equipment Inventory window appears with the Main tab selected. The Equip‐
ment Models window also appears.

3. Select the equipment model using the Equipment Models window. If necessary, you may add 
a new equipment model. Please see “The Equipment Models Window” on page 105 for more 
information about the Equipment Models window.

Note: These instructions assume that you have built your Information Lists, as 
described in “CHAPTER 6: Information Lists” on page 123.
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4. Enter a unique control number for the equipment item you are adding in the Control # field. 

5. Enter the unique serial number assigned to the equipment item by the manufacturer in the 
Serial Number field.

6. Enter the remaining equipment information in all of the Equipment Inventory window tabs. 
Please see:

‐ “Main Tab” on page 90 for information about the Main tab of the Equipment Inventory 
window.

‐ “Schedule Tab” on page 93 for information about the Schedule tab of the Equipment 
Inventory window. Please also see “Scheduling Equipment” on page 107 for information 
about scheduling equipment in HEMS.

‐ “Other Details Tab” on page 94 for information about the Other Details tab of the Equip‐
ment Inventory window. Please also see “CHAPTER 8: Managing Risk” on page 179 for 
information about managing risk in HEMS.

‐ “Parts Tab” on page 96 for information about the Parts tab of the Equipment Inventory 
window. Please also see “CHAPTER 7: Managing Parts” on page 169 for information 
about managing parts in HEMS.

‐ “Attachments Tab” on page 96 for information about the Attachments tab of the Equip‐
ment Inventory window.

7. Save the newly added equipment item by either clicking the Save button in the Toolbar or 
pressing [CTRL]+[S]. You are also prompted to save any unsaved changes if you exit without 
saving.

Copying Equipment
Adding a new equipment item to inventory by copying and editing an existing equipment item 
can save time and improve information accuracy. To add a new equipment item to inventory 
based on an existing equipment item:

1. Open the Equipment Inventory dashboard by either:

‐ Clicking the Equipment Inventory tab on the right of the HEMS application.

‐ Clicking the Equipment Inventory button in the HEMS Home screen.

‐ Selecting Activities>Equipment Inventory.

‐ Pressing [CTRL]+[I].

2. Search for and select the equipment you want to copy.

3. Click the Copy button in the Action Area to open the Equipment Inventory window with the 
values from the copied equipment item already filled in.

Note: You may either click a field or press [TAB] to move from field to field.
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4. Enter the unique control and serial numbers for the new equipment item in the Control # 
and Serial # fields.

5. Edit the remaining fields in all tabs as appropriate.

6. Save the new equipment item by either clicking the Save button in the Toolbar or pressing 
[CTRL]+[S]. You are also prompted to save any unsaved changes if you exit without saving.

Editing Equipment
To edit an equipment item:

1. Locate the equipment item you want to update in the Equipment Inventory dashboard and 
then clicking the Edit button in the Action Area. Please see “The Equipment Inventory Dash‐
board” on page 22 for more information about the Equipment Inventory dashboard.

This opens the Equipment Inventory window for the current equipment item. Please see 
“The Equipment Inventory Window” on page 89 for more information about the Equipment 
Inventory window.

2. Edit the equipment item as needed.

3. Either click the Save button in the Toolbar or press [CTRL]+[S] to save the edited equipment 
item.

Active/Inactive Equipment
HEMS allows you to mark equipment as active or inactive. Newly added equipment items are 
active by default.

Activating Equipment
Marking an equipment item active signifies that the item is in service. Active items appear in 
searches and are scheduled for preventive maintenance.

To mark an equipment item as active:

1. Locate the equipment item you want to update in the Equipment Inventory dashboard and 
then clicking the Edit button in the Action Area. Please see “The Equipment Inventory Dash‐
board” on page 22 for more information about the Equipment Inventory dashboard.

This opens the Equipment Inventory window with the currently selected equipment item 
information already filled in. Please see “The Equipment Inventory Window” on page 89 for 
more information about the Equipment Inventory window.

Note: The technician can edit multiple equipment items at once using the Quick 
Equipment Activities window. Managers can edit multiple equipment items, 
including scheduling information, using the Equipment Management window. 
Please see “The Quick Equipment Activities Window” on page 101 and “Equip‐
ment Management” on page 260 for more information about the Quick Equip‐
ment Activities and Equipment Management windows.
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2. Check the Active checkbox in the Main tab of the Equipment Inventory window.

3. Either click the Save button in the Toolbar or press [CTRL]+[S] to save the edited equipment 
item.

Deactivating Equipment
Marking an equipment item as inactive prevents that equipment item from appearing in 
searches or being scheduled for preventive maintenance unless you have set your HEMS defaults 
to show both active and inactive records. Please see “General Service Area Options” on page 263 
for information about customizing HEMS defaults.

To mark an equipment item as inactive:

1. Locate the equipment item you want to update in the Equipment Inventory dashboard and 
then click the Edit button in the Action Area. Please see “The Equipment Inventory Dash‐
board” on page 22 for more information about the Equipment Inventory dashboard.

This opens the Equipment Inventory window with the currently selected equipment item 
information already filled in. Please see “The Equipment Inventory Window” on page 89 for 
more information about the Equipment Inventory window.

2. Clear the Active checkbox in the Main tab of the Equipment Inventory window.

3. Either click the Save button in the Toolbar or press [CTRL]+[S] to save the edited equipment 
item.

Retiring/Storing/Deleting Equipment
HEMS allows you to retire equipment items, place equipment into and out of storage, and delete 
equipment items.

Retiring Equipment
Retiring an equipment item removes that equipment item from service. To retire an equipment 
item:

1. Select Activities>Quick Equipment Activities to open the Quick Equipment Activities win‐
dow.

Note: You can activate multiple equipment items at once by using the Quick 
Equipment Activities window and selecting Activate in the Selection menu. 
Please see “The Quick Equipment Activities Window” on page 101 for more 
information about the Quick Equipment Activities window.

Note: You can deactivate multiple equipment items at once using the Quick 
Equipment Activities window and selecting Deactivate in the Selection menu. 
Please see “The Quick Equipment Activities Window” on page 101 for more 
information about the Quick Equipment Activities window.
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2. Locate the equipment item(s) you want to retire and move that information to the Selection 
Area.

3. Select Retire using the Select pull‐down menu and then enter the following information:

‐ Retire: Enter the retirement date for the equipment item(s) in the Retire field.

‐ Total Time: Enter the total time to perform any required retirement procedure on the 
equipment item(s) in the Total Time field.

‐ Assigned Engineer: Select the engineer responsible for retiring the equipment item(s) 
using the Assigned Engineer field.

4. Click Apply to retire the equipment item(s) and close the Quick Equipment Activities win‐
dow.

Storing Equipment
Storing an equipment item indicates that it is being kept in storage for possible future use. To 
store equipment:

1. Select Activities>Quick Equipment Activities to open the Quick Equipment Activities win‐
dow.

2. Locate the equipment item(s) you want to store and move that information to the Selection 
Area.

3. Select Storage ‐ In using the Select pull‐down menu and then enter the following informa‐
tion:

‐ Storage Date: Enter the date on which the equipment item(s) were placed in storage 
using the Storage Date field.

‐ Storage Location: Enter the location where the equipment item(s) are being stored in the 
Storage Location field.

4. Click Apply to store the equipment item(s) and close the Quick Equipment Activities win‐
dow.

Removing Equipment from Storage
Removing an equipment item indicates that it is no longer being stored and may be in the pro‐
cess of being returned to active service. To store an equipment item:

1. Select Activities>Quick Equipment Activities to open the Quick Equipment Activities win‐
dow.

2. Locate the equipment item(s) you want to remove from storage and move that information 
to the Selection Area.

Note: You can define equipment retirement procedures by Service Area or 
equipment type, model, or item. Please see “General Service Area Options” on 
page 263 for information on defining default retirement procedures by Service 
Area.
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3. Select Storage ‐ Out using the Select pull‐down menu and then enter the following informa‐
tion:

‐ Date: Enter the date on which the equipment item(s) were placed in storage using the 
Date field.

4. Click Apply to remove the equipment item(s) from storage and close the Quick Equipment 
Activities window.

Deleting an Equipment Item.
Deleting an equipment item from HEMS removes the item from inventory. To delete an equip‐
ment item, locate the equipment item you want to delete in the Equipment Inventory dash‐
board and then click the Delete button in the Action Area. Please see “The Equipment Inventory 
Dashboard” on page 22 for more information about the Equipment Inventory dashboard.

Opening a Work Order from the Equipment Inventory
Dashboard
You can open a work order for the current equipment item in the Equipment Inventory dash‐
board. Opening a work order from the Equipment Inventory dashboard automatically fills the 
equipment information into the work order for you.

To open a work order for the current equipment item:

1. Locate the equipment item you want to update in the Equipment Inventory dashboard. 
Please see “The Equipment Inventory Dashboard” on page 22 for more information about 
the Equipment Inventory dashboard.

2. In the Action Area, check the radio button that corresponds to the type of work order you are 
creating for the equipment item. Please see “Managing Work Orders” on page 56 for more 
information about work order types.

3. Click the Create WO button to open the Work Order window with the equipment item and 
type information already filled in. Please see “The Work Order Window” on page 60 for more 
information about the Work Order window.

4. Edit the work order as necessary.

5. Either click the Save button in the Toolbar or press [CTRL]+[S] to save the newly opened work 
order.

Note: You cannot delete equipment if any action has been performed on it, 
because that action is part of your maintenance history, which includes work 
orders, equipment assigned to a contract, etc. 
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Viewing Equipment History
Clicking the H button in the Action Area of the Equipment Inventory dashboard opens the Equip‐
ment History window, which allows you to view, edit, copy, close, and delete work orders for the 
current equipment item. Please see “The Equipment History Window” on page 103 for more 
information about the Equipment History window.

Viewing Equipment Contract History
Clicking the C button in the Action Area of the Equipment Inventory dashboard opens the Equip‐
ment Contract History window, which lists the service contract(s) that cover the current equip‐
ment item. Please see “The Equipment Contract History Window” on page 104 for more 
information about the Equipment Contract History window and “CHAPTER 9: Managing Con‐
tracts” on page 183 for more information about managing contracts in HEMS.

Viewing Equipment Schedule Information
Clicking the S button in the Action Area of the Equipment Inventory dashboard opens the 
selected equipment item’s maintenance schedule(s) in a separate browser window.
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CHAPTER 6:
Information Lists
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The HEMS Information Lists
This section describes each of the HEMS Information Lists.

Departments List
Selecting Information Lists>Depart‐
ments opens the Departments 
Information List.

All of the facility’s departments 
must be entered into the Depart‐
ments Information List for purposes 
such as:

• “Charge back” systems that 
transfer costs from the engi‐
neering department to the 
department using their materi‐
als and services.

• Determining ownership of hos‐
pital equipment and charges for 
repairs to that equipment.

The Departments Information List contains the following information for each record:

• Shared: Whether or not the department is shared across Service Areas.

• Active: Whether or not the department is currently active.

• Department Name: Name of the department.

• Cost Center #: This number is used for accounting purposes.

• Department Head Initials: Initials of the department head.

• Phone: Department’s main or primary contact phone number.

• Budget: Amount that the department allocates for labor and parts expenditures to maintain 
the equipment for which it is responsible, such as defibrillators or equipment owned by the 
facilities department that services a clinical or other department within the hospital, such as 
HVAC, medical gas, electrical power, etc.

• Footage: The department’s total square footage. This is useful when utility costs are charged 
back to departments.

Note: All Information Lists contain NONE and Not Found values. These are fixed 
system values that cannot be edited, deleted, or replaced. Some Information 
Lists also contain additional fixed system values that are described where 
appropriate in this chapter.
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• Schedule Date: If you schedule some or all of your equipment by department, this is the date 
used to base the date for generating your schedules.

• Schedule Frequency: Preventive maintenance frequency for equipment in this department. 
Defining a preventive frequency by department will assign the selected frequency to all 
equipment assigned to the department. This frequency will override any higher frequency 
assigned for the equipment. For example, if the department frequency is quarterly but the 
equipment preventive maintenance frequency is semi‐annual, the new frequency for the 
equipment will be quarterly. If only some of the equipment in a department require a differ‐
ent interval, then use the Equipment Inventory window to add the new interval for these 
equipment items. Please see “Defining Preventive Maintenance Templates by Equipment 
Item” on page 109 for information about scheduling by equipment item.

• Shift: The department’s hours of operation. This information is shared with the Employees 
Information List.

• Notes: Additional information about the department.

Please see “Working with Information Lists” on page 159 for information about working with 
Information Lists.

Note: Only define the frequency by departments if this is an exception to your 
standard preventive maintenance template, which is defined by equipment 
type, model, equipment item and/or groups. For example, you may have a state 
requirement to perform more frequent preventive maintenance for a particular 
department, such as OR.

Note: You need to define a Department shift in order to report equipment down 
time.
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Device Inclusions List
Selecting Information Lists>Device 
Inclusions opens the Device Inclu‐
sions Information List.

The Device Inclusions Information 
List allows you to classify equip‐
ment in inventory for identification 
purposes. For example, you can ful‐
fill the requirement to maintain a 
utility management list by using 
this Information List and identifying 
all equipment you define as “Util‐
ity” by selecting Utility from the 
device inclusion list when adding 
equipment to inventory. Other 
potential groups may include “Clini‐
cal,” “Critical Care,” “General Equipment,” “Fire Safety,” “Life Safety,” and any other type of 
equipment that would be beneficial for you to group.

The Device Inclusions Information List contains the following information for each record:

• Shared: Whether or not the device inclusion is shared across Service Areas.

• Active: Whether or not the device inclusion is active.

• Device Inclusion: Name of the device inclusion group.

• Notes: Additional information about the device inclusion group.

Employees List
Selecting Information 
Lists>Employees opens the 
Employees Information List.

The Employees Information List 
contains detailed information on 
staff and contractor (vendor) per‐
sonnel. Personnel must be entered 
into this Information List in before 
they can become authorized HEMS 
users, have work orders assigned to 
them, and have their hours tracked 
for reporting purposes.

The Employees Information List 
contains the following information 
for each record:

AUTHORED BY ANTHONY HERNANDEZ - (415)786-2081 - anthony94122@outlook.com
126 January 2010 - Revision 1.0



HEMS Enterprise 5.x User & Administrator Guide
• Shared: Whether or not the employee record is shared across Service Areas.

• Initials: The employees’ initials or an abbreviation used to designate a group of employees. 
Clicking the blue Initials link opens the Labor Hours report for the selected employee or 
employee group. You must enter shift information in this Information List in order to com‐
pare labor hours against shift hours.

• Employee #: Individual number assigned to each employee.

• Rate: The employee’s hourly pay rate. This information is used to generate costs on work 
orders and may be entered as a department‐wide average in order to protect confidentiality.

• Specialty: The employee’s professional specialty (such as plumbing, electrical, BMET, etc.). 
This field uses values from the Maintenance Specialties Information List, which is described 
in “Maintenance Specialties List” on page 144.

• First Name: The employee’s first name.

• Middle Initial: The employee’s middle initial.

• Last Name: The employee’s last name.

• Start Date: Date the employee started work.

• Department: Department the employee is assigned to. This field uses values from the 
Departments Information List, which is described in “Departments List” on page 124.

• Location: Location of the department. This field uses values from the Locations Information 
List, which is described in “Locations List” on page 140.

• Termination Date: Date the employee terminated employment.

• Shift: Shift that the employee normally works. You must define a shift for this employee in 
order to compare labor hours against shift hours when running the Labor Hours report as 
described above. This field uses values from the Shifts Information List, which is described in 
“Shifts List” on page 152. 

• Eng Emp: If this checkbox is checked, the selected employee is an engineering employee who 
can be assigned to or perform labor on work orders. Employees who do not have this check‐
box checked cannot be assigned work or have labor entered on work orders; they can open 
work orders, if they have the appropriate permissions.

• Vendor: Check this checkbox to indicate that the selected employee is an independent con‐
tractor.

• Active: Whether or not the employee is active.

• Office Phone: Employee’s office phone number.

• Home Phone: Employee’s home phone number.

Note: Adding or editing an employee’s pay rate after the employee has been 
assigned work orders will not affect past (or closed) work orders; the updated 
pay rate will appear on future work orders. 
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• Fax: Employee’s fax number.

• Email: Employee’s email address.

• Beeper: Employee’s pager/beeper number. The employee will receive a pager notification 
when a work order is assigned to them if the HEMS server is configured to support this 
option. The work coordinator must have a valid email address in order for this service to be 
active. Please see “Pager/Email Service Area Options” on page 265 for more information 
about configuring beeper and email notifications.

• Address/City/State/Zip: Employee’s complete street, city, state, and ZIP code

• Notes: Additional information about the employee such a degrees, special training, etc.

This Information list has the following fixed system values: Admin, and Guest.

Equipment Lists
The equipment inventory is the central focus of the entire HEMS system. The combination of 
information such as equipment type, manufacturer, model, etc. uniquely identifies the charac‐
teristics of each equipment item. Careful equipment inventory planning and design is crucial for 
efficient and accurate equipment management.
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Equipment Inventory Form (Plant)
Use one copy of the following form (or similar) to gather information for each piece of Plant 
equipment if no equipment inventory is available from a manual system or archived CMMS when 
building the HEMS database.

HEMS PLANT EQUIPMENT INVENTORY SURVEY FORM
Control # Equipment Type
Device Inclusion Manufacturer
Model Number Serial Number
Revision Supplier
Department Name Campus
Building Floor
Wing Room
Space Location Code
Warranty Date Service Date
Purchase Date Purchase Price
P.O. Number Documentation? None
UPS? Yes No Service Manual
Emergency Power? Yes No User Manual
Active? Yes No

SUBSYSTEM INFORMATION
MOTOR COMPRESSOR COMPUTER STEAM TRAP

Tag # Tag # Hard Drive Tag #
Manf. Manf. RAM Manf.
Mod # Mod # CD‐R Mod #
Ser # Ser # Type
Frame Frame Press.
H.P. H.P. Size
Volts Volts Location
Amps Amps
Phase Phase
RPM RPM

REHEAT UPS VAV COMPONENTS
Tag # Tag # Tag # Filter #1
Manf. Manf. Manf. Filter #2
Mod # Mod # Mod # Filter #3
Size Input V Size Belts
CFM Capacity Style Bearings
Supply Battery CFM Tools 1
Location # of Batts. Damper Tools 2

Outlets Location Other 1
Location Other 2

Equipment Text Work Order Notes
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Equipment Inventory Form (Biomed)
Use one copy of the following form (or similar) to gather information for each piece of Biomedi‐
cal Engineering equipment if no equipment inventory is available from a manual system or 
another CMMS when building the HEMS database.

HEMS BIOMEDICAL ENGINEERING EQUIPMENT INVENTORY SURVEY FORM
Control # Equipment Type
Device Inclusion Manufacturer
Model Number Serial Number
Revision Supplier
Department Name Campus
Building Floor
Wing Room
Space Location Code
Warranty Date Service Date
Purchase Date Purchase Price
P.O. Number Documentation? None
UPS? Yes No Service Manual
Emergency Power? Yes No User Manual
Active? Yes No ECRI Name
ECRI # Ownership

SUBSYSTEM INFORMATION
MOTOR COMPRESSOR COMPUTER UPS

Tag # Tag # Hard Drive Tag #
Manf. Manf. RAM Manf.
Mod # Mod # CD‐R Mod
Ser # Ser # Input V
Frame Frame Capacity
H.P. H.P. # Batts.
Volts Volts Outlets
Amps Amps Location
Phase Phase
RPM RPM

COMPONENTS OTHER OTHER COMPONENTS
Filter #1
Filter #2
Filter #3
Belts
Bearings
Tools 1
Tools 2
Other 1
Other 2
Equipment Text Work Order Notes
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Equipment Models List
Selecting Information Lists>Equipment Inventory Lists>Equipment Models opens the Equip‐
ment Models Information List.

The Equipment Models Informa‐
tion List list identifies equipment by 
model and divides equipment into 
categories to facilitate purchasing 
similar parts in volume. It is also 
essential for efficiently opening and 
responding to work orders for 
device recalls and alerts. You can 
also use it to help in salvaging parts 
when a unit is taken out of service.

The Equipment Models Informa‐
tion List contains the following gen‐
eral information for each record:

• Model #: Equipment model number.

• Active: Whether or not the equipment model is active.

• Name: Equipment model name.

• Manf: Equipment manufacturer.

• EQ Type: Type of equipment. This field uses values from the Equipment Types Information 
List, which is described in “Equipment Types List” on page 134. Clicking the EQ Type hyper‐
link runs the Scheduling Impact report, which lists all the equipment assigned to this type so 
you can review the impact on scheduling before making an equipment type change. For 
example, you can review the impact of schedule frequency changes, scheduling or unsched‐
uling equipment, or changing the schedule start date.

• ECRI#: Emergency Care Research Institute (ECRI) manufacturer number assigned to the 
equipment model.

• Name: ECRI name of the equipment model.

• Notes: Additional information about the equipment model.

Note: Entering the ECRI # and type from ECRI's Universal Medical Device 
Nomenclature System™ (UMDNS™) in the ECRI # and ECRI Name fields allows 
Biomedical Engineering staff to efficiently open and respond to work orders for 
device recall and alerts. 
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The Equipment Models Schedule tab allows you to enter a preventive maintenance schedule 
template (preventive maintenance procedure, interval, and assigned engineer) for the equip‐
ment model. In general, you will schedule equipment by equipment type; however, if there are 
particular equipment models that require a different preventive maintenance procedure, inter‐
val, or assigned engineer, this is where they are scheduled. Please see “Scheduling Equipment” 
on page 107 for more information about scheduling.

This tab contains the following additional information:

• Schedule Template: When you need to define a pre‐
ventive maintenance template by equipment model, 
checking the Schedule Template checkbox allows 
you to define the PM Procedure, Assigned Engineer, 
Schedule Date, and/or Schedule Frequency at the 
equipment model level. To define the procedure for 
the equipment model, click the Edit button in the 
Toolbar and then check the Schedule Template checkbox.

• PM Procedure: Preventive maintenance procedure to use for the equipment model. Preven‐
tive maintenance is usually defined by equipment type; however, you may define the proce‐
dure by equipment model, if needed.

• Assigned Engineer: Name of the engineer assigned to work on the equipment model. The 
assigned engineer is usually defined by equipment type; however, you may assign an engi‐
neer by equipment model, if needed. This field uses values from the Employees Information 
List, which is described in “Employees List” on page 126.

• Priority: The Priority field displays the priority for the equipment model based on risk if you 
have risk defined. If you have minimum frequency for scheduling based on risk configured, 
the maintenance interval may vary depending on the risk factor; review risk‐related mainte‐
nance intervals using the Risk Interval report, which is described in “Risk Interval” on 
page 216. You may also define the priority manually if you are not using risk.

• Schedule Date: When scheduling by model, this is the date used to base the date for generat‐
ing your schedules for the equipment model. Please see “Scheduling Equipment” on 
page 107 for more information about scheduling.

• Schedule Frequency: How frequently (i.e. the intervals) you are going to perform preventive 
maintenance on the equipment model. In general, frequency is defined by equipment type; 
however, you may schedule by model if necessary. Use one frequency for every maintenance 
interval. For example, if maintenance must be done monthly, semi‐annually, and annually, 
you will need to add three frequency entries.

‐ Clicking the New button to the right of the Schedule Frequency field opens the Schedule 
Frequency window, which allows you to add a schedule frequency to the preventive 
maintenance procedure for the equipment model.

‐ Double‐clicking an existing schedule frequency opens the Schedule Frequency window 
for the selected frequency and allows you to make edits.

‐ Highlighting a frequency and then clicking the Delete button next to the selected fre‐
quency removes that frequency from the equipment model.AUTHORED BY ANTHONY HERNANDEZ - (415)786-2081 - anthony94122@outlook.com
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Please see “Scheduling Equipment” on page 107 for more information about working with 
schedule frequencies.

The Equipment Models Other Details tab contains the 
following additional information:

• Risk Assessment: If the equipment model has differ‐
ent risk factors than the equipment type this model 
belongs to, then check the Risk Assessment check‐
box to define the risk for this model. Defining risk by 
equipment model overrides the risk assigned to the 
equipment type, and also assigns this risk level to all 
equipment items assigned to the equipment model. HEMS can be configured to base mini‐
mum schedule frequencies on the assigned risk factor. For example, you may have defined an 
annual preventive maintenance procedure that, due to a high risk factor, must be performed 
semiannually.

• Risk Statement Groups: If you are assigning risk by equipment model, use the pull‐down 
menu to answer each of the five following statements. HEMS calculates the risk factor, which 
determines the priority.

‐ Equipment Function: What the equipment is used for.

‐ Clinical Application: How the equipment model impacts clinical functions.

‐ PM Requirement: How often preventive maintenance needs to be performed.

‐ Likelihood of Failure: How likely the equipment is to fail. This is a measure of equipment 
reliability.

‐ Environment of Use: Where the equipment is used.

• Risk Factor: HEMS displays the calculated risk factor in the Risk Factor field. HEMS calculates 
the risk factor, which determines the priority. Please see “CHAPTER 8: Managing Risk” on 
page 179 for information about managing risk in HEMS.

• Support End Date: Last date that the manufacturer (OEM) will support this equipment 
model.

• Last Production Date: Date that the manufacturer has (or will) stop manufacturing this 
equipment model.

• Max Replace Date: Last date by which this equipment model must be retired or replaced.

• Service Manual: Checking the Service Manual checkbox indicates that a service manual is 
available for this equipment model and includes this information on individual equipment 
item records. Scan or attach manuals using the Attachments tab, described below.

• Operator Manual: Checking the Operator Manual checkbox indicates that an operator man‐
ual is available for this equipment model and includes this information on individual equip‐
ment item records. Scan or attach manuals using the Attachments tab, described below.

• Obsolete: Checking the Obsolete checkbox means that this equipment model is considered 
obsolete.
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• Prohibited: Checking the Prohibited checkbox means that the equipment model is prohib‐
ited in the health care facility and must be removed from the facility.

• Alarm: Checking the Alarm checkbox means that this equipment model includes one or 
more alarms that indicate equipment failure, as described in ASHE Safety Goal #6.

• Incoming Inspection: Checking the Incoming Inspection checkbox allows you to select the 
desired inspection that applies to newly acquired equipment items of this model, using the 
pull‐down menu. Please see “General Service Area Options” on page 263 for more informa‐
tion about defining a default incoming inspection procedure.

• Retirement Procedure: Checking the Retirement Procedure checkbox allows you to select 
the desired procedure that applies when retiring equipment items of this model from ser‐
vice, using the pull‐down menu. Please see “General Service Area Options” on page 263 for 
more information about defining a default retirement procedure.

The Equipment Models Parts tab allows you to assign 
parts to the equipment model for preventive mainte‐
nance. Please see “Adding Equipment Models” on 
page 161 for information about updating the parts 
assigned to the current equipment model.

The Equipment Models Attachments tab allows you to 
scan and/or attach documents such as manuals or 
images related to the current equipment model. Attach‐
ments included here are also available at the equipment item level. Please see “Attaching or 
Scanning Files” on page 168 for more information about working with scanned and attached files 
in HEMS Information Lists.

Equipment Types List
Selecting Information Lists>Equip‐
ment Inventory Lists>Equipment 
Types opens the Equipment Types 
Information List.

The Equipment Types Information 
List allows you to identify and group 
like pieces of equipment. EQ2 sup‐
ports and will integrate any of the 
standard equipment nomenclatures 
(ASHE, AAMI, or ECRI) and proce‐
dures to your standardization pro‐
cess. Please contact EQ2 directly for 
information and a quote for stan‐
dardizing processes for existing data.

The Equipment Types Information List contains the following general information for each 
record:

• Type: Name of the selected equipment type (from a standard list such as ASHE).
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• Active: Whether or not the equipment type is active or not.

• Class: Equipment class that the equipment type belongs to. This field uses values from the 
Equipment Classes Information List, which is described in “Equipment Classes List” on 
page 139.

• Life Expectancy: Life expectancy of the equipment type, in years. The Maximum Expenditure 
Limit (MEL) report uses this information, which is one of the criteria for determining when to 
replace equipment. Please see “Maximum Expenditure Limit” on page 211 for more informa‐
tion about the Maximum Expenditure Limit (MEL) report.

• System: Equipment system that the equipment type belongs to. This field uses values from 
the Equipment Systems Information List, which is described in “Equipment Systems List” on 
page 139.

• ECRI#: Emergency Care Research Institute (ECRI) number assigned to the equipment type.

• Name: ECRI name of the equipment type.

• Notes: Additional information about the equipment type.

The Equipment Types Schedule tab contains the follow‐
ing additional information:

• PM Procedure: Preventive maintenance procedure 
to use for the equipment type. This field uses values 
from the Procedures Information List, which is 
described in “Procedures List” on page 146.

• Assigned Engineer: Name of the engineer assigned 
to the equipment type. This field uses values from 
the Employees Information List, which is described in “Employees List” on page 126.

• Priority: The Priority field displays the priority for the equipment type based on risk if you 
have risk defined. If you have minimum frequency for scheduling based on risk configured, 
the maintenance interval may vary depending on the risk factor; review risk‐related mainte‐
nance intervals using the Risk Interval report, which is described in “Risk Interval” on 
page 216. You may also define the priority manually if you are not using risk.

• Schedule Date: Date from which to base the date for generating your schedules for the 
equipment type. Please see “Scheduling Equipment” on page 107 for more information 
about scheduling.

Note: Entering the ECRI # and type from ECRI's Universal Medical Device 
Nomenclature System™ (UMDNS™) in the ECRI # and ECRI Name fields allows 
Biomedical Engineering staff to efficiently open and respond to work orders for 
device recall and alerts. 

AUTHORED BY ANTHONY HERNANDEZ - (415)786-2081 - anthony94122@outlook.com
135Copyright 2010, EQ2, Inc. All rights reserved.



CHAPTER 6: Information Lists
• Schedule Frequency: How frequently (i.e. the intervals) you are going to perform preventive 
maintenance on the equipment type. Use one frequency for every maintenance interval. For 
example, if maintenance must be done monthly, semi‐annually, and annually, you will need 
to add three frequency entries.

‐ Clicking the New button to the right of the Schedule Frequency field opens the Schedule 
Frequency window, which allows you to add a schedule frequency to the preventive 
maintenance procedure for the equipment type.

‐ Double‐clicking an existing schedule frequency opens the Schedule Frequency window 
for the selected frequency and allows you to make edits.

‐ Highlighting a frequency and then clicking the Delete button removes that frequency 
from the equipment type.

Please see “The Schedule Frequency Window” on page 97 for more information about work‐
ing with schedule frequencies.

The Equipment Types Other Details tab contains the fol‐
lowing additional information:

• Risk Assessment: Checking the Risk Assessment 
checkbox allows you to define risk for the equipment 
type. Defining risk by equipment type also assigns 
this risk level to all equipment models and items 
assigned to this type. HEMS automatically calculates 
the risk factor based on how you answer the risk 
statements. HEMS can be configured to base minimum schedule frequencies on the assigned 
risk factor. For example, you have an annual preventive maintenance procedure, but risk fac‐
tor determines it should be performed semiannually.

• Risk Statement Groups: If you are assigning risk by equipment type, use the pull‐down menu 
to answer each of the five following statements. HEMS calculates the risk factor, which deter‐
mines the priority.

‐ Equipment Function: What the equipment is used for.

‐ Clinical Application: How the equipment model impacts clinical functions.

‐ PM Requirement: How often preventive maintenance needs to be performed.

‐ Likelihood of Failure: How likely the equipment is to fail. This is a measure of equipment 
reliability.

‐ Environment of Use: Where the equipment is used.

Note: Risk is normally defined by equipment type; all equipment models and 
items assigned to the equipment type will inherit the risk factor defined for this 
type. If necessary, risk may be defined by equipment model and/or equipment 
item. Defining risk for an equipment model overrides the risk factor defined for 
the equipment type. Defining risk for an equipment item overrides the risk 
defined for both the equipment type and model.
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• Risk Factor: HEMS displays the calculated risk factor in the Risk Factor field. HEMS calculates 
the risk factor, which determines the priority. Please see “CHAPTER 8: Managing Risk” on 
page 179 for information about managing risk in HEMS.

• Incoming Inspection: Checking the Incoming Inspection checkbox allows you to select the 
desired inspection that applies to newly acquired equipment items of this type, using the 
pull‐down menu. Please see “General Service Area Options” on page 263 for more informa‐
tion about defining a default incoming inspection procedure.

• Retirement Procedure: Checking the Retirement Procedure checkbox allows you to select 
the desired procedure that applies when retiring equipment items of this type from service, 
using the pull‐down menu. Please see “General Service Area Options” on page 263 for more 
information about defining a default retirement procedure.

The Equipment Types Attachments tab allows you to scan and/or attached documents such as 
manuals or images related to the current equipment type. Attachments included here are also 
available at the equipment item level. Please see “Attaching or Scanning Files” on page 168 for 
more information about working with scanned and attached files in HEMS Information Lists.

Equipment Groups List
Selecting Information Lists>Equip‐
ment Inventory Lists>Equipment 
Groups opens the Equipment 
Groups Information List.

The Equipment Groups Information 
List allows you to perform preven‐
tive maintenance on groups of 
equipment where scheduling by 
type or model is difficult. For exam‐
ple, you may have hundreds of fire 
extinguishers and may decide to 
create a number of manageable 
sized groups for scheduling pur‐
poses. Individual preventive main‐
tenance work orders will be created for each equipment item within the group.

The Equipment Groups Information List contains the following general information for each 
record:

• Group: Name of the selected equipment group.

• Active: Whether or not the equipment group is active.

• Schedule: Checking the Schedule checkbox allows you to schedule the equipment belonging 
to the equipment group as a group and also enables the Schedule Templates tab, described 
below.
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• Schedule Date: Date from which to base the date for 
generating your schedules for the equipment group. 
Please see “Scheduling Equipment” on page 107 for 
more information about scheduling.

• Notes: Additional information about the equipment 
group.

The Equipment Groups Equipment tab lists the equip‐
ment assigned to the group.

When the Schedule checkbox is checked as described 
above, the Equipment Groups Schedule Template tab 
contains the following additional information:

• PM Procedure: Preventive maintenance procedure 
to use for the equipment group. This field uses val‐
ues from the Procedures Information List, which is 
described in “Procedures List” on page 146.

• Assigned Engineer: Name of the engineer assigned 
to perform preventive maintenance on the equip‐
ment group. This field uses values from the Employees Information List, which is described in 
“Employees List” on page 126.

• Priority: Priority of the equipment group. This appears on scheduled work orders for each 
equipment item in this equipment group. You may select a priority by using the pull‐down 
menu or by right‐clicking or pressing [F2], as described in “CHAPTER 3: Adding Values to 
Fields” on page 49.

• Schedule Date: Date from which to base the date for generating your schedules for this 
equipment group. Please see “Scheduling Equipment” on page 107 for more information 
about scheduling.

• Schedule Frequency: How often the preventive maintenance procedure should occur for the 
equipment group (i.e. the interval). Use one frequency for every maintenance interval. For 
example, if maintenance must be done monthly, semi‐annually, and annually, you will need 
to add three frequency entries.

‐ Clicking the New button opens the Schedule Frequency window, which allows you to add 
a schedule frequency to the preventive maintenance procedure for the equipment group.

‐ Double‐clicking an existing schedule frequency opens the Schedule Frequency window 
for the selected frequency and allows you to make edits.

‐ Highlighting a frequency and then clicking the Delete button removes that frequency 
from the equipment group.

Please see “The Schedule Frequency Window” on page 97 for more information about work‐
ing with schedule frequencies.

Please see “Adding a Record” on page 161 and “Adding Equipment Groups” on page 164 for 
information about adding equipment groups.
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Equipment Classes List
Selecting Information Lists>Equip‐
ment Inventory Lists>Equipment 
Classes opens the Equipment 
Classes Information List.

The Equipment Classes Information 
List allows you to identify equip‐
ment such a Life Support, Diagnos‐
tic, Non‐patient Care, Laboratory 
Equipment, Electrical, Patient Sup‐
port, or Cooling.

The Equipment Classes Information 
List contains the following general 
information for each record:

• Name: Name of the equipment 
class.

• Active: Whether or not the equipment class is active.

• Notes: Additional information about the equipment class.

Equipment Systems List
Selecting Information Lists>Equip‐
ment Inventory Lists>Equipment 
Systems opens the Equipment Sys‐
tem Information List.

The Equipment Systems Informa‐
tion List offers a larger group that 
equipment items can belong to, 
such as HVAC, Water System, or 
Electrical System, if applicable. It is 
yet another way of grouping like 
equipment together.

The Equipment Systems Informa‐
tion List contains the following gen‐
eral information for each record:

• Name: Name of the equipment system.

• Active: Whether or not the equipment system is active.

• Notes: Additional information about the equipment system.
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Locations Lists
The Locations Information Lists define specific locations within your facility or facilities. These 
locations are used to record equipment locations for inventory and tracking purposes. You can 
also schedule preventive maintenance by location.

Locations List
Selecting Information Lists>Loca‐
tions>Locations opens the Loca‐
tions Information List. This is a very 
important Information List because 
technicians use the location 
description to locate the equipment 
on work orders. A location may be a 
specific room or where a piece of 
inventoried equipment is located or 
stored. Knowing where equipment 
is becomes especially important in 
large or multi‐building facilities 
because this information can save a 
lot of time and confusion. 

The Locations Information List con‐
tains the following information for each record:

• Shared: Whether or not the location is shared across Service Areas.

• Location: Name of the location.

• Active: Whether or not the location is active.

• Campus: Name of the campus associated with the location. This field uses values from the 
Campuses Information List, which is described in “Campuses List” on page 141.

• Building: Name or number of the building associated with the location. This field uses values 
from the Buildings Information List, which is described in “Buildings List” on page 142.

• Wing: Name or number of the wing associated with the location. This field uses values from 
the Wings Information List, which is described in “Wings List” on page 142.

• Floor: Name or number of the floor associated with the location. This field uses values from 
the Floors Information List, which is described in “Floors List” on page 143.

• Room: Name or number of the room associated with the location. This field uses values from 
the Rooms Information List, which is described in “Rooms List” on page 143.

• Space: Name or number of the space associated with the location. This field uses values from 
the Spaces Information List, which is described in “Spaces List” on page 144.

• Start Date: Date from which to base the date for generating your schedules for equipment 
that is scheduled by this location. Please see “Scheduling Equipment” on page 107 for infor‐
mation about scheduling equipment.
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• Schedule Frequency: Preventive maintenance frequency for equipment at this location. 
Defining a preventive maintenance frequency by location will assign the frequency selected 
to all equipment assigned to the location. This frequency will override any higher frequency 
assigned for the equipment. For example, if the location frequency is quarterly but the equip‐
ment preventive maintenance frequency is semi‐annual, the new frequency for the equip‐
ment will be quarterly. If only some of the equipment in a location require a different 
interval, then use the Equipment Inventory window to add the new interval for these equip‐
ment items. See “Defining Preventive Maintenance Templates by Equipment Item” on 
page 109 for information about scheduling by equipment item.

• Notes: Additional information about the location.

Campuses List
Selecting Information Lists>Loca‐
tions>Campuses opens the Cam‐
puses Information List. Campuses 
are typically clusters of buildings 
within the same vicinity of each 
other.

The Campuses Information List con‐
tains the following information for 
each record:

• Shared: Whether or not the 
campus is shared across Service 
Areas.

• Campus: Name of the campus.

• Active: Whether or not the 
campus is active.

• Notes: Additional information about the campus.

Note: Only define the frequency by locations if this is an exception to your stan‐
dard preventive maintenance template, which is defined by equipment type, 
model, equipment item and/or groups. For example, you may have a state 
requirement to perform more frequent preventive maintenance for a particular 
location.
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Buildings List
Selecting Information Lists>Loca‐
tions>Buildings opens the Build‐
ings Information List. Buildings are 
typically freestanding structures 
that may be either standalone or 
grouped into a campus.

The Buildings Information List con‐
tains the following information for 
each record:

• Shared: Whether or not the 
building is shared across Service 
Areas.

• Building: Name or number of 
the building.

• Active: Whether or not the building is active.

• Notes: Additional information about the building.

Wings List
Selecting Information Lists>Loca‐
tions>Wings opens the Wings 
Information List.

Wings typically designate separate 
sections of buildings that can span 
multiple floors.

The Wings Information List contains 
the following information for each 
record:

• Shared: Whether or not the 
wing is shared across Service 
Areas.

• Wing: Name or number of the 
wing.

• Active: Whether or not the wing is active.

• Notes: Additional information about the wing.
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Floors List
Selecting Information Lists>Loca‐
tions>Floors opens the Floors Infor‐
mation List. Floors typically 
designate a given floor number. A 
floor may span one or more wings.

The Floors Information List contains 
the following information for each 
record:

• Shared: Whether or not the 
floor is shared across Service 
Areas.

• Floor: Name or number of the 
floor.

• Active: Whether or not the 
floor is active.

• Notes: Additional information about the floor.

Rooms List
Selecting Information Lists>Loca‐
tions>Rooms opens the Rooms 
Information List. Rooms are typi‐
cally enclosed spaces on a certain 
floor.

The Rooms Information List con‐
tains the following information for 
each record:

• Shared: Whether or not the 
room is shared across Service 
Areas.

• Room: Name or number of the 
room.

• Active: Whether or not the 
room is active.

• Notes: Additional information about the room.
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Spaces List
Selecting Information Lists>Loca‐
tions>Spaces opens the Spaces 
Information List. Spaces are typi‐
cally areas within a room. 

The Spaces Information List con‐
tains the following information for 
each record:

• Shared: Whether or not the 
space is shared across Service 
Areas.

• Space: Name or number of the 
space.

• Active: Whether or not the 
space is active.

• Notes: Additional information about the space.

Maintenance Specialties List
Selecting Information Lists>Main‐
tenance Specialties opens the 
Maintenance Specialties Informa‐
tion List. 

The Maintenance Specialties Infor‐
mation List contains the trades, 
crafts, or other functions of the 
employees who perform the work 
generated through work orders 
(such as BMET, Biomedical Techni‐
cian, Imaging, Carpenter, Plumber, 
or Painter). This list may also 
include administration and man‐
agement functions.

The Maintenance Specialties Information List contains the following information for each 
record:

• Shared: Whether or not the maintenance specialty is shared across Service Areas.

• Specialty: Name of the maintenance specialty.

• Active: Whether or not the maintenance specialty is active.

• Notes: Additional information about the maintenance specialty.
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Part Types List
Selecting Information Lists>Part 
Types opens the Part Types Infor‐
mation List. 

The Part Types Information List is a 
category used to describe like parts 
in the HEMS Parts Inventory win‐
dow, such as: Ballasts, fluorescent; 
Cable, romex; Elbows, copper; and 
Lamps, incandescent. Please see 
“CHAPTER 7: Managing Parts” on 
page 169 for more information 
about managing parts within HEMS.

The Part Types Information List 
contains the following information 
for each record:

• Part Type: Name of the part type.

• Active: Whether or not the part type is active.

• Notes: Additional information about the part type.

Predefined Text List
Selecting Information Lists>Pre‐
defined Text opens the Predefined 
Text Information List. 

The Predefined Text Information 
List makes the data entry process 
simpler, faster, and more accurate 
by storing text for quick use when 
adding or editing information in the 
Work Order, Equipment Inventory, 
Contract, and Maintenance Task 
windows. Please see “Using Pre‐
defined Text” on page 50 for more 
information about using pre‐
defined text in fields.

AUTHORED BY ANTHONY HERNANDEZ - (415)786-2081 - anthony94122@outlook.com
145Copyright 2010, EQ2, Inc. All rights reserved.



CHAPTER 6: Information Lists
The continuing trend toward having mechanics and technicians enter their own work order data 
makes the Predefined Text Information List even more valuable. For example, consider the com‐
mon occurrence of replacing a light bulb. A predefined text string that says, “Remove diffuser 
and replace the 32 watt, 48 inch fluorescent tube” contains over 60 characters that the mechanic 
or technician can enter with just a few mouse clicks. Reusing this text string every time the iden‐
tical function is performed ensures consistency across records over time, which increases the 
value of reports that in turn increase efficiency and quality.

The Predefined Text Information list contains the following information for each record:

• Shared: Whether or not the predefined text record is shared across Service Areas.

• Text Title: Name of the predefined text string.

• Active: Whether or not the predefined text string is active.

• Module: Window in which the predefined text string applies. Users adding or editing infor‐
mation in a HEMS window/module will only see the predefined text strings that are available 
for that window, to avoid confusion.

• Text Content: The actual text string that will be entered into fields in the selected window 
when selected by the technician or engineer.

Procedure & Task Lists
Procedures and tasks describe the preventive maintenance performed on scheduled work 
orders. The Procedures and Tasks Information Lists are therefore critical to the core HEMS func‐
tions.

In general, a task is an individual work function such as, “test lead input voltage.” A procedure is 
an ordered collection of tasks designed to accomplish a certain function, such as completing pre‐
ventive maintenance or a specific repair on an equipment item. In this example, testing the lead 
input voltage could be the third step in a procedure that begins with plugging in and powering up 
the equipment item, then making sure that various indicator lamps are lit. Tasks and procedures 
can be further classified by type for organization, tracking, and reporting purposes.

Procedures List
Selecting Information Lists>Proce‐
dures & Tasks>Procedures opens 
the Procedures Information List. 

Each procedure in the Procedures 
Information List is a group of tasks 
that accomplish a specific goal such 
as a preventive maintenance cycle 
or repair action. EQ2 supports and 
will integrate any of the standard 
equipment nomenclatures (ASHE, 
AAMI, or ECRI) and procedures to 
your standardization process. 
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Please contact EQ2 directly for information and a quote for standardizing processes for existing 
data.

If service manuals are not available for a particular equipment item, use a manual from a related 
equipment item or a reputable book on related maintenance/repair procedures.

Procedures may contain tasks with multiple intervals, such as semi‐annual, quarterly and 
monthly. Schedules incorporate multiple task intervals. Please see “Scheduling Equipment” on 
page 107 for more information about scheduling equipment.

The Procedures Information List contains the following general information for each record:

• Name: Name of the procedure.

• Number: Number of the procedure. This number must be unique for each HEMS procedure.

• Active: Whether or not the procedure is active.

• Type: Type of the procedure. This field uses values from the Procedure Types Information 
List, which is described in “Procedure Types List” on page 148.

• Specialty: Maintenance or trade specialty required to perform the procedure. This field uses 
values from the Maintenance Specialties Information List, which is described in “Mainte‐
nance Specialties List” on page 144.

• Season: If a preventive maintenance procedure is performed during a season and not year‐
round, such as snow plowing, enter the Season here for scheduling purposes. This field uses 
values from the Seasons Information List, which is described in “Seasons List” on page 151.

• Source: Source used as reference material when designing the selected procedure.

• Schedule Frequency: How often you will perform preventive maintenance using this proce‐
dure (i.e. the interval). Use one frequency for every maintenance interval. For example, if 
maintenance must be done monthly, semi‐annually, and annually, you will need to add three 
frequency entries.

‐ Clicking the New button to the right of the Schedule Frequency field opens the Schedule 
Frequency window, which allows you to add a schedule frequency to the procedure.

‐ Double‐clicking an existing schedule frequency opens the Schedule Frequency window 
for the selected frequency and allows you to make edits.

‐ Highlighting a frequency and then clicking the Delete button removes that frequency 
from the procedure.

Please see “Adding Procedures” on page 165 for more information about adding tasks to a 
procedure and “The Schedule Frequency Window” on page 166 for information about assign‐
ing a frequency to each task.

CAUTION: IMPROPERLY DESIGNED PROCEDURES CAN CAUSE DAMAGE TO 
EQUIPMENT AND/OR REDUCED EQUIPMENT OPERATIONAL LIFE SPAN.
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The Tasks tab contains the following additional informa‐
tion: 

• Each task in the procedure.

• The frequency of each task.

• The estimated time for each task.

• Print Task Description: Checking the Print Task Description checkbox prints the information 
on your scheduled work orders.

Please see “Adding Procedures” on page 165 for information about adding tasks to a procedure.

The Description tab contains the following information: 

• All of the tasks that make up the procedure.

• The total estimated time to complete all of the tasks 
in the procedure (based on the time for each task).

• A frequency‐by‐frequency breakdown of the tasks 
and total estimated time to complete the procedure.

• Any procedure notes and task text (from the Tasks Information List). Please see “Tasks List” 
on page 149 for more information about the Tasks Information List.

Procedure Types List
Selecting Information Lists>Proce‐
dures & Tasks>Procedure Types 
opens the Procedure Types Infor‐
mation List. 

A procedure type classifies one or 
more individual procedures by 
overall function. You can create 
procedure types by trade (such a 
plumbing, electrical, etc.) or by 
work function (inspection, preven‐
tive maintenance, repair, etc.) to 
suit your organization’s needs.

The Procedure Types Information 
List contains the following informa‐
tion for each record:

• Procedure Type: Name of the procedure type.

• Active: Whether or not the procedure type is active.

• Notes: Additional information about the procedure type.
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Tasks List
Selecting Information Lists>Proce‐
dures & Tasks>Tasks opens the 
Tasks Information List. 

In general, a task is an individual 
work function such as, “Test lead 
input voltage.” A task might be as 
simple as a visual exterior inspec‐
tion or as complicated as a vibration 
test performed on a set of bearings.

Procedures group individual tasks 
into a complete maintenance job 
that is used when working on 
scheduled preventive maintenance 
work orders. Please see “Proce‐
dures List” on page 146 for more 
information about procedures.

The Tasks Information List contains the following information for each record:

• Name: Name of the task.

• Active: Whether or not the task is active.

• Type: Type of the task. This field uses values from the Task Types Information List, which is 
described in “Task Types List” on page 150.

• Control: Tasks associated with control or that interface with medTester or other equipment 
testers.

• Task #: Number of the task. This number must be unique for each HEMS task.

• Min Task Value: Lowest allowable result of this task. For example, the minimum allowable 
voltage might be 12.5V. Values below this limit indicate that the equipment may need repair.

• Max Task Value: Highest allowable result of this task. For example, the maximum allowable 
voltage might be 13.2V. Values above this limit indicate that the equipment may need repair

• Estimated Hours: Estimated amount of time, in hours and tenths, that the task should take to 
accomplish. The sum of all task times will be entered into work orders for workload monitor‐
ing and reporting.

• Task Text: Full explanation of how to accomplish the task. You may enter predefined text into 
this field, as described in “Using Predefined Text” on page 50.  

Note: You may list any special tool(s) required to accomplish this task (such as a 
voltmeter) as a reminder to the mechanic or technician.
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Task Types List
Selecting Information Lists>Proce‐
dures & Tasks>Task Types opens 
the Task Types Information List. 

A task type classifies one or more 
individual tasks by overall function. 
You can create task types by trade 
(such a plumbing, electrical, etc.) or 
by work function (inspection, pre‐
ventive maintenance, repair, etc.) 
to suit your organization’s needs.

The Task Types Information List 
contains the following information 
for each record:

• Task Type: Name of the task 
type.

• Active: Whether or not the task type is active.

• Notes: Additional information about the task type.

Purchase Orders List
Selecting Information Lists>Pur‐
chase Orders opens the Purchase 
Orders Information List. 

The Purchase Orders Information 
List tracks purchase order numbers 
and their descriptions and is pri‐
marily used in equipment inventory 
and work orders. 

The Purchase Orders Information 
List contains the following informa‐
tion for each record:

• Shared: Whether or not the 
purchase order is shared across 
Service Areas.

• PO #: Number of the purchase order.

• Active: Whether or not the purchase order is active.

• Description: Description of the purchase order.

• Notes: Additional information about the purchase order.

AUTHORED BY ANTHONY HERNANDEZ - (415)786-2081 - anthony94122@outlook.com
150 January 2010 - Revision 1.0



HEMS Enterprise 5.x User & Administrator Guide
Seasons List
Selecting Information Lists>Sea‐
sons opens the Seasons Informa‐
tion List. 

The Seasons Information List allows 
scheduled work orders to be gener‐
ated only within a specific date 
range. For example:

• Cooling Season (April 15 
through October 14) – A 
monthly work order might be 
generated, using this season, to 
change a filter in a window air 
conditioning unit, which is not 
required at any other time of 
the year.

• Heating Season (October 15 through April 14) – A monthly work order might be generated, 
using this season, to check the water level in a steam boiler.

The Seasons Information List contains the following information for each record:

• Shared: Whether or not the season is shared across Service Areas.

• Season: Name of the season.

• Active: Whether or not the season is active.

• Start Date: Date on which the season begins each year.

• End Date: Date on which the season ends each year.

• Notes: Additional information about the season.
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Shifts List
Selecting Information Lists>Shifts 
opens the Shifts Information List.

The Shifts Information List defines 
work shifts and department shifts 
(hours of operation).

The Shifts Information List contains 
the following detailed information 
about each designated work shift:

• Shared: Whether or not the 
shift is shared across Service 
Areas.

• Name: Name of the shift.

• Active: Whether or not the shift 
is active.

• Days: These seven checkboxes correspond to the days of the week. A checked checkbox indi‐
cates that the shift is scheduled to work that day.

• Start Time: Shift start time in military (24‐hour) format. For example, if the shift starts at 
2:00PM, enter 14:00.

• End Time: Shift end time in military (24‐hour) format. For example, if the shift ends at 
10:00PM, enter 22:00.

• Notes: Additional information about the shift.

Subcodes List
Selecting Information Lists>Sub‐
codes opens the Subcodes Informa‐
tion List. 

The Subcodes Information List con‐
tains additional tracking informa‐
tion. For preventive maintenance 
work orders, this documents the 
outcome (such as “PM Successful”), 
as described in “Preventive Mainte‐
nance (WO Type = Scheduled)” on 
page 56. For corrective work 
orders, this field documents the 
cause (such as “Failure”), as 
described in “Corrective Mainte‐
nance (WO Type=Routine, Failure, 
etc.)” on page 57.
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The Subcodes Information List contains the following information for each record:

• Shared: Whether or not the subcode is shared across Service Areas.

• Name: Name of the subcode.

• Active: Whether or not the subcode is active.

• Description: Describes the subcode.

• Notes: Additional information about the subcode.

This Information list has the following built‐in system values:

• Abuse/Physical Damage

• Device in Use

• Not Found

• Operator Error

• PM Failure

• PM Successful

• Unable to Locate

• None

Vendors List
Selecting Information Lists>Ven‐
dors opens the Vendors Informa‐
tion List. 

The Vendors Information List 
includes all equipment suppliers 
and manufacturers used by the bio‐
medical/maintenance department 
in their day‐to‐day activities. It pro‐
vides a convenient single source for 
all vendor contact information and 
also facilitates purchasing and man‐
agement.

The Vendors Information List con‐
tains the following information for 
each record:
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• Vendor Type: The following checkboxes indicate the vendor type:

‐ Supplier: Checking the Supplier checkbox indicates that the vendor supplies (but does 
not necessarily manufacture) equipment.

‐ Manufacturer: Checking the Manufacturer checkbox indicates that the vendor manufac‐
tures (but does not necessarily supply) equipment.

• Active: Whether or not the vendor is active.

• Name: Name of the vendor. Be sure to standardize your vendor list to avoid variant spelling 
and abbreviations for the same vendor (such as “GE”, “Gen Elec”, or “General Electric”), for 
ease of look‐up and reporting.

• Type: Vendor types categorize vendors for quick look‐up and filtering.

• Address/City/State/Zip: Vendor’s complete street, city, state, and ZIP code.

• Phone: Vendors’s primary phone number.

• Phone 2: Vendor’s secondary phone number.

• Fax: Vendor’s fax number.

• Beeper: Vendor’s pager/beeper number.

• Email: Vendor’s email address.

• ECRI#: Emergency Care Research Institute (ECRI) manufacturer number assigned to the ven‐
dor.

• ECRI Name: ECRI manufacturer name of the vendor.

• Notes: Additional information about the vendor.

Note: It is possible for a vendor to both manufacture and supply equipment. In 
this case, check both checkboxes for that vendor. 

Note: Entering the manufacturer’s ECRI # and name from ECRI's Universal Med‐
ical Device Nomenclature System (UMDNS) in the ECRI # and Name fields 
allows Biomedical Engineering staff to efficiently open and respond to work 
orders for device recall and alerts. 
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Work Order Lists
Opening, tracking, closing, and documenting work orders is another crucial HEMS function. The 
combination of work order code and types uniquely identifies the characteristics of each work 
order. Carefully setting up these Information Lists can help you monitor, track, and report on 
workload, equipment reliability, time spent on one or multiple work orders, types of work per‐
formed, etc.

Work Order Codes List
Selecting Information Lists>Work 
Order Lists>Work Order Codes 
opens the Work Order Codes Infor‐
mation List. 

The Work Order Codes Information 
List adds additional labor informa‐
tion to the work order such as 
Locating Equipment, Wait Time, 
Travel Time, etc.

The Work Order Codes Information 
List contains the following informa‐
tion for each record:

• Shared: Whether or not the 
work order code is shared 
across Service Areas.

• Code Name: Name of the work order code.

• Active: Whether or not the work order code is active.

• Notes: Additional information about the work order code.

This Information list has the following fixed system values:

• Callback After Hours

• Incoming Inspection

• Locating Equipment

• Overtime

• PM

• Travel Time

• Wait Time

• Not Found

• None
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Work Order Priorities List
Selecting Information Lists>Work 
Order Lists>Work Order Priorities 
opens the Work Order Priorities 
Information List. 

The Work Order Priorities Informa‐
tion List allows department manag‐
ers to review open work orders and 
determine:

• The importance of the work 
order. 

• Whether the work order can be 
delayed.

The Work Order Priorities Informa‐
tion List contains the following 
information for each record:

• Shared: Whether or not the work order priority is shared across Service Areas.

• Priority Name: Name of the work order priority.

• Active: Whether or not the work order priority is active.

• Weight: How much the work order priority affects overall work order prioritization.

• Response Time: Time within which work orders opened with this priority must be responded 
to by a technician.

• Close Time: Time within which work orders opened with this priority must be resolved and 
closed by a technician.

• Notes: Additional information about the work order priority.

This Information list has the following fixed system values:

• Low

• Standard

• High

• Not Found

• None
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Work Order Status List
Selecting Information Lists>Work 
Order Lists>Work Order Status 
opens the Work Order Status Infor‐
mation List. 

The Work Order Status Information 
List allows department managers to 
review open work orders and deter‐
mine:

• The workload for a particular 
group.

• What is delaying a job.

• How to determine staffing 
needs.

The Work Order Status Information List contains the following information for each record:

• Shared: Whether or not the work order status is shared across Service Areas.

• Status: Name of the work order status.

• Active: Whether or not the work order status is active.

• Not Pending: Checking the Not Pending checkbox indicates that work orders with the status 
are considered closed. This is important for searching, filtering and reporting on pending vs. 
closed work orders. HEMS considers work orders pending when they have any status except 
Closed.

• Notes: Additional information about the work order status.

This Information list has the following fixed system values:

• Open

• Closed

• Awaiting Parts

• Device in Use

• Hold

• Schedule Conflict

• Unable to Locate

• Unfinished

• Not Found
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Work Order Types List
Selecting Information Lists>Work 
Order Lists>Work Order Types 
opens the Work Order Types Infor‐
mation List. 

The Work Order Types Information 
List classifies work orders in a pre‐
determined manner for tracking 
and regulatory management.

The Work Order Types Information 
List contains the following informa‐
tion for each record:

• Shared: Whether or not the 
work order status is shared 
across Service Areas.

• WO Type: Name of the work order type.

• Active: Whether or not the work order type is active.

• Notes: Additional information about the work order type.

This Information list has the following fixed system values:

• Scheduled

• Routine

• Education

• Failure

• Hazard

• Incoming Inspection

• MDSR (Medical Device Safety Report)

• Miscellaneous

• Project

• Recall/Alert

• Retired

• Web Assigned

• Not Found
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Working with Information Lists
Information Lists are the foundation of the HEMS database because they contain the records of 
the various departments, locations, employees, equipment, etc. in your organization.

Information List Windows
Selecting an Information 
List from the Information 
Lists menu opens a win‐
dow for the selected 
Information List. The 
name and contents of 
each window depends on 
the Information List you 
selected, but all Informa‐
tion List windows contain 
the following functional 
areas:

• Search Area: Allows 
you to search for records in the selected Information List. This image shows an example of a 
Find mode search area. The actual search options available will depend on the Information 
List you are working with.

• Report/Print Buttons: Allow you to run reports and print/export data. Please see “CHAPTER 
12: Printing & Exporting Data” on page 233 for more information about printing and export‐
ing data in HEMS.

• Search Mode Buttons: Switch between Find and Filter modes, and display records added 
during the current HEMS session.

• Results Area: Search results appear here.

• Details Area: Displays the currently selected Information List record.

Search Area (Find Mode)
When the Information List window is in Find mode (shown above), the Search Area contains var‐
ious fields depending on the selected Information List. By default, entering one or more letters in 
one or more of the search fields returns results that begin with the text you entered. For exam‐
ple, entering “def” will return “defibrillator.”

Entering values in multiple search field restricts results to values that match all of the search 
terms in all of the fields. For example, entering “def” in the EQ Type field and “phi” in the Manu‐
facturer field would return defibrillators manufactured by Philips but not defibrillators from dif‐
ferent manufacturers.

Search 
Area

Report/
Print 

Buttons

Results 
Area

Search
Mode

Buttons

Details 
Area
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Checking the Exact checkbox returns only those results that contain the exact text you entered. If 
you select this option, then entering “def” will not return “defibrillator” because the two are not 
an exact match.

Enter your desired search terms and then click Search to return matching results, or Reset to 
clear the Search Area and begin a new search.

Please see “The Find Function” on page 221 for more information on using Find mode.

Search Area (Filter Mode)
When the Information List window is in Filter mode (not shown), the Search Area contains a list 
of selected filter conditions. Please see “Filters” on page 222 for more information about using 
filters.

Report/Print Buttons
The Report/Print buttons provide quick access to relevant reports. From the left to right, the 
buttons are:

• List Report: Clicking the List Report button opens a summary report that lists all of the 
records in the current Information List. For example, if you are in the Equipment Models 
Information List, then this button will display a summary of all equipment models.

• Detail Report ‐ All: Clicking the Detail Report ‐ All button opens a report that provides 
detailed information about each of the records in the current Information List.

• Detail Report ‐ Current: Selecting an item in the Results Area and then clicking the Detail 
Report ‐ Current button opens a report that provides detailed information about the cur‐
rently selected Information List record.

Reports appear in a separate browser window. You can print and/or export these reports, as 
described in “CHAPTER 12: Printing & Exporting Data” on page 233.

Search Mode Buttons
The Search Mode buttons determine how Information List records will be retrieved. From left to 
right, the buttons are:

• Show Newly Added Items: If the Show Newly Added Items button is active, clicking it will 
display items added during your current HEMS session (from the time you logged into HEMS). 
Exiting HEMS ends your session. Clicking this button again returns you to normal Search 
mode.

• Switch to Filter mode: When the Information List window is in Find mode, the Switch to Fil‐
ter mode button appears as a small funnel. Clicking this button switches the Search Area to 
Filter mode. Please see “Filters” on page 222 for more information on using filters.

• Switch to Find mode: When the Information List window s in Filter mode, the Switch to Find 
mode button appears as a small magnifying glass. Clicking this button switches the Search 
Area to Find mode. Please see “The Find Function” on page 221 for more information on 
using Find mode.

AUTHORED BY ANTHONY HERNANDEZ - (415)786-2081 - anthony94122@outlook.com
160 January 2010 - Revision 1.0



HEMS Enterprise 5.x User & Administrator Guide
Details Area
The Details Area displays the information contained in the selected Information List record.

Adding a Record
This section describes how to add records to HEMS Information Lists. Most Information Lists use 
the general instructions. The Equipment Models, Equipment Types, Equipment Groups, and 
Procedures Information Lists have additional instructions that must be followed when adding 
records to these Information Lists. Please see:

• “Adding Equipment Models” on page 161 for information on adding equipment models.

• “Adding Equipment Types” on page 163 for information on adding equipment types.

• “Adding Equipment Groups” on page 164 for information on adding equipment groups.

• “Adding Procedures” on page 165 for information on adding procedures.

Adding Information List Records
To add a record to an Information List:

1. Select the correct Information List using the Information Lists menu.

2. EIther click the New button in the Toolbar or press [CTRL]+[N].

3. Enter all of the required information for the record you are creating in the appropriate fields.

4. The Active checkbox is checked by default, making this record active.

5. Enter any additional information as appropriate for the Information List you are working in.

6. Either click the Save button in the Toolbar or press [CTRL]+[S] to save the new record.

For detailed information about the contents of each field, please refer to the instructions for the 
Information List you are working with.

Adding Equipment Models
To add a new equipment model:

1. Open the Equipment Models Information List. See “Equipment Models List” on page 131 for 
information about the Equipment Models Information List.

2. Follow Steps 2‐5, above.

Note: Don’t forget to add information to tabs within the Information List you 
are working with, if applicable. 
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3. In general, equipment is scheduled by type; however, you can schedule by model if needed 
(such as if a model has a different preventive maintenance procedure, interval, or assigned 
engineer). To add a preventive maintenance interval, go to the Schedule tab, check the 
Schedule Template checkbox, and then click the New button to open the Schedule Fre‐
quency window. Please see “The Schedule Frequency Window” on page 97 for information 
about using the Schedule Frequency window.

4. In general, risk is assigned by type, but you can also assign risk by model if needed. Enter risk 
information, if any, using the Other Details tab. Please see “CHAPTER 8: Managing Risk” on 
page 179 for more information about managing risk in HEMS.

5. Go to the Parts tab, and then 
click the Update Part Informa‐
tion button to open the Select 
the parts to be added window.

6. Search for the parts you want to 
add using the Search Area.

7. Select the part record(s) to add 
to the equipment model in the 
Search Results Area and then 
move that information to the 
Selection Area using the follow‐
ing Selection buttons:

‐ Clicking the >> button 
moves all of the records in 
the Search Result Area to 
the Selection Area.

‐ Clicking the > button moves 
the currently selected 
record in the Search Result Area to the Selection Area.

‐ Clicking the < button removes the currently selected record from the Selection Area back 
to the Search Results Area.

‐ Clicking the << button removes all of the records in the Selection Area back to the Search 
Results Area.

8. Click OK to close the Select Parts window and return to the Equipment Models Information 
List with your selections added to the model you are adding.

9. If needed, go to the Attachments tab to attach documents (such as manuals) and/or scan 
images from a local scanner to the equipment model. Attachments added to equipment 
types and models appear as attachments in individual equipment item records of the same 
model or type.

10. Either click the Save button in the Toolbar or press [CTRL]+[S] to save the new equipment 
model record.

Search Area

Search Results Area Selection Area
Selection Buttons
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Adding Equipment Types
To add a new equipment type:

1. Open the Equipment Types Information List. See “Equipment Types List” on page 134 for 
information about the Equipment Types Information List.

2. Follow Steps 2‐5 of the General procedure on page 161.

3. In general, equipment is scheduled by type. To add a preventive maintenance interval to the 
type you are adding, go to the Schedule tab, check the Schedule Template checkbox, and 
then click the New button to open the Schedule Frequency window. Please see “The Sched‐
ule Frequency Window” on page 166 for information about using the Schedule Frequency 
window.

4. Enter risk information, if any, using the Other Details tab. Please see “Equipment Types List” 
on page 134. 

5. If needed, go to the Attachments tab to attach documents (such as manuals) and/or scan 
images from a local scanner to the equipment type. Attachments added to equipment types 
and models appear as attachments in individual equipment item records of the same model 
or type.

6. Either click the Save button in the Toolbar or press [CTRL]+[S] to save the new equipment 
type record.
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Adding Equipment Groups
To add a new equipment group:

1. Open the Equipment Groups Information List. See “Equipment Groups List” on page 137 for 
information about the Equipment Groups Information List.

2. Follow Steps 2‐5 of the General procedure on page “Adding a Record” on page 161.

3. Go to the Equipment tab, and 
then click the Update Equip‐
ment Information button to 
open the Select Equipment 
window.

4. Search for the equipment you 
want to add using the Search 
Area.

5. Select the equipment item(s) to 
add to the equipment group in 
the Search Results Area and 
then move that information to 
the Selection Area using the fol‐
lowing Selection buttons:

‐ Clicking the >> button 
moves all of the records in 
the Search Result Area to 
the Selection Area.

‐ Clicking the > button moves the currently selected record in the Search Result Area to the 
Selection Area.

‐ Clicking the < button removes the currently selected record from the Selection Area back 
to the Search Results Area.

‐ Clicking the << button removes all of the records in the Selection Area back to the Search 
Results Area.

6. Add a schedule date and define the preventive maintenance template by checking the 
Schedule button to access the Schedule tab. Enter the PM Procedure and Assigned Engineer. 
To define the schedule interval, go to the Schedule tab and either click the New button or 
double‐click a frequency to open the Schedule Frequency window. Please see “The Schedule 
Frequency Window” on page 97 for information about using the Schedule Frequency win‐
dow.

7. Click OK to close the Select Equipment window and return to the Equipment Groups Infor‐
mation List with your selections added to the model you are creating.

8. Either click the Save button in the Toolbar or press [CTRL]+[S] to save the new equipment 
group record. 

Search Area

Search Results Area Selection Area
Selection Buttons
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Adding Procedures
To add a new procedure:

1. Open the Procedures Information List. See “Procedures List” on page 146 for information 
about the Procedures Information List.

2. Follow Steps 2‐5 of the General procedure on page “Adding a Record” on page 161.

3. If desired, add a schedule frequency by checking the New button next to the Schedule Fre‐
quency checkbox to open the Schedule Frequency window. Please see “The Schedule Fre‐
quency Window” on page 166 for information about using the Schedule Frequency window.

4. Go to the Tasks tab, and then 
click the Update Task Informa‐
tion button to open the Select 
the tasks to be added window.

5. Search for the task you want to 
add using the Search Area.

6. Select the task record(s) to add 
to the procedure in the Search 
Results Area and verify that you 
have selected the correct task 
by reading its description in the 
Task Description field.

7. Move the selected task to the 
Selection Area using the follow‐
ing Selection buttons:

‐ Clicking the >> button 
moves all of the records in 
the Search Results Area to 
the Selection Area.

‐ Clicking the > button moves the currently selected record in the Search Result Area to the 
Selection Area.

‐ Clicking the < button removes the currently selected record from the Selection Area back 
to the Search Results Area.

‐ Clicking the << button removes all of the records in the Selection Area back to the Search 
Results Area.

8. For each selected task, use the Frequency pull‐down menu to select the interval for that task. 
The available frequencies will be those you created in Step 3, above.

Note: EQ2 supports and will integrate any of the standard equipment nomen‐
clatures (ASHE, AAMI, or ECRI) and procedures to your standardization process. 
Please contact EQ2 directly for information and a quote for standardizing pro‐
cesses for existing data.

Search Area

Search Results Area Selection Area
Selection Buttons
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9. Arrange the tasks into the correct procedural order by selecting the task to move and then 
using the Reorder buttons:

‐ Clicking the double up‐arrow button moves the selected task to the top of the list of tasks 
in the Selection Area to indicate that it should be performed first.

‐ Clicking the single up‐arrow button moves the selected task up one position in the list of 
tasks in the Selection Area to indicate that it should be performed earlier.

‐ Clicking the single down‐arrow button moves the selected task down one position in the 
list of tasks in the Selection Area to indicate that it should be performed later.

‐ Clicking the double down‐arrow button moves the selected task to the bottom of the list 
of tasks in the Selection Area to indicate that it should be performed last.

10. Verify that you have selected the correct tasks and arranged them in the correct order.

11. Click Apply to close the Select Tasks window and return to the Procedures Information List 
with tasks added to the procedure you are creating.

12. Check the Print Task Description checkbox if you want the contents of the Description tab to 
print on work orders (recommended).

13. Either click the Save button in the Toolbar or press [CTRL]+[S] to save the new procedure 
record.

The Schedule Frequency Window
The Schedule Frequency window is used to create, edit, or delete 
schedule frequencies in the Equipment Models, Equipment 
Types, Equipment Groups, and Procedures Information Lists. 
HEMS allows you to define preventive maintenance templates by 
equipment type, model, equipment item, or group. Please see 
“Scheduling Equipment” on page 107 for more information about 
scheduling equipment.

To add a schedule frequency:

1. Open the Schedule Frequency window as described for each Information List.

2. Select the correct interval by checking the appropriate Interval radio button.

3. If necessary, adjust the frequency using the Occurs Every pull‐down menu. For example, to 
schedule every 18 months, you would select Monthly and then Occurs Every 18.

4. Enter the number of estimated hours necessary to complete preventive maintenance for this 
interval in the Hours field.

5. Click OK to close the Schedule Frequency window and save your changes to the Information 
List you are currently working in.

CAUTION: IMPROPERLY DESIGNED PROCEDURES CAN CAUSE DAMAGE TO 
EQUIPMENT AND/OR REDUCED EQUIPMENT OPERATIONAL LIFE SPAN.
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Editing a Record
To edit an Information List record:

1. Select the correct Information List using the Information Lists menu.

2. Either click the Edit button in the Toolbar or press [CTRL]+[E].

3. Check or clear the Active checkbox, as appropriate. See “Activating/Deactivating Records” on 
page 167 for more information about active and inactive records.

4. Enter all of the updated information for the record you are editing in the appropriate fields, 
(including information in tabs, if applicable).

5. Either click the Save button in the Toolbar or press [CTRL]+[S] to save the edited record.

For detailed information about the contents of each field, please refer to the instructions for the 
Information List you are working with.

Copying a Record
To save time, you may create a copy of an existing Information List record and then edit the copy. 
This is useful when you need two records that share some identical information. To copy an exist‐
ing Information List record:

1. Select the correct Information List using the Information Lists menu.

2. Find the record you want to copy using the Search function. Please see “CHAPTER 11: Finding 
Data” on page 219 for more information about searching for Information List records.

3. Either click the Copy button in the Toolbar or press [CTRL]+[K].

4. Edit the appropriate fields to reflect the correct information for the new record, being sure 
not to forget about information in tabs, if applicable.

5. Either click the Save button in the Toolbar or press [CTRL]+[S] to save the new record.

Activating/Deactivating Records
Each record in the HEMS Information Lists includes a checkbox labeled Active. This checkbox is 
checked by default when you create a new record.

Information List records cannot be deleted from HEMS if they have been used in equipment 
inventory or work orders because this information is part of your maintenance history. You can, 
however, deactivate records that are no longer used by clearing the desired record’s Active 
checkbox.

You can also determine whether or not to display inactive records by selecting Utilities>Manage‐
ment Tools>Service Area Configuration and either checking or clearing the Show only active 
items in the lists checkbox.

Please see “Service Area Configuration” on page 263 for more information about configuring Ser‐
vice Areas.
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Attaching or Scanning Files
The Equipment Models and Equipment Types Information Lists include an Attachments tab that 
allows you to attach documents and/or images related to the current record. Attachments added 
to the Equipment Models and/or Equipment Types Information Lists are available in the equip‐
ment inventory for equipment items of that model or type. Similarly, attachments in the Equip‐
ment Type Information List will appear in equipment model records under the same equipment 
type.

• To add an attachment, select Attach to open a standard Windows dialog that allows you to 
select the file name, type, and location to attach. HEMS supports the DOC, GIF, ICON, JPEG, 
PDF, TXT, XLS, and ZIP formats.

• To scan an image from a local scanner, select Scan to open a standard Windows dialog that 
allows you to scan and name the file. Click OK to scan the file.

• To delete an attached or scanned file, select the item to delete and then click the Delete but‐
ton. You are prompted to confirm your decision.

Note: To attach a file in a format that HEMS does not support, ZIP the file and 
then attach the ZIP file to the desired record.
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Managing Parts
HEMS can track parts and supplies to make sure that you have enough on hand to perform 
scheduled maintenance on equipment. Assigning parts to equipment allows HEMS to maintain 
your parts inventory and know when to order parts. You can also manage your parts budget.

Parts Inventory Window
Selecting Activities>Parts>Part Inventory or clicking the Parts button in the Home screen opens 
the Parts Inventory window.

The Parts Inventory window contains the following functional areas:

• Search Area: Allows you to search for part records.

• Report Buttons: Allow you to run reports and access the HEMS print and export functions.

• Search Mode Buttons: Switch between Find and Filter modes, and display newly added part 
records.

• Search Results Area: Search results appear here.

• Details Area: Displays the currently selected part record.

Search Area (Find Mode)
When the Parts Inventory window is in Find mode (shown above), the Search Area allows you to 
search for parts by part #, active, part type, manufacturer, model # or control #. By default, enter‐
ing one or more letters in one or more of the search fields returns results that begin with the text 
you entered. For example, entering “bat” will return “battery.”
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Entering values in multiple search field restricts results to values that match all of the search 
terms in all of the fields. For example, entering “fuse” in the Part Type field and “Acme” in the 
Manufacturer field would return fuses manufactured by Acme but not fuses from different man‐
ufacturers.

Checking the Exact checkbox forces HEMS to return only those results that contain the exact text 
you entered. If you select this option, then entering “bat” will not return “battery” because the 
two are not an exact match.

Enter your desired search terms and then click Search to return matching results, or Reset to 
clear the Search Area and begin a new search.

Please see “The Find Function” on page 221 for more information on using Find mode.

Search Area (Filter Mode)
When the Parts Inventory window is in Filter mode (not shown), the Search Area contains a list 
of selected filter conditions. Please see “Filters” on page 222 for more information about using 
filters.

Report/Print Buttons
The Report buttons provide quick access to relevant reports. From the left to right, the buttons 
are:

• List Report: Clicking the List Report button opens a summary report that lists all of the parts 
records in HEMS.

• Detail Report ‐ All: Clicking the Detail Report ‐ All button opens a report that provides 
detailed information about each of the part records in HEMS.

• Detail Report ‐ Current: Selecting an item in the Results Area and then clicking the Detail 
Report ‐ Current button opens a report that provides detailed information about the cur‐
rently selected part record.

Reports appear in a separate browser window. You can print and/or export these reports, as 
described in “CHAPTER 12: Printing & Exporting Data” on page 233.

Search Mode Buttons
The Search Mode buttons determine how part records will be retrieved. From left to right, the 
buttons are:

• Show Newly Added Items: If the Show Newly Added Items button is active, clicking it will 
display part records added during your current HEMS session. Exiting HEMS ends your ses‐
sion.

• Switch to Filter mode: When the Parts Inventory window is in Find mode, the Switch to Fil‐
ter mode button appears as a small funnel. Clicking this button switches the Search Area to 
Filter mode. Please see “Filters” on page 222 for more information on using filters.
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• Switch to Find mode: When the Parts Inventory window s in Filter mode, the Switch to Find 
mode button appears as a small magnifying glass. Clicking this button switches the Search 
Area to Find mode. Please see “The Find Function” on page 221 for more information on 
using Find mode.

Details Area
The Details Area displays the following information for the selected part record:

• Part #: HEMS part number. This number is unique for each part entered in HEMS.

• Active: Whether or not the part record is active.

• Manufacturer Part #: Number assigned by the manufacturer to the part.

• Manufacturer: Manufacturer that makes the part.

• Part Type: Type of part.

• Description: Description of the part.

• Location: Where the part is located.

• Units: How the part is measured (such as each, dozen, pounds, etc.).

• Notes: Additional information about the part.

• Standard Price: How much the part usually sells for.

• On Hand: How many of the part you have on hand, a defined by your minimum quantity. 
HEMS defaults to 1.

• Last Price: Most recent price paid for the part.

• Order Quantity: How many of the part you need to purchase at once, measured in your 
selected units. This is based on the defined minimum quantity.

• Markup: Percentage used to specify the normal overhead for the Service Area and calculate 
the part’s total cost. For example, if the last price of the part was $3.00 and the markup is 
10%, then the part cost is $3.30.

• Min Quantity: Minimum number of units of this part that you should have on hand at all 
times.

• Cost of Order: How much the most recent order cost for this part.

The Parts Inventory window also has four Transaction buttons that let you adjust your inventory 
as needed. These buttons are:

• Add Receive: Record receiving a shipment of the part.

• Adjust +: Add to your inventory of the part (such as if you discover more of this part in your 
warehouse).

• Adjust ‐: Subtract from your inventory of the part (such as in case of loss, spoilage, etc.).

• Transactions: Opens the Parts Transaction History window.
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Please see “Part Transactions” on page 174 for more information about the Parts Transactions 
window. and “The Parts Transaction History Window” on page 176 for more information about 
the Parts Transaction History window.

Adding a Part
To add a part record to HEMS:

1. Select Activities>Parts>Parts Inventory to open the Parts Inventory window.

2. EIther click the New button in the Toolbar or press [CTRL]+[N].

3. By default, the Active checkbox is checked. See “Active/Inactive Parts” on page 174 for more 
information about active and inactive part records.

4. Enter the requested information.

5. Either click the Save button in the Toolbar or press [CTRL]+[S] to save the new part record.

Copying a Part
To save time, you may create a copy of an existing part record and then edit the copy. This is use‐
ful when you need two records that share some identical information. To copy an existing Infor‐
mation List record:

1. Select Activities>Parts>Parts Inventory to open the Parts Inventory window.

2. Find the record you want to copy using the Search function. Please see “Search Area (Find 
Mode)” on page 170 for more information about searching for part records.

3. Either click the Copy button in the Toolbar or press [CTRL]+[K].

4. Edit the appropriate fields to reflect the correct information for the new part record.

5. Either click the Save button in the Toolbar or press [CTRL]+[S] to save the new part record.

Editing a Part
To edit a part record:

1. Select Activities>Parts>Parts Inventory to open the Parts Inventory window.

2. Either click the Edit button in the Toolbar or press [CTRL]+[E].

3. Check or clear the Active checkbox, as appropriate. See “Active/Inactive Parts” on page 174 
for more information about active and deactivated part records.

4. Enter all of the updated information for the part record you are editing in the appropriate 
fields.

5. Either click the Save button in the Toolbar or press [CTRL]+[S] to save the edited part record.
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Active/Inactive Parts
Each part record HEMS includes a checkbox labeled Active. This checkbox is checked by default 
when you create a new part record.

Parts that have been used in HEMS cannot be deleted because they are part of your history. You 
can, however, deactivate part records that are no longer used. In this example, you can edit the 
part record by clearing its Active checkbox.

You can also determine whether or not inactive part records can be included in newly created or 
edited equipment inventory or work order records by selecting Utilities>Management 
Tools>Service Area Configuration and either checking or clearing the Show only active items in 
the lists checkbox.

Please see “Service Area Configuration” on page 263 for more information about configuring Ser‐
vice Areas.

Part Transactions
A part transaction occurs when you receive a shipment or otherwise add or remove parts from 
your inventory. There are two basic transaction types:

• Receive: A receive transaction occurs when you get a shipment or when you add parts to 
your inventory (such as if you discover parts that had previously gone missing). You will gen‐
erally enter receive transactions and let HEMS automatically subtract parts from your inven‐
tory as they are consumed during equipment maintenance and repair.

• Use: HEMS automatically tracks part consumption. You can also use this transaction type to 
reconcile any discrepancy between the inventory in HEMS and your actual parts on hand.

Record parts transactions in HEMS using the Parts Transactions window, which you can open by 
either:

• Searching for the part in the Parts Inventory window and clicking one of the Transaction but‐
tons, or

• Selecting Activities>Parts>Parts Transactions.

The Parts Transactions window varies depending on which method you use to open it.
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The Part Transactions Window (Standalone)
To record a part transaction directly into the Parts Transactions window:

1. Select Activities>Parts>Parts 
Transactions to open the Parts 
Transactions window.

2. Search for the part using the 
Search Area, which is described 
in “Search Area (Find Mode)” 
on page 170 and “Search Area 
(Filter Mode)” on page 171.

3. Select the part for which you 
are recording the transaction in 
the Search Results Area to open 
that part’s information in the 
Details are.

4. Either click New in the Toolbar 
or press [CTRL]+[N].

5. The Part #, Manufacturer’s Part #, Manufacturer, Standard Price, Last Price, Markup, and 
On Hand information appears automatically. Edit this information as appropriate, if needed.

6. Enter the following transaction information:

‐ Transaction Type: Select Receive or Use, as appropriate.

‐ Transaction Date: Date of the transaction.

‐ PO #: Purchase order number (if any) using the PO# field.

‐ Manufacturer: Company that makes/produces the part. This field is automatically filled 
with the value contained in the Parts Inventory List, if any. Otherwise, you may select the 
part manufacturer.

‐ Supplier: Vendor who supplies the part (may or many not be the manufacturer).

‐ Quantity: How many parts are included in this transaction.

‐ Unit: How parts are measured. This field is automatically filled with the value contained 
in the Parts Inventory List.

‐ Unit Price: How much each part measure costs.

‐ Catalog #: The supplier’s catalog number for the part.

‐ Markup: Percentage used to specify the normal overhead for the Service Area and calcu‐
late the part’s total cot. For example, if the last price of the part was $3.00 and the 
markup is 10%, then the part cost is $3.30.

‐ Storage Location: Where the parts are being stored.

‐ Storage Notes: Any additional information about where the parts are being stored.
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‐ Notes: Other information about the part transaction.

7. Either click the Save button in the Toolbar or press [CTRL]+[S] to save the part transaction to 
the part record.

The Parts Transactions Window (from Inventory)
Clicking one of the four Transaction buttons in the 
Parts Inventory window opens the Parts Transac‐
tions window. This version of the window does not 
include the Search and Search Results Area 
because you have already selected the part.

Follow Steps 5‐7 of the above procedure to enter a 
transaction for the current part.

The Parts Transaction History 
Window

Clicking the Transactions button in 
the Parts Inventory window opens 
the Parts Transaction History win‐
dow, which allows you to view and 
edit transactions for the current 
part.

Editing Parts Transactions
To edit a part transaction:

1. Open the Parts Transactions 
window for the current transac‐
tion by either:

‐ Selecting the desired trans‐
action in the list and then 
clicking the Edit button.

‐ Double‐clicking the transaction listing.

2. The Parts Transaction window appears with the most recent information for the selected 
transaction. Make any needed changes (see “The Part Transactions Window (Standalone)” on 
page 175) and then click the Save button in the Toolbar to save your changes.

Note: The Transaction Type is 
already selected based on the 
Transaction button you clicked in 
the Parts Inventory window. 
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Part Transaction Reports
1. To run a part transaction report from the Parts Transaction History window:

2. Select the report type you want to run by checking the appropriate radio button. Your avail‐
able options are:

‐ Single Line (List) Report: Checking the Single Line (List) Report radio button opens a sum‐
mary report that lists all of the parts records in HEMS.

‐ Detail Report ‐ Current: Checking the Detail Report ‐ Current radio button opens a report 
that provides detailed information about the current part record.

‐ Detail Report ‐ All: Checking the Detail Report ‐ All radio button opens a report that pro‐
vides detailed information about each of the part records in HEMS.

3. Click the Preview button to run the report. Reports appear in a separate browser window. 
You may print reports, as described in “CHAPTER 12: Printing & Exporting Data” on page 233.

Closing the Parts Transaction History Window
Click the Back button to close the Parts Transaction History window and return to the Parts 
Inventory window.

Scheduling Parts
HEMS allows you to schedule parts for ongoing inventory and cost tracking. Please see “Schedul‐
ing Equipment” on page 107 for more information about scheduling equipment and parts.

Scheduling Parts by Equipment Model
To schedule parts by equipment model:

1. Add the part to the appropriate equipment model using the Parts tab of the Equipment 
Models Information List.

2. Schedule the part using the Schedule tab of the Equipment Models Information List.

Please see “Equipment Models List” on page 131 for more information about the Equipment 
Models Information List, and “Scheduling Parts” on page 109 for information about adding parts 
and schedules to equipment models.

Note: Parts that require multi‐year scheduling (such as battery replacement) 
will automatically be scheduled on a cycle based on the Seed Date for Multi 
Year date in the Schedule tab of the Equipment Inventory window. By default, 
this date is selected from either the Placed in Service date (if specified) or the 
equipment Purchase Date. You may manually enter a different date by checking 
the checkbox and entering a date, if needed.
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Scheduling Parts by Equipment Item
To schedule parts by equipment item (if additional parts are required for an equipment item 
besides those scheduled for the equipment model):

1. Add the part to the appropriate individual equipment item in the Parts tab of the Equipment 
Inventory window.

2. Schedule the part using the Schedule tab of the Equipment Inventory window. Please see 
“Parts Tab” on page 96 for more information about the equipment item Parts tab and 
“Schedule Tab” on page 93 for more information about the equipment item Schedule tab.

Please see the note on the previous page for information about multi‐year part scheduling.

Parts Reports
HEMS includes the following parts reports:

• Equipment with Parts: Please see “Equipment with Parts” on page 210 for more information 
about the Equipment with Parts report.

• PM Parts Due ‐ Shortage: Please see “PM Parts Due ‐ Shortage” on page 214 for more infor‐
mation about the PM Parts Due ‐ Shortage report.

• PM Parts Due: Please see “PM Parts Due” on page 215 for more information about the PM 
Parts Due report.

• Parts with Equipment: Please see “Parts with Equipment” on page 217 for more information 
about the Parts with Equipment report.
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Risk Assignment
Generally, risk is defined by equipment type, but you can also define risk by equipment model 
and item if required. HEMS uses risk assessment criteria defined by the American Society for 
Healthcare Engineering (ASHE) risk factor standards. HEMS can also set minimum maintenance 
schedule intervals based on risk factor. For example, a certain piece of equipment may be sched‐
uled for annual preventive maintenance but require semiannual maintenance because of its 
assigned risk factor. Contact EQ2 for more information, if needed.

Determining Risk Factors
Determining the risk score is as easy as selecting the appropriate statement for each risk cate‐
gory:

• Equipment Function: What the equipment is used for.

‐ Therapeutic ‐ Life support. (10 points)

‐ Therapeutic ‐ Surgery or intensive care. (9 points)

‐ Therapeutic ‐ Physical therapy or treatment. (8 points)

‐ Diagnostic ‐ Surgery/ICU monitoring. (7 points)

‐ Diagnostic ‐ Other physiological monitoring. (6 points)

‐ Analytical ‐ Lab analytical. (5 points)

‐ Analytical ‐ Lab accessories. (4 points)

‐ Analytical ‐ Computer‐related accessories. (3 points)

‐ Misc ‐ Patient related. (2 points)

‐ Misc ‐ Non patient related. (1 point)

• Clinical Application: How the equipment model impacts clinical functions.

‐ Has potential for patient death. (5 points)

‐ Has potential for patient injury. (4 points)

‐ Can cause inappropriate therapy/misdiagnosis. (3 points)

‐ Can cause equipment damage. (2 points)

‐ There is no significant identified risk. (1 points)

• PM Requirement: How often preventive maintenance needs to be performed.

‐ Preventive maintenance frequency is monthly. (5 points)

‐ Preventive maintenance frequency is quarterly. (4 points)

‐ Preventive maintenance frequency is semiannual. (3 points)

‐ Preventive maintenance frequency is annual. (2 points)
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‐ No frequency required. (1 point)

• Likelihood of Failure: How likely the equipment is to fail based on its Mean Time Between 
Failures (MTBF). This is a measure of equipment reliability.

‐ MTBF is less than 3 months. (5 points)

‐ MTBF is approximately 6 months. (4 points)

‐ MTBF is approximately 1 year. (3 points)

‐ MTBF is approximately 3 years. (2 points)

‐  MTBF is approximately 5 years. (1 point)

• Environment of Use: Where the equipment is used.

‐ Equipment is primarily used in anesthetizing locations. (5 points)

‐ Equipment is primarily used in critical care locations. (4 points)

‐ Equipment is primarily used in wet/lab/exam locations. (3 points)

‐ Equipment is primarily used in general care areas. (2 points)

‐ Equipment is primarily used in non‐patient areas. (1 point)

Each of the preceding risk category includes standard statements that are assigned points, which 
HEMS automatically calculates. Equipment with a score below 6 points is not included in the pre‐
ventive maintenance management program. Equipment with a score of 6 or more points is cate‐
gorized into priority levels depending on the total score. Please contact EQ2 if you need to set a 
default other than 6 points.

Please refer to the ASHE Maintenance Management for Medical Equipment for a full description 
of risk factors.

Defining Risk in HEMS
Risk is generally defined by equipment type. All equipment of that type inherits this information. 
HEMS also allows you to define risk by model or equipment item if necessary. If an equipment 
item has risk defined in more than one place (i.e. type, model, and/or equipment item), HEMS 
uses risk for that equipment item in the following precedence:

• Defining risk by equipment model overrides defining risk by equipment type.

• Defining risk by equipment item overrides defining risk by either equipment model or type. 

Note: Once risk is defined for equipment type or model, all new equipment 
items added to these types or models will have risk assigned automatically.
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Defining Risk by Equipment Type
To define risk by equipment type:

1. Select Information Lists>Equipment Inventory Lists>Equipment Types to open the Equip‐
ment Types Information List and then select the desired equipment type.

2. Select the Other Details tab and then check the Risk Assessment checkbox.

3. Answer each of the 5 risk assessment questions using the pull‐down menus. HEMS automati‐
cally calculates risk factor and displays that in the Risk Factor field.

4. Save your changes by either clicking the Save button in the Toolbar or by pressing [CTRL]+[S].

Defining Risk by Equipment Model
To define risk by equipment model, if required:

1. Select Information Lists>Equipment Inventory Lists>Equipment Models to open the Equip‐
ment Models Information List and then select the desired equipment model. 

2. Select the Other Details tab and then check the Risk Assessment checkbox.

3. Answer each of the 5 risk assessment questions using the pull‐down menus. HEMS automati‐
cally calculates risk factor and displays that in the Risk Factor field.

4. Save your changes by either clicking the Save button in the Toolbar or by pressing [CTRL]+[S].

Defining Risk by Equipment Item
To define risk by equipment item, if required for any exceptions where risk cannot be defined by 
type or model:

1. Select the desired equipment item in the Equipment Inventory dashboard and then click the 
Edit button to open the Equipment Inventory window. 

2. Select the Other Details tab and then check the Risk Assessment checkbox.

3. Answer each of the 5 risk assessment questions using the pull‐down menus. HEMS automati‐
cally calculates risk factor and displays that in the Risk Factor field.

4. Save your changes by either clicking the Save button in the Toolbar or by pressing [CTRL]+[S].

Risk Reports
HEMS includes the following risk reports:

• Risk Interval: Please see “Risk Interval” on page 216 for more information about the Risk 
Interval report.

• Risk Category: Please see “Risk Category” on page 216 for more information about the Risk 
Category report.
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The Contracts Window
The HEMS Contracts window contains service contract records. Each active service contract has 
its own record in the Contracts window.

Typically, a service contract is an arrangement with a vendor to provide maintenance services for 
a specific period of time on a designated inventory of equipment. The service contract can cover 
preventive maintenance, repair, parts, or any combination thereof. A service contract ensures 
that the service costs are capped at the cost of the contract. By contrast, a time and materials 
arrangement has no cost cap. All service including preventive maintenance, repair, and parts are 
paid out‐of‐pocket when service occurs.

Selecting Activities>Contracts opens the Contracts window, which allows you to view, add, edit, 
or remove service contract information. 

The Contracts window contains the following functional areas:

• Search Area: Allows you to search for service contract records.

• Report/Print Buttons: Allow you to run reports and print/export data. Please see “CHAPTER 
12: Printing & Exporting Data” on page 233 for more information about printing and export‐
ing data in HEMS.

Note: You may access contract history information for a specific equipment item 
by selecting an item in the Equipment Inventory dashboard and then pressing 
the C button to open the Equipment Contract History window. Please see “The 
Equipment Contract History Window” on page 104 for more information about 
the Equipment Contract History window.

Search Area

Search Results 
Area

Tabs

Report/Print 
Buttons

Search Mode 
Buttons
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• Search Mode Buttons: Switch between Find and Filter modes, and display newly added ser‐
vice contract records. Please see “CHAPTER 11: Finding Data” on page 219 for more informa‐
tion about finding data in HEMS.

• Results Area: Search results appear here. 

• Tabs: Displays the current service contract record in the Main, Equipment, Labor/Travel 
Details, and Attachments tab.

Search Area (Find Mode)
When the Contracts window is in Find mode (shown above), the Search Area contains fields that 
let you find service contract records by contract number, whether or not the records are active, 
control number, and vendor. By default, entering one or more letters in one or more of the 
search fields returns results that begin with the text you entered. For example, entering “def” 
will return “defibrillator.” Entering values in multiple search field restricts results to values that 
match all of the search terms in all of the fields.

Checking the Exact checkbox forces HEMS to return only those results that contain the exact text 
you entered. If you select this option, then entering “def” will not return “defibrillator” because 
the two are not an exact match.

Enter your desired search terms and then click Search to return matching results, or Reset to 
clear the Search Area and begin a new search.

Please see “The Find Function” on page 221 for more information on using Find mode.

Search Area (Filter Mode)
When the Contracts window is in Filter mode (not shown), the Search Area contains a list of 
selected filter conditions. Please see “Filters” on page 222 for more information about using fil‐
ters.

Report/Print Buttons
The Report/Print buttons provide quick access to relevant reports. From the left to right, the 
buttons are:

• List Report: Clicking the List Report button opens a summary report that lists all of the ser‐
vice contract records in HEMS.

• Detail Report ‐ All: Clicking the Detail Report ‐ All button opens a report that provides 
detailed information about each of the service contract records in HEMS.

• Detail Report ‐ Current: Selecting an item in the Results Area and then clicking the Detail 
Report ‐ Current button opens a report that provides detailed information about the cur‐
rently selected service contract record.

Reports appear in a separate browser window. You can print and/or export these reports, as 
described in “CHAPTER 12: Printing & Exporting Data” on page 233.

AUTHORED BY ANTHONY HERNANDEZ - (415)786-2081 - anthony94122@outlook.com
185Copyright 2010, EQ2, Inc. All rights reserved.



CHAPTER 9: Managing Contracts
Search Mode Buttons
The Search Mode buttons determine how service contract records will be retrieved. From left to 
right, the buttons are:

• Show Newly Added Items: If the Show Newly Added Items button is active, clicking it will 
display service contract records added during your current HEMS session. Logging out of 
HEMS ends your session.

• Switch to Filter mode: When the Contracts window is in Find mode, the Switch to Filter 
mode button appears as a small funnel. Clicking this button switches the Search Area to Filter 
mode. Please see “Filters” on page 222 for more information on using filters.

• Switch to Find mode: When the Contracts window is in Filter mode, the Switch to Find 
mode button appears as a small magnifying glass. Clicking this button switches the Search 
Area to Find mode. Please see “The Find Function” on page 221 for more information on 
using Find mode.

Main Tab
The Contract window Main tab 
contains the following information:

Basic Information
The Basic Information portion of 
the Main tab contains the following 
information:

• Contract #: Number of the ser‐
vice contract.

• Active: Whether or not the ser‐
vice contract is active.

• External Contract #: Number 
that the vendor assigned to the 
service contract.

• PO #: Purchase order number. 
This field uses values from the Purchase Orders Information List, which is described in “Pur‐
chase Orders List” on page 150.

• Title: Name of the service contract.

• Internal Manager: Initials of the manager who is responsible for the service contract. This 
field uses values from the Employees Information List, which is described in “Employees List” 
on page 126.

• Vendor: Name of the vendor who is responsible for performing the maintenance and/or 
repair called for in the service contract. This field uses values from the Vendors Information 
List, which is described in “Vendors List” on page 153.
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Contract Period
The Contract Period portion of the Main tab contains the following information:

• Start Date: Date on which the service contract begins.

• End Date: Date on which the service contract ends. The Equipment Inventory window uses 
this date for equipment included this service contract. Your equipment service expiration 
date in the equipment inventory is automatically updated with the contract end date if you 
selected this option when HEMS was installed. You can check this by selecting Utilities>Man‐
agement Tools>Service Area Configuration and seeing whether the Use contract end date 
as the equipment service expiration date checkbox is checked. See “Service Area Configura‐
tion” on page 263 for more information about Service Area configuration.

• Notify before: Number of days before the End Date that the Internal Manager receives an 
automatic notification about the contract’s pending expiration. This is the number of days 
required to cancel a contract before the vendor automatically renews it. Enter the desired 
number of days in the Notify before field. This option is only available with the optional EQ2 
Web Enterprise add on module, which is described in “EQ2 Web Enterprise” on page 285.

Contract Cost
The Contract Cost portion of the Main tab contains the following information:

• Amount: Base cost of the service contract.

• Other: Any additional costs (travel, legal, etc.) associated with the service contract.

• Contract Cost: Total cost of the service contract, which equals the sum of the base and addi‐
tional contract costs listed in the previous fields.

Contract Type
The Contract Type portion of the Main tab describes the type of the current agreement. The 
available options are:

• Service Contract: If this radio button is checked, indicates that the contract is a fixed‐price 
contract.

• Time and Material: If this radio button is checked, indicates that the contract is a pay‐as‐you‐
go contract.

• Other: If this radio button is checked, indicates that the contract is a different type of con‐
tract. Enter the contract type in the field provided.

Contract Coverages
The Contract Coverages portion of the Main tab lists the coverages provided under the current 
service contract. The available options are:

CAUTION: MAKE SURE TO RUN PERIODIC REPORTS TO CHECK FOR SERVICE 
CONTRACTS THAT ARE COMING UP FOR RENEWAL, TO AVOID BEING LOCKED 
INTO UNWANTED CONTRACT RENEWALS.
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• PM: If the PM checkbox is checked, the contract covers preventive maintenance on the 
included equipment to the maximum number of visits per year specified in the Covered/Year 
field.

• Repair: If the Repair checkbox is checked, the service contract covers repairs on the included 
equipment.

• Parts: If the Parts checkbox is checked, the service contract covers parts for the included 
equipment.

• Glass: If the Glass checkbox is checked, the service contract covers replacement of broken 
glass parts (such as lenses or windows).

• Other: If the Other checkbox is checked, the service contract covers the other items or ser‐
vices specified in the field.

• Auto Renew: If the Auto Renew checkbox is checked, the service contract will automatically 
renew on its end date unless terminated before that date, in accordance with the contract 
terms.

• First Call Agreement: If the First Call Agreement checkbox is checked, the vendor listed in 
the service contract must be called before any other vendor for any covered service on the 
included equipment.

Notes
The Notes portion of the Main tab contains additional notes about the current service contract 
record in a text field.

Equipment Tab
The Contract window Equipment 
tab contains the following informa‐
tion for each equipment item 
included in the current service con‐
tract:

• Control #: Unique number 
assigned to each equipment 
item managed by HEMS.

• Serial #: Serial number of the 
equipment item.

• EQ Type: Type of equipment.

• Cost: Cost of the equipment 
item.

When you are adding or editing a 
service contract record, the Update 
Equipment Information button is enabled, which allows, allows you to add or modify the equip‐
ment included in the service contract. Please see “Adding Contracts” on page 191 for more infor‐
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mation about adding service contract records or “Editing Contracts” on page 192 for more 
information about editing service contract records. Please also see “CHAPTER 5: Managing 
Equipment” on page 85 for more information about managing equipment in HEMS.

Labor/Travel Details Tab
The Contracts window Labor/Details tab contains the following information:

Labor Coverage
The Labor Coverage portion of the 
Labor/Travel Details tab lists the 
vendor’s availability for the current 
service contract. The available 
options are:

• Hours: Hours that the vendor is 
available. The available options 
are:

‐ Normal Business Hours: if 
the Normal Business Hours 
radio button is checked, the 
vendor is available during 
regular business hours only.

‐ Extended Hours: if the 
Extended Hours radio button is checked, the vendor is available beyond regular business 
hours.

‐ 24 x 7: If the 24 x 7 radio button is checked, the vendor is available at any time of day or 
night.

• Day(s) of the week: Check the appropriate checkbox(es) to indicate the vendor’s days of 
operation.

• From: Time of day that the vendor becomes available, in 24‐hour (military) format.

• To: Time of day that the vendor stops being available, in 24‐hour (military) format.

Labor Rates
The Labor Rates portion of the Labor/Travel Details tab lists the vendor’s charges for servicing 
the current service contract. The available options are:

• Normal Business: The vendor’s normal hourly rate.

• After Hours: The vendor’s after hours or overtime hourly rate.

• Holiday Rate: The vendor’s holiday hourly rate.

• Labor Notes: Enter any additional labor‐rate related notes here.
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Travel Charges
The Travel Charges portion of the Labor/Travel Details tab lists the vendor’s travel charges for 
the current service contract. The available options are:

• Hourly Rate: The vendor’s hourly travel rate.

• Zone Charge: Zone charges are charges based on the distance the vendor needs to travel.

• Travel Notes: Enter any additional travel‐charge related notes here.

Legal Details
The Legal Details portion of the Labor/Travel Details tab ensures that legal requirements have 
been met when creating the current service contract. The available option is:

• HIPAA Business Associate Addendum completed?: Checking the HIPAA Business Associate 
Addendum completed? checkbox indicates that the service contract includes the specified 
HIPAA addendum.

Attachments Tab
The Contracts window Attach‐
ments tab allows you to scan and/
or attach documents such as manu‐
als or images related to the current 
contract record. Please see “Attach‐
ing or Scanning Files” on page 193 
for more information about work‐
ing with scanned and attached files 
in HEMS contract records.
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Working with Contracts
This section describes how to view, add, edit, and deactivate service contracts using the HEMS 
Contracts window.

Viewing Contracts
To view a service contract using the Contracts window:

1. Open the Contracts window by selecting Activities>Contracts.

2. Search for and select the service contract you want to view. The selected contract informa‐
tion appears in the tabs. Please see “The Contracts Window” on page 184 for more informa‐
tion about the Contracts window.

Adding Contracts
To add a service contract record to the Contracts window:

1. Select Activities>Contracts to open the Contracts window and then either click the New but‐
ton in the Toolbar or press [CTRL]+[N].

2. Select the Main tab and then enter all of the required information. Please see “Main Tab” on 
page 186 for a description of the information contained in the Main tab.

3. Select the Equipment tab and then click the Update Equipment Information button to open 
the Equipment Management Wizard window. Search for the equipment that will be included 
in the service contract record you are creating and add it to the Selection Area, as described 
in “Search Area (Find Mode)” on page 185.

4. You may assign a dollar amount to one or more of the selected equipment items, as follows:

‐ To distribute the cost of the contract evenly among all equipment items, select Update 
Equipment Information, enter an amount in the Assign field, and then click the Assign 
button.

‐ To enter different amounts for each equipment item, click the equipment item and navi‐
gate to the Cost column (or move to the beginning by dragging), and then enter an 
amount directly. 

‐ If all equipment has the same amount except for one item, enter an amount in the Assign 
field, click the Assign button. and then edit the one equipment item that is different.

You are prompted to confirm your dollar assignments.

5. Click Apply to close the Equipment Management Wizard window and return to the Con‐
tracts window with the selected equipment added to the Equipment tab, indicating that it is 
covered by the service contract you are creating.
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6. Select the Labor/Travel Details tab and enter the vendor’s availability, rate, and legal details 
information. Please see “Labor/Travel Details Tab” on page 189 for a description of the 
Labor/Travel Details tab.

7. If needed, select the Attachments tab to attach and/or scan documents to the service con‐
tract record you are creating (such as a copy of the actual contract). Please see “Attaching or 
Scanning Files” on page 193 for information on attaching and scanning files to the HEMS 
Contracts window.

8. Click the Save button in the Toolbar to save the new service contract record.

Copying a Contract
To save time, you may create a copy of an existing service contract record and then edit the copy. 
This is useful when you need two service contract records that share some identical information. 
To copy an existing service contract record:

1. Select Activities>Contracts to open the Contracts window.

2. Select the service contract record you want to edit by searching for it as described in “Search 
Area (Find Mode)” on page 185.

3. Either click the Copy button in the Toolbar or press [CTRL]+[K].

4. Check or clear the Active checkbox, as appropriate. See below for more information about 
active and inactive service contract records.

5. Edit the appropriate fields to reflect the correct information for the new record, being sure 
not to forget about the Contracts window tabs.

6. Either click the Save button in the Toolbar or press [CTRL]+[S] to save the new service con‐
tract record.

Editing Contracts
To edit a service contract record:

1. Select Activities>Contracts to open the Contracts window.

2. Select the service contract record you want to edit by searching for it as described in “Search 
Area (Find Mode)” on page 185.

3. Either click the Edit button in the Toolbar or press [CTRL]+[E].

4. By default, the Active checkbox is checked. See “Active/Inactive Contracts” on page 193 for 
more information about active and inactive service contract records.

5. Enter all of the updated information for the service contract record you are editing in the 
appropriate fields, being sure not to forget about the Contracts window tabs.

6. Either click the Save button in the Toolbar or press [CTRL]+[S] to save the edited service con‐
tract record.

Please refer to “The Contracts Window” on page 184 for detailed information about the contents 
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Active/Inactive Contracts
Each service contract record in the Contracts window includes a checkbox labeled Active. This 
checkbox is checked by default when you create a new record.

Deleting Contracts
Service contract records that have been used elsewhere in HEMS cannot be deleted because 
they are part of your history. You can, however, deactivate service contract records that are no 
longer used by selecting the service contract record to deactivate and then clearing that record’s 
Active checkbox.

To delete a service contract:

1. Select Activities>Contracts to open the Contracts window.

2. Select the service contract record you want to edit by searching for it as described in “Search 
Area (Find Mode)” on page 185.

3. Click the Delete button in the Toolbar.

Attaching or Scanning Files
The HEMS Contracts window includes an Attachments tab that allows you to attach documents 
and/or images related to the current contract record.

• To add an attachment, select Attach to open a standard Windows dialog that allows you to 
select the file name, type, and location to attach. HEMS supports the DOC, GIF, ICON, JPEG, 
PDF, TXT, XLS, and ZIP formats.

• To scan an image from a local scanner, select Scan to open a standard Windows dialog that 
allows you to scan and name the file. Click OK to scan the file.

• To delete an attached or scanned file, select the item to delete and then click the Delete but‐
ton. You are prompted to confirm your decision.

Note: To attach a file in a format that HEMS does not support, ZIP the file and 
then attach the ZIP file to the desired record.
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The Reports Sidebar
The Reports sidebar allows you to quickly run any of the available HEMS 
reports. Please see “Reports Sidebar Defaults” on page 246 for information 
about configuring user access to reports. 

You may access reports by either:

• Clicking a category button at the bottom of the Reports sidebar and then 
double‐clicking the icon of the report you want to run, or

• Entering a report name or keyword into the Search field at the top of the 
Reports sidebar and then running one of the matching reports by double‐
clicking its icon.

Reports appear in a separate browser window. Available filtering options also 
appear in the browser window. To filter a report, enter your desired criteria and 
then click the View Report button. You can hide filtering options by clicking the 
double up‐arrow button, or display these options by clicking the double‐down 
arrow button.

Configuring
You can configure the following report options:

• Each HEMS user can configure the Reports sidebar by selecting Utili‐
ties>User Configuration to open the User Configuration window and then 
selecting the Reports Sidebar tab. Please see “Reports Sidebar Defaults” on 
page 246 for more information about customizing access to reports by user.

• You can also customize the order in which reports appear in the Reports 
Sidebar using the User Configuration window, as described in “Configuring 
User Defaults” on page 246.

Running Reports
To run a report in HEMS:

1. Locate the report you want to run in the Reports Sidebar.

2. Double‐click the selected report to open it in a separate browser window.

3. Filter the report by entering your desired search criteria in the available 
fields.

4. Click the View Report button to view your selected report.
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Navigating Reports
You can navigate HEMS reports using the Report Toolbar in the browser window.

From left to right, the Report Toolbar buttons are:

• Expand/Collapse Tree (1): Clicking the Expand/Collapse Tree button toggles a tree view of 
the current report on and off. You can use this tree to quickly locate the report information 
you are looking for.

• Go to First Page (2): Takes you to the first page of the report.

• Go to Previous Page (3): Takes you to the previous page of the report.

• Go to Selected Page (4): Takes you to the selected page of the report. Enter your desired 
page number and then press [ENTER].

• Go to Next Page (5): Takes you to the next page of the report.

• Go to Last Page (6): Takes you to the last page of the report.

• Zoom (7): Allows you to magnify or shrink the report for easy viewing.

• Find Text (8): Enter text in the field and then click Find to locate the first instance of your 
selected text in the report. Clicking Find Next locates subsequent instances of the same text 
in the current report.

• Export Report (9): Selecting an export format in the pull‐down menu and then clicking 
Export allows you to export the current report. Please see “Printing” on page 234 for more 
information about exporting HEMS reports.

• Refresh Report (10): Refreshes the current report.

• Print Report (11): Prints the current report. Please see “Exporting” on page 235 for more 
information about printing reports.

• Expand/Collapse Search Area (12): Clicking the double up‐arrow icon collapses the report 
search options. When the search options are collapsed, clicking the double down‐arrow icon 
expands the search area.
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Work Order Reports
HEMS includes the following work order reports, which are available by clicking the Work Order 
category button at the bottom of the Reports sidebar.

Work Order Review (Summary)
The Work Order Review (Summary) report allows you to review pending versus closed work 
orders including percentages, costs, and hours. You can display this summary by Work Order 
Type, Work Order Priority, Assigned Engineer, Location, Department, Specialty, Subcode, and 
Requester. You must specify either an Issue Date (when the work order was issued) or Status 
Date (either the close date or the most recent work order status date if still pending) for this 
report.

This report presents both a bar graph that displays pending and closed work orders and a pie 
chart that shows the relative number of work orders by summary type for the “top 10” types on 
the first page. The second page presents the following information:

• Total number and percent of work orders that are opened, closed or pending.

• Cost of labor and parts.

• Hours spent.

• Maximum and average days work orders remain open.

Work Order Review (Detail)
The Work Order Review (Detail) report allows you to review pending versus closed work orders 
with details, including the request and the action taken. You can display this detailed report by 
Work Order Type, Work Order Priority, Assigned Engineer, Location, Department, Specialty, 
Subcode, and Requester. You must specify either an Issue Date (when the work order was 
issued) or Status Date (either the close date or the most recent work order status date if still 
pending) for this report.

This report presents both a bar graph that displays pending and closed work orders and a pie 
chart that shows the relative number of work orders by how you have grouped your report. Sub‐
sequent pages then present the following information:

• WO #: Work order number.

• Issue Date: Date the work order was issued.

• WO Department: Department that requested the work order.

• WO Location: Location of the equipment referenced by the work order.

Note: Work order report graphs display the “Top 10” items in the report. 
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• Priority: Work order priority.

• Assg Eng: Engineer assigned to the work order.

• Procedure Name: Name of the maintenance/repair/etc. procedure.

• Specialty: Maintenance specialty.

• Status: Most recent work order status.

• Status Date: Usually the close date of the work order, or, if the work is still pending, the most 
recent manually updated date.

Work Order Equipment Review (Summary)
The Work Order Equipment Review (Summary) report allows you to review pending versus 
closed work orders based on the equipment including percentages, costs and hours. Filtering 
options include equipment related items (such as equipment type, equipment model, and device 
inclusion). You can display this summary by Work Order Type, Work Order Priority, Assigned 
Engineer, Location, Department, Specialty, Subcode, EQ Type, Device Inclusion, Manufacturer, 
Model # + Manufacturer, Model Name + Manufacturer, Manufacturer + Model #, Control #, 
and Requester. You must specify either an Issue Date (when the work order was issued) or Sta‐
tus Date (either the close date or the most recent work order status date if still pending) for this 
report.

This report presents both a bar graph that displays pending and closed work orders and a pie 
chart that shows the relative number of work orders by how you have grouped your report. The 
second page presents the following information:

• Total number and percent of work orders that are opened, closed or pending.

• Cost of labor and parts.

• Hours spent.

• Maximum and average days work orders remain open.

Work Order Equipment Review (Detail)
The Work Order Equipment Review (Detail) report allows you to review pending versus closed 
work orders with details, including the request and action taken based on the equipment on the 
work order. Filtering options include equipment related items (such as equipment type, equip‐
ment model, and device inclusion). You can display this detailed report by Work Order Type, 
Work Order Priority, Assigned Engineer, Location, Department, Specialty, Subcode, EQ Type, 
Device Inclusion, Manufacturer, Model # + Manufacturer, Manufacturer + Model #, Model 
Name + Manufacturer, Control #, and Requester. You must specify either an Issue Date (when 
the work order was issued) or Status Date (either the close date or the most recent work order 
status date if still pending) for this report.
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This report presents both a bar graph that displays pending and closed work orders and a pie 
chart that shows the relative number of work orders by how you have grouped your report. Sub‐
sequent pages then present the following information:

• WO #: Work order number. This number is unique to each work order in HEMS.

• Issue Date: Date the work order was issued.

• WO Department: Department that requested the work order.

• WO Location: Location of the equipment referenced by the work order.

• Priority: Work order priority.

• Assg Eng: Engineer assigned to the work order.

• Procedure Name: Name of the maintenance/repair/etc. procedure.

• Specialty: Maintenance specialty.

• Status: Most recent work order status.

• Status Date: Usually the close date of the work order, or, if the work is still pending, the most 
recent manually updated date.

Work Order Labor Review (Summary)
The Work Order Labor Review (Summary) report allows you to review labor hours on work 
orders based on one or more date(s) when the work orders were opened, closed, or the date(s) 
actual services were provided. You can display this detailed report by Work Order Type, Work 
Order Priority, Assigned Engineer, Location, Department, Specialty, Subcode, Labor Employee, 
Labor Work Code, and Requester. You must specify either an Issue Date (when the work order 
was issued) or Status Date (work order status as of your selected date) for this report.

This report presents both a bar graph that displays pending and closed work orders and a pie 
chart that shows the relative number of work orders by summary type by how you have grouped 
your report. The second page presents the following information:

• # of WOs: Number of work orders worked on by the technician.

• # of Labor Events: Number of labor entries on the work order.

• Labor Hours: Number of labor hours recorded on work orders.

• Labor Cost: Total labor cost (labor hours times labor rate).

• Lump Sum: Additional labor costs such as overhead or some external cost.

• Total Cost: Total of all labor and lump sum costs.
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Management Reports
HEMS includes the following management work order reports, which are available by clicking the 
Management category button at the bottom of the Reports sidebar:

Work Order Response Time (Detail)
The Work Order Response Time (Detail) report shows you how quickly you are responding to 
work with details, including the request and/or action. This report can be used for safety com‐
mittee and quality control committee meetings. When running the report, you can define the 
response time in hours and group by work order type.

This report presents the following information:

• WO #: Work order number. This number is unique to each work order in HEMS.

• Issue date: Date the work order was issued.

• WO Department (Cost Center): Department that requested the work order.

• WO Location: Location of the equipment referenced by the work order.

• Priority: Work order priority.

• Subcode: Code that indicates the preventive maintenance outcome (such as PM Successful), 
or the cause of corrective/routine maintenance (such as physical abuse/damage, operator 
error, etc.).

• Assg Eng: Engineer assigned to the work order.

• Responded On: Date and time the technician first responded (first labor entry).

• Status: Most recent work order status.

• Status Date: Usually the close date of the work order, or, if the work is still pending, the most 
recent manually updated date.

• Response Time: How long it took to respond to the work order. This is defined as the interval 
between the work order issue date/time and the first labor entry for that work order.
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Work Order Response Time (Summary)
The Work Order Response Time (Summary) report shows you how quickly you are responding 
to work. This report can be used for safety committee and quality control committee meetings. 
When running the report, you can define the response time in hours and can group by Work 
Order Type, Work Order Priority, Assigned Engineer, Location, Department, Specialty, Subcode, 
and Requester.

This report presents the following information:

• Work Orders Responded Within Defined Time: Number and percent of work orders 
responded to within your specified time, in hours.

• Work Orders Responded After Defined Time: Number and percent of work orders 
responded to after your specified time, in hours.

• Work Orders Not Responded: Number and percent of work orders not responded to date.

Work Order Close Time (Summary)
The Work Order Close Time (Summary) report shows you how quickly you are completing work. 
This report can be used for safety committee and quality control committee meetings. When 
running the report, you can define the work order close time in hours and can group by Work 
Order Type, Work Order Priority, Assigned Engineer, Location, Department, Specialty, Subcode, 
and Requester.

This report presents the following information:

• Work Orders Closed Within Defined Time: Number and percent of work orders closed within 
your specified time, in hours.

• Work Orders Closed After Defined Time: Number and percent of work orders closed after 
your specified time, in hours.

• Work Orders Not Closed: Number and percent of work orders not closed to date.

Work Order Close Time (Detail)
The Work Order Close Time (Detail) report shows you how quickly you are completing work 
with details, including the request and/or action. This report can be used for safety committee 
and quality control committee meetings. When running the report, you can define the work 
order close time in hours and can group by Work Order Type, Work Order Priority, Assigned 
Engineer, Location, Department, Specialty, Subcode, and Requester.

This report presents the following information:

• Work Order #: Work order number. This number is unique to each work order in HEMS.

• Issue Date: Date the work order was issued.

• WO Department (Cost Center): Department that requested the work order.

• WO Location: Location of the equipment referenced by the work order.
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• Priority: Work order priority.

• Subcode: Code that indicates the preventive maintenance outcome (such as PM Successful), 
or the cause of corrective/routine maintenance (such as physical abuse/damage, operator 
error, etc.).

• Assg Eng: Engineer assigned to the work order.

• Close Date: Date and time the work order was closed.

• Close Time: How long it took to close the work order.

Work Order Summation by Priority
The Work Order Summation by Priority report summarizes the total work order count, percent‐
age, hours, and costs by priority. To report on preventive maintenance work orders only, filter 
the report by setting the WO Type to Scheduled.

This report presents a pie chart showing a graphical overview of work order statuses and then 
presents a breakdown of work orders by hours, percentages, and costs.

You must specify a date range for this report.

Work Order Summation by Department
The Work Order Summation by Department report summarizes the total work order count, per‐
centage, hours, and costs by department. To report on preventive maintenance work orders only, 
filter the report by setting the WO Type to Scheduled.

This report presents a pie chart showing a graphical overview of work order statuses and then 
presents a breakdown of work orders by hours, percentages, and costs.

You must specify a date range for this report.

Regulatory Compliance
The Regulatory Compliance report encapsulates all of the information required for regulatory 
compliance, active inventory, and work order costs for user error and/or equipment abuse. This 
report lets you look at how your hospital is performing in one click.

This report presents the following information:

• Non Life Support: All equipment items not belonging to the Life Support class.

• Life support: All the equipment items belonging to the Life Support class.

• High Risk: All equipment items that meet or exceed your defined High Risk level.

• User Error/EQ Abuse: Work orders with the Operator Error, or Abuse/Physical Damage sub‐
codes.

• Recall Alert: Work Orders with the Recall/Alert type.

• Device in Use: Work Orders with the Device in Use subcode.
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• Unable to Locate: Work Orders with the Unable to Locate subcode.

• PM Failure: Work Orders with the PM Failure subcode.

• PM: Work Orders with the Scheduled type.

• Unscheduled: All work orders with a type other than, “Scheduled” (such as “Routine,” “Haz‐
ard,” “Project,” etc.

• Overtime: Work orders with the Overtime labor entry.

Quality Survey Remarks
The Quality Survey Remarks report shows the remarks submitted by users in response to quality 
surveys about the services provided by your department. Surveys are conducted after work is 
completed. This report is only available if you have the optional EQ2 Web Enterprise add‐on 
installed. If you do not have EQ2 Web Enterprise installed, please see “EQ2 Web Enterprise” on 
page 285 for more information about this add‐on module.

Quality Survey
The Quality Survey report shows the satisfaction level of departments for services performed for 
them. This information is based on quality surveys conducted after work is completed. This 
report is only available if you have the optional EQ2 Web Enterprise add‐on installed. If you do 
not have EQ2 Web Enterprise installed, please see “EQ2 Web Enterprise” on page 285 for more 
information about this add‐on module.
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Equipment Reports
HEMS includes the following equipment reports, which are available by clicking the Equipment 
category button at the bottom of the Reports sidebar:

Equipment Detail
The Equipment Detail report provides detailed information about equipment in inventory. You 
can sort this report by Equipment Type, Model # + Manufacturer, Manufacturer + Model #, 
Manufacturer, Department, Cost Center #, Location, Device Inclusion, Control #, Serial #, ECRI 
#, and ECRI Name.

This report presents the following information per matching item:

• Control #: Unique number assigned to each equipment item in HEMS.

• Serial #: Unique number assigned to the equipment item by the manufacturer.

• Risk Score: Level of risk assigned to the equipment item.

• EQ Type: Type of equipment.

• EQ System: Equipment system.

• EQ Class: Equipment class.

• Manufacturer: Equipment manufacturer name.

• Supplier: Equipment supplier (may or many not be the manufacturer).

• Model #: Equipment model number.

• DI: Device inclusion for the current equipment item.

• Department: Department that owns the equipment.

• Cost Center #: Department cost center number.

• Purchase Date: Date the equipment was purchased.

• Purchase Cost: Amount paid for the equipment.

• Warranty Date: Warranty expiration date.

• Service Date: Service contract expiration date.

• Depreciation: Equipment life expectancy.

• Location: Location of the equipment.

• Campus: Campus where the equipment is located.

• Building: Building where the equipment is located.

• Wing: Wing where the equipment is located.

• Floor: Floor where the equipment is located.
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• Room: Room where the equipment is located.

• Space: Space where the equipment is located.

Management Program Inventory
The Management Program Inventory report only covers equipment in the preventive mainte‐
nance management program. Management program inventory contains either all equipment 
items that have a higher risk factor than the minimum required for placing the equipment into 
the management program, or equipment that does not have risk defined. This report compares 
the number of preventive maintenance and repair work orders.

This report presents the following information broken down by equipment type:

• Control #: Unique number assigned to each equipment item in HEMS.

• Department: Department that owns the equipment.

• Location: Location of the equipment.

• Annual Frequency: Current preventive maintenance frequency.

• # of PM Work Orders Opened/Closed/Close%: How many preventive maintenance work 
orders were opened and closed, and the percentage of opened work orders that were closed.

• # of Failure Work Orders Opened/Closed/Close%: How many corrective maintenance work 
orders were opened and closed, and the percentage of opened work orders that were closed

• Risk Factor: Level of risk assigned to the equipment item.

Equipment List
The Equipment List report shows the equipment inventory in list format. Technicians can run this 
report for a quick glance at equipment with next due date for preventive maintenance. You can 
sort this report by Equipment Type, Model # + Manufacturer, Manufacturer + Model #, Manu‐
facturer, Department, Cost Center #, Location, Device Inclusion, Control #, Serial #, ECRI #, and 
ECRI Name.

This report presents the following information:

• Control #: Unique number assigned to each equipment item in HEMS.

• Serial #: Unique number assigned to the equipment item by the manufacturer.

• EQ Type: Type of equipment.

• Model #: Equipment model number.

• Manufacturer: Equipment manufacturer name.

• Department: Department that owns the equipment.

• Location: Location of the equipment.

• DI: Device inclusion for the selected equipment.

• Next Date (PM): Date the equipment item is next due for preventive maintenance.
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• Interval: Preventive maintenance interval.

• Risk Factor: Level of risk assigned to the equipment item.

Equipment Overdue for PM
The Equipment Overdue for PM report displays equipment that is more than 30 days overdue 
for preventive maintenance. You can sort this report by Equipment Type, Model Name + Manu‐
facturer, Manufacturer + Model Name, Model # + Manufacturer, Manufacturer + Model #, 
Manufacturer, Department, Cost Center #, Location, Device Inclusion, Control #, Serial #, ECRI 
#, and ECRI Name.

This report presents the following information:

• Control #: Unique number assigned to each equipment item in HEMS.

• Serial #: Unique number assigned to the equipment item by the manufacturer.

• EQ Type: Type of equipment.

• EQ Model: Equipment model.

• Manufacturer: Equipment manufacturer name.

• Department: Department that owns the equipment.

• Location: Where the equipment is located.

• Last Closed On: Date on which the last scheduled work order for this equipment was closed.

• Last Due From: Date from which the last scheduled work order is due.

• Days Due: how many days overdue the equipment is for maintenance.

• Cnt: Total unclosed scheduled work orders.

Equipment List with Purchase Information
The Equipment List with Purchase Information report shows the equipment inventory in a list 
format including purchase information. This report is useful when the owner department needs 
information regarding purchasing decisions or equipment age. You can sort this report by Equip‐
ment Type, Model # + Manufacturer, Manufacturer + Model #, Model # + Manufacturer, Manu‐
facturer + Model #, Manufacturer, Department, Cost Center #, Location, Device Inclusion, 
Control #, Serial #, ECRI #, and ECRI Name.

This report presents the following information:

• Control #: Unique number assigned to each equipment item in HEMS.

• EQ Type: Type of equipment.

• EQ Model: Equipment model.

• Manufacturer: Equipment manufacturer name.

• Serial #: Unique number assigned to the equipment item by the manufacturer.
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• PO #: Purchase order number used to buy the equipment.

• Pur Date: Date the equipment was purchased.

• Pur Cost: Purchase cost of the equipment.

• Service Date: Date that the current service contract expires for the selected equipment.

• Warranty Date: Date that the manufacturer warranty expires for the selected equipment.

• Life Exp: Total life expectancy for the selected equipment.

• Age: Age of the selected equipment.

Equipment Summary
The Equipment Summary report displays summary information about equipment in inventory. 
You can group this report by Equipment Type, Model # + Manufacturer, Manufacturer + Model 
#, Model # + Manufacturer, Manufacturer + Model #, Manufacturer, Department, Cost Center 
#, Location, Device Inclusion, Control #, Serial #, ECRI #, and ECRI Name.

This report presents the following information by group:

• Number of Equipment: Equipment count based on your selected grouping.

• Life Expectancy: Total life expectancy for each equipment model (only displayed if grouped 
by type).

• Age Min/Max/Avg: Minimum (newest), maximum (oldest), and average age of the equip‐
ment.

• Cost Price Min/Max/Avg: Minimum (lowest), maximum (highest), and average cost of the 
equipment when you purchased it.

Clicking the arrows at the top of a column sorts the report in ascending (A‐Z) or descending (Z‐A) 
order by the selected column.

Equipment Listing with Schedule Information
The Equipment Listing with Schedule Information report shows the equipment inventory in list 
format, including schedule information. This can be used to review equipment schedule informa‐
tion with the next due date. You can group this report by Equipment Type, Model # + Manufac‐
turer, Manufacturer + Model #, Model # + Manufacturer, Manufacturer + Model #, 
Manufacturer, Department, Cost Center #, Location, Device Inclusion, Control #, Serial #, ECRI 
#, and ECRI Name.

This report presents the following information by group:

• Control #: Unique number assigned to each equipment item in HEMS.

• EQ Type: Type of equipment.

• EQ Model: Equipment model.

• Manufacturer: Equipment manufacturer name.
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• Serial #: Unique number assigned to the equipment item by the manufacturer.

• Assg Eng: Engineer assigned to the work order.

• Next Date: Date the equipment item is next due for preventive maintenance.

• Int: Preventive maintenance schedule interval.

• Risk: Level of risk assigned to the equipment item. Please see “CHAPTER 8: Managing Risk” 
on page 179 for information about managing risk in HEMS.

• Est Hours: Estimated hours for preventive maintenance.

Equipment Downtime
The Equipment Downtime report lists equipment with its downtime. The equipment is consid‐
ered “down” if it is unavailable and the department is open. Downtime does not include hours 
when the department is closed, even if the equipment is unavailable during those hours. Equip‐
ment is considered unavailable from the time a work order is opened to the time the equipment 
is back in service and the work order is closed. To run this report, you must have department 
shifts (hours of operation) defined in the Departments Information List. Please see “Depart‐
ments List” on page 124 for more information about the Departments Information List.

This report presents the following information for your selected date range:

• Control #: Unique number assigned to each equipment item in HEMS.

• Equipment Type: Type of equipment.

• Model #: Equipment model number.

• Manufacturer: Equipment manufacturer name.

• Serial #: Unique number assigned to the equipment item by the manufacturer.

• Owner Department: Department that owns the equipment.

• Down Time (hours): How many hours the current equipment item has been down.

• Down Time (%): Percentage of time that the current equipment item has been down.

Clicking the arrows at the top of a column sorts the report in ascending (A‐Z) or descending (Z‐A) 
order by the selected column.

Equipment History
The Equipment History report displays the maintenance history for the specified equipment 
item control number. You can specify whether or not to include work order details in this report. 
This report includes equipment details, schedule information, contract information (if defined), 
work history grouped by scheduled and unscheduled. It also includes graphs for replacement 
matrix and cost of ownership.

AUTHORED BY ANTHONY HERNANDEZ - (415)786-2081 - anthony94122@outlook.com
209Copyright 2010, EQ2, Inc. All rights reserved.



CHAPTER 10: Reports
Equipment with Parts
The Equipment with Parts report lists equipment items and their associated parts.

This report presents the following information:

• Control #: Unique number assigned to each equipment item in HEMS.

• Equipment information: This report lists serial #, equipment type, model #, model name, 
manufacturer, and department information for each equipment item.

• Part information: This report lists part #, manufacturer's part #, manufacturer, part descrip‐
tion, and part type information for each part.

Rate of Occurrence of Failure
The Rate of Occurrence of Failure report identifies what equipment is failing most frequently 
according to unscheduled (repair) events. Failed equipment slows production and incurs costs. 
Failures are a metric for management to review and determine wither preventive maintenance 
must be increased, equipment replaced, etc. This is the other side of the Maximum Expenditure 
Limit report. You can group this report by Department, EQ Type, or None. Selecting None groups 
the report by control number.

This report presents the following information by group:

• Control #: Unique number assigned to each equipment item in HEMS.

• Serial #: Unique number assigned to the equipment item by the manufacturer.

• Model #: Equipment model number.

• Manufacturer: Equipment manufacturer name.

• Equipment Type: Type of equipment.

• Department: Department that owns the equipment.

• EQ Purchase Date: Date the current equipment item was purchased.

• # of Failures: Number of times the current equipment item has failed.

• ROCOF: Rate of Occurrence of Failure for the current equipment item.
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Maximum Expenditure Limit
The Maximum Expenditure Limit report lists equipment items with life expectancy, purchase, 
and purchase price defined. This report provides a baseline for establishing a equipment replace‐
ment program. If the Repair Cost is more than the Maximum Expenditure Limit (MEL) then it is 
time to purchase new equipment. The new cost that appears in the report is a straight line calcu‐
lation that adds 3% to the equipment’s original cost per annum.

This report presents the following information:

• Control #: Unique number assigned to each equipment item in HEMS.

• Equipment Type: Type of equipment.

• Life Exp: Total life expectancy of the current equipment item, in years.

• Useful Life Left: Remaining useful life of the current item, in years.

• Hours Spent: Total number of hours spent on work orders for the current equipment item.

• # of WOs: Number of work orders opened for the current equipment item.

• Repair Cost: How much has been spent to repair the current equipment item during the cur‐
rent year.

• Max Exp Limit (MEL): Remaining value of the current equipment item.

• Exceeded MEL by: How much the equipment repair cost exceeds the Maximum Expenditure 
Limit.

• Exp Cost for New Equipment: Expected equipment replacement cost.

• P: Prohibited

• O: Obsolete

• Support End Date: Date that manufacturer or vendor support expires for the current equip‐
ment item.

Note: The fact that a piece of equipment is approaching or beyond its projected 
useful life expectancy is not by itself a sufficient reason to replace the item.
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Closed Percentage per Month
The Closed Percentage per Month report only covers equipment in the preventive maintenance 
management program. This report shows the count of scheduled equipment in the preventive 
maintenance program per month per priority and the count of equipment closed within that 
month

This report presents a bar graph with work order close percentages by month and then a month‐
‐by‐month list with the following information:

• Month: Calendar year by month. The current year displays through the current month.

• Priority: Work order priority.

• Total WOs: Total number of work orders opened.

• WOs Closed: Total number of work orders closed within the month.

• Close %age: Percentage of work orders closed. This is obtained by dividing the number of 
closed work orders by the total number of work orders.
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Schedule (PM) Reports
HEMS includes the following preventive maintenance schedule reports, which are available by 
clicking the Schedule (PM) category button at the bottom of the Reports sidebar:

Procedure Review
The Procedure Review report displays a procedure and its associated tasks in sequence. This 
report also shows all of the equipment associated with the procedure, if selected. You can sort 
this report by Procedure Name, Procedure #, Specialty + Procedure Name, Specialty + Proce‐
dure Number, Procedure Type + Procedure Name, and Procedure Type + Procedure #.

This report presents the following information for each procedure:

• Procedure Name: Name of the maintenance/repair/etc. procedure.

• Proc #: Number assigned to the procedure.

• Procedure Type: Type of procedure.

• Specialty: Maintenance specialty.

• Source: Where the procedure originated (such a ASHE).

• Task Sequence: Order in which the tasks are performed.

Then, for each task in the procedure, the report displays:

• Task name: Name of the task.

• Task #: Unique number associated with each task.

• Interval: The interval of the task.

• Est Hrs: Estimated hours.

Preventive Maintenance Summary
The Preventive Maintenance Summary report lists preventive maintenance schedules based on 
your search criteria.

This report presents the following information by equipment type:

• Control #: Unique number assigned to each equipment item in HEMS.

• Equipment Type: Type of equipment.

• Maintenance Procedure: Procedure performed for preventive maintenance.

• Priority: Work order priority.

• Assg Eng: Engineer assigned to the work order.

• Department: Department that owns the equipment.

• Next Date: Date the equipment item is next due for preventive maintenance.
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• Interval: Preventive maintenance interval.

• Risk: Level of risk assigned to the equipment item.

Annual Schedule Load
The Annual Schedule Load report allows you to review your scheduled load to see equipment 
scheduled per month and estimated hours per month. You can group this report by Assigned 
Engineer, Specialty, Equipment Type, Department, Location, Priority, and Procedure. You can 
also sort this report by Issue Date, Assigned Engineer, Procedure, Specialty, Department, Loca‐
tion, Priority, or Control #.

The summary version of this report presents bar graphs showing the number of equipment items 
due by month, the total estimated hours per month, and the overall equipment count and esti‐
mated hours count for the selected time frame.

The detailed version of this report presents the above information plus the following detailed 
information for each piece of equipment grouped according to your selected criteria:

• Issue Date: Date the work order was issued.

• Control #: Unique number assigned to each equipment item in HEMS.

• Equipment Type: Type of equipment.

• Department: Department that owns the equipment.

• Location: Where the equipment is located.

• Procedure: Maintenance procedure name.

• Specialty: Maintenance specialty.

• Employee: Assigned engineer.

• Est Hrs: Estimated hours.

• Int: Preventive maintenance interval.

PM Parts Due - Shortage
The PM Parts Due ‐ Shortage report lists parts that need to be ordered to cover the selected pre‐
ventive maintenance period. HEMS calculates the shortage by subtracting stock on hand from 
the parts required for preventive maintenance for the selected period. You can group this report 
by Department, Equipment Type, Location, Model # + Manufacturer, Part Manufacturer, Part 
Type, and Part #.

The summary version of this report presents the following information:

• Part #: Part number entered into HEMS by the user.

• Part Type: Type of part.

• Manufacturer: Manufacturer that makes the part.
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• Quantity Needed: How many parts are needed to complete preventive maintenance for the 
selected date range.

• On Hand: How many of the particular part you have on hand.

• Shortage: Difference between the number of parts you have and the number of parts you 
need for the selected date range.

• Last Price: Most recent price paid for this part.

•  Purchase Budget: Total cost to purchase all of the parts needed for the specified date range.

The detailed version of this report presents the summary information plus all of the equipment 
that needs each of the parts:

• Control #: Unique number assigned to each equipment item in HEMS.

• Serial #: Unique number assigned to the equipment item by the manufacturer.

• Equipment Type: Type of equipment.

• Model #: Equipment model number.

• Manufacturer: Equipment manufacturer name.

• Due Date: Date the equipment item is next due for preventive maintenance.

PM Parts Due
The PM Parts Due report lists parts required for preventive maintenance without considering 
stock on hand. You can group this report by Department, Equipment Type, Location, Model # + 
Manufacturer, Part Manufacturer, Part Type, and Part #. Then, based on the selected group, the 
report displays the part quantities needed by your selected date and both estimated cost by 
group and the total estimated cost for all groups.
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Risk Reports
HEMS includes the following risk reports, which are available by clicking the Risk category button 
at the bottom of the Reports sidebar:

Risk Interval
The Risk Interval report displays preventive maintenance intervals and priority based on risk fac‐
tor. It uses several ranges of risk factor scores and displays the interval and priority for each 
range.

Risk Category
The Risk Category report displays risk statements sorted by risk category and decreasing risk fac‐
tor. The risk categories are:

• Equipment Function

• Clinical Application

• PM Requirement

• Likelihood of Failure

• Environment of Use
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Other Reports
HEMS includes the following additional reports, which are available by clicking the Other cate‐
gory button at the bottom of the Reports sidebar:

Parts with Equipment
The Parts with Equipment report lists parts and their associated equipment. You may group this 
report by Equipment Type, Model # + Manufacturer, Part Manufacturer, Part Type, and Part #.

For each part, the report shows the following information:

• Part #: Part number entered into HEMS by the user.

• Part Type: Type of part.

• Part Description: Description of part.

• Part Manufacturer: Manufacturer that makes the part.

• Last Price: Most recent price paid for this part.

• On Hand: How many of the current part you have on hand.

The report then lists the equipment that uses that part, including:

• Control #: Unique number assigned to each equipment item in HEMS.

• Serial #: Unique number assigned to the equipment item by the manufacturer.

• Equipment Type: Type of equipment.

• Model #: Equipment model number.

• Manufacturer: Equipment manufacturer name.

Equipment with Network Information
The Equipment with Network Information report is a sample custom report with custom fields 
pertaining to network information defined in the equipment inventory.
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CHAPTER 11:
Finding Data
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Finding Your Work
The HEMS Find and Filter functions are available in HEMS dashboards, windows, and Information 
Lists to help you quickly locate the information you’re looking for. The Find function provides a 
context sensitive set of fields that allow you to enter your desired search criteria. For example, 
you can search the Work Orders dashboard for a single work order or a range of work orders by 
control numbers, specific date or date range, status, priority, and more. Search results appear in 
the same window for fast viewing, editing, and other functions. The Filter function lets you cre‐
ate custom searches that can go beyond the options available using the Find function.

Search results are available until you run another Find or Filter search that overrides your previ‐
ous the first group of search results.

Note: The Find and Filter functions retrieve information from the HEMS server 
every time you run a search.
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The Find Function
The HEMS Find function automatically appears when you open a HEMS dashboard, window, or 
Information List. To use the Find function, enter your desired search criteria in the Search Area of 
the current window. Please refer to the instructions for your current window. If you are using the 
Work Orders dashboard, please see “The Work Orders Dashboard” on page 17. If you are using 
the Equipment inventory dashboard please see “The Equipment Inventory Dashboard” on 
page 22.

When using the Find function:

• In general, most fields return matches that begin with the text entered in that field. For 
example, entering “def” retrieve both “defib” and “defibrillator.” The EQ Type and ECRI fields 
return results that contain the text entered in those fields. For example, entering “fib” will 
return “defibrillator.”

• If you enter search criteria in more than one field, the Find function will return only those 
results that match all of your search criteria in all fields that contain text.

• To return all records, click the Search button without entering anything in the search fields.

• By default, the Find function in the Work Orders and Equipment Inventory dashboards is 
Pending and Active, respectively. To return all work orders, clear the Pending checkbox; to 
return all equipment, select Both Active and Inactive.

The Find Window
The following security‐related windows use the Find window to locate information:

• Users Window: Please see “User Management” on page 242 for more information about 
managing users in HEMS.

• Passwords Window: Please see “Password Management” on page 249 for more information 
about managing passwords in HEMS.

• Control Permissions Groups: Please see “Control Groups” on page 252 for more information 
about managing Control Groups in HEMS.

• Menu Permissions Groups: Please see “Menu Groups” on page 257 for more information 
about managing Menu Groups in HEMS.

• Errors Window: Please see “Error Logs” on page 267 for more information about finding and 
viewing HEMS errors.

The Find window displays the most commonly used search fields appropriate to the current win‐
dow.

You can open the Find window at any time when in any of the above‐listed windows by clicking 
the Find button in the Toolbar. Please see “Toolbar” on page 37 for more information about the 
Toolbar.
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Filters
At times, you may want to refine your search or search by using fields that are not available in 
Find mode. The HEMS Filter function lists all available fields for the window or list you are in, 
which allows you to narrow your search results even more.

Filters list field headers (in light gray) and all fields available for the window you are in. Be careful 
to select the correct Field header and then the field. For example, Initials is under the Assigned 
Engineer header, and Labor Initials is under the WO Lbr Entries header.

Toggling Filters
By default, HEMS operates in Find mode.

• To switch to Filter mode, click the Switch to Filter Mode button, which appears as a small 
funnel in the current window.

• To switch back to Find mode, click the Switch to Find Mode button, which appears as a small 
magnifying glass in the current window.

Filter Components
A Filter is made up of one or more Conditions. A single Condition compares a Field to a specific 
Value using an Operator that determines the comparison that will be made. For example, “Work 
Order Status Date is greater than or equal to 05/01/2009” is a Condition where:

• Work Order Status Date is the Field.

• Greater than or equal to is the Operator.

• 05/01/2009is the value.

This Condition only allows those work order records with a Status Date greater than or equal to 
05/01/2009 to be part of the subset.

A Filter can have more than one Condition. In this case the Filter compares each Condition using 
Connectors that specify how any given Condition should be compared to the next Condition in 
the Filter.

HEMS Filter syntax is therefore:

• Single‐Condition Filter: Condition (where Condition equals Field + Operator + Value).

Note: The remainder of this section capitalizes the words “Field,” “Value,” “Con‐
dition”, and “Operator” to indicate specific filter components.
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• Multi‐Condition Filter: Condition + Connector+ Condition, or (Field + Operator + Value) + 
Connector + Field + Operator + Value).

Operators
Operators compare Fields and Values to determine whether a given record should be included in 
the subset. HEMS includes several Operators, described below. Some Operators use more than 
one Value. For example, “is between” requires two Values (as in “Status Date is between 05/01/
2009 and 06/01/2009”). Other Operators do not use any Value; for example, “Requester is blank” 
is either true or not without needing a Value. Some Operators are only available for certain 
Fields.

Equals
The data stored in the Field must exactly match the specified value.

• Sample Condition: REQUESTER INITIALS equals “TBN.”

The resulting subset will only include records with “TBN” as the requester initials. Records with 
“TB”, “BTN”, and “NT” will not be included.

Does Not Equal
The data stored in the Field may be anything but the value you specify.

• Sample Condition: DEPARTMENT does not equal “DIETARY.”

The resulting subset will only include records that do not have “DIETARY” as the department.

Begins With
The data stored in the Field must begin with the specified value.

• Sample Condition: CONTROL NUMBER begins with “AC.”

The resulting subset will include records that have “AC017”, “AC060”, “AC035”, and “AC200”, etc. 
as the control number.

Contains
The data stored in the Field has the specified value anywhere in that Field.

• Sample Condition: REQUEST TEXT contains “TELEPHONE SWITCH INSTALL.”

The resulting subset will include records that have “TELEPHONE SWITCH INSTALL” as part of the 
request text.

Note: A Filter can have an arbitrary number of Conditions. HEMS processes Con‐
ditions in the order they appear in the Filter window. Values that pass the first 
Condition are then evaluated against the second Condition and so forth until all 
Conditions have been processed. Think of a Filter as a progressively finer sieve 
where each Condition further refines the resulting subset.
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Does Not Contain
The data stored in the Field does not have the specified value anywhere in that Field.

• Sample Condition: REQUEST TEXT does not contain “TELEPHONE SWITCH INSTALL.”

The resulting subset will include records that do not have “TELEPHONE SWITCH INSTALL” as part 
of the request text.

Is Unknown
The data stored in the specific Field has an unknown or null value.

• Sample Condition: PRIORITY is unknown.

The resulting subset will include records that do not have a specified priority.

Is Not Unknown
The data stored in the specific Field has a known value.

• Sample Condition: PRIORITY is not unknown.

The resulting subset will include records that have a specified priority.

Is Greater Than
The data stored in the Field has a value that exceeds the specified value.

• Sample Condition: STATUS DATE is greater than 5/01/2009.

The resulting subset will include records that have dates later than 05/01/2009 as the start date.

Is Greater Than or Equal
The data stored in the Field has a value that exceeds or equals the specified value.

• Sample Condition: STATUS DATE is greater than or equal to 5/01/2009.

The resulting subset will include records that have dates later than or equal to 05/01/2009 as the 
start date.

Is Less Than
The data stored in the Field has a value that is less than the specified value.

• Sample Condition: STATUS DATE is less than 5/01/2009.

The resulting subset will include records that have dates earlier than 05/01/2009 as the start date.

Is Less Than or Equal
The data stored in the Field has a value that is less than or equals the specified value.

• Sample Condition: STATUS DATE is less than or equal to 5/01/2009.

The resulting subset will include records that have dates earlier than or equal to 05/01/2009 as 
the start date.
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Is Between
The data stored in the Field has a value that is more than the specified minimum and less than 
the specified maximum.

• Sample Condition: STATUS DATE is between 5/01/2009 and 07/01/2009.

The resulting subset will include records that have dates between (but not equal to) 05/01/2009 
and 07/01/2009 as the start date.

Is One Of
The data stored in the Field has a value that is equal to one of the specified possible Values. This 
Operator can process up to 10 separate “equals” operations at once.

• Sample Condition: DEPARTMENT is one of, “SPECIALTY CLINIC,” “HEALTH CLINIC,” or “DENTAL 
CLINIC.”

The resulting subset will include records where the department equals any one of the above 
three Values.

Is Yes
The data stored in the Field has a value of (or equal to) Yes.

• Sample Condition: ACTIVE equals, “YES.”

The resulting subset will include all active records.

Is No
The data stored in the Field has a value of (or equal to) No.

• Sample Condition: ACTIVE equals, “NO.”

The resulting subset will include all inactive records.

Satisfied
The data stored in the Field has a value equal to Satisfied.

• Sample Condition: SATISFACTION LEVEL equals, “SATISFIED.”

The resulting subset will include records where the Satisfaction Level Field has the value, “SATIS‐
FIED.”.

Note: This Operator is only available for the Satisfaction Level Field.
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Not Satisfied
The data stored in the Field has a value equal to Not Satisfied.

• Sample Condition: SATISFACTION LEVEL equals, “NOT SATISFIED.”

The resulting subset will include records where the Satisfaction Level Field has the value, “NOT 
SATISFIED.”

Can’t Say
The data stored in the Field has a value equal to Can’t Say.

• Sample Condition: SATISFACTION LEVEL equals, “CAN’T SAY.”

The resulting subset will include records where the Satisfaction Level Field has the value, “CAN’T 
SAY.”

Connectors
A described above (see “Filter Components” on page 222), Connectors connect Operators. In 
general, a Connector can be either an “AND” or an “OR.” An AND Connector means that both of 
the Conditions it connects must be true in order to include a record in the subset. An OR Connec‐
tor means that either one or both Conditions can be true in order to include a record in the sub‐
set. For example:

• If Condition A is “LEAD ENGINEER EQUALS JG” AND Condition B is “STATUS EQUALS OPEN” 
then a record must have LG assigned as the Lead Engineer and a Status of OPEN in order to 
be included in the subset. Records where LG is not the Lead Engineer and/or where the Sta‐
tus is not OPEN are not included in the subset.

• If Condition A is “LEAD ENGINEER EQUALS JG” OR Condition B is “STATUS EQUALS OPEN” 
then a record must have either LG assigned as the Lead Engineer or a Status of OPEN in order 
to be included in the subset. Records where LG is not the Lead Engineer but where the Status 
is OPEN or records where LG is the Lead Engineer but where the Status is not OPEN are 
included in the subset.

Note: This Operator is only available for the Satisfaction Level Field.

Note: This Operator is only available for the Satisfaction Level Field.
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The words, “and” and “or” can be confusing when discussing Filters because their meaning can 
be the opposite of how they are used in normal English. For example, if you want to print out 
work orders requested by both the DIETARY CENTER and the DIALYSIS CENTER, common sense 
says that you should use an AND Connector. The problem with this approach is that using an AND 
Connector in this case will search for work orders that were requested by both departments and 
return no results because work orders can only be requested by one department. In this case, 
using an OR Connector will return work orders that have been requested by either the DIETARY 
CENTER or the DIALYSIS CENTER, which matches your search for.

You can avoid confusion by remembering that the Filter checks each record for each Condition. 
In this example, it is impossible for the DEPARTMENT to have more than one value per record; an 
OR Connector is therefore the correct one to use.

HEMS includes the following Connectors:

• A and B: Both Condition A and Condition B must be true to return a matching result.

• A or B: Either Condition A or Condition B can be true to return a matching result.

• A and not B: Condition A must be true and Condition B must be false in order to return a 
matching result.

• Not A and B: Condition A must be false and Condition B must be true in order to return a 
matching result.

• Not A and Not B: Both Condition A and Condition B must be false in order to return a match‐
ing result.

• A or Not B: Either Condition A must be true or Condition B must be false in order to return 
matching result.

• Not A or B: Either Condition A must be false or Condition B must be true in order to return a 
matching result.

• Not A or Not B: Either Condition A or Condition B must be false in order to return a matching 
result.

You may use parentheses to nest search criteria and form even more complex search queries. For 
example:

• Status=Open OR Status=Pending AND Initials=JDH: In this example, HEMS searches the Filter 
in the order it is written and returns all work orders that are open OR those that have a status 
of Open with JDH's initials.

• (Status=Open OR Status=Pending) AND Initials=JDH: In this example, adding the parentheses 
forces the Filter to first search inside parentheses to return open or pending work orders that 
are assigned to JDH.
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Creating a Filter
When creating a Filter, there is a 
slight difference between adding 
the first Condition and any subse‐
quent Conditions.

Adding the First Condition
To add the first Condition to the Fil‐
ter you are creating:

1. Click the Switch to Filter Mode 
button (funnel) in the window 
you are currently working in to 
switch the Search Area into Fil‐
ter Mode.

2. In the Search Area, click the Fil‐
ter button to open the Filter window.

3. Click the Add button to open the Filter Condition window. Please see “Filter Components” 
on page 222 for more information about Conditions.

4. Select the Field to base the Filter on using the Field pull‐down menu.

5. Select the Operator using the Operator pull‐down menu. Please see “Operators” on page 223 
for more information about Operators.

6. Enter your desired value in the Value Field by either:

‐ Manually entering text into the Field, or

‐ Clicking the Value... button (if enabled) to open 
the Select Values window where you can select a 
predefined value and then click OK to place your 
selection in the Field. This is a great way to speed 
up Filter creation and reduce errors.

7. Click OK to close the Filter Condition window and add 
your selected Condition to the Filter window.
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Adding Conditions to a Filter
To continue adding Conditions to a Filter:

1. Click the Add button in the Filter win‐
dow to open the Filter Condition win‐
dow. 

2. Select the Connector that will be used 
to connect the Condition you are creat‐
ing to the previous Condition in the 
current Filter using the Connection 
pull‐down menu. Please see “Connec‐
tors” on page 226 for more information 
about Connectors.

3. Select the Field to base the Filter on 
using the Field pull‐down menu.

4. Select the Operator using the Operator 
pull‐down menu. Please see “Opera‐
tors” on page 223 for more information 
about Operators.

5. Enter your desired value in the Value Field by either:

‐ Manually entering text into the Field, or

‐ Clicking the Value... button (if enabled) to open the Select Values window where you can 
select a predefined value and then click OK to place your selection in the Field. This is a 
great way to speed up Filter creation and reduce errors.

6. Click OK to close the Filter Condition window and add your selected Condition to the Filter 
window.

7. Repeat this procedure for any additional Conditions you want to add to the current Filter.

Counting Records
You can get a quick idea of how well your Filter is working by counting the number of records 
that match the Filter Conditions. To do this, click the Count button in the Filter window. The 
result appears in a HEMS pop‐up window.

Running the Filter
Clicking OK in the Filter window closes the window and displays the records that match your cur‐
rent Filter in the Search Results Area of the window you are currently working in.

You may reopen the Filter window at any time by clicking the Filter button in the Search Area of 
the window you are currently working in. The Filter window appears with your Filter informa‐
tion, allowing you to edit, store, or clear the Filter.
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Editing Filters
You can edit Filters in the Filter window using any combination of the following methods:

• Select the Condition you want to edit and then click the Edit... button to open the Filter Con‐
ditions window with the current Condition. Alter the Connector, Field, Operator, and/or 
Value and then click OK.

• Reorder the Conditions by clicking and dragging them up or down in the Filter window. 

• Delete a Condition by selecting it and then clicking the Delete button.

• Clear all Conditions by clicking the Clear button.

Managing Filters
HEMS allows you to store and retrieve Filters for repeated use. You can also use stored Filters as 
the basis for new Filters by retrieving a stored Filter and then editing it as described above. You 
can also store the edited Filter using the same name (to overwrite the old version of the Filter) or 
using a different name (to store the new version of the Filter without overwriting the old ver‐
sion).

Storing a Filter
To store a Filter: 

1. In the Filter window, click the More >> 
button.

2. Click the Store... button to open the 
Save Filter window.

3. Enter a name for the Filter in the Name 
Field. If you are editing an existing Filter 
and keep the same name, then this will 
overwrite the previous version of the 
Filter. You must change the Filter name 
to save it without overwriting the previ‐
ous version.

4. Enter a description of the Filter in the 
Description Field.

5. Click OK to store your Filter and close 
the Save Filter window.

Note: Remember that HEMS processes Conditions in the order they appear in 
the Filter. Reordering Conditions can therefore alter the subset of records 
returned by the Filter. Click the Count button to see how reordering Conditions 
is affecting the number of matching records. Also, keep in mind that you may 
need to edit the Connectors after reordering the Conditions.
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Retrieving a Stored Filter
To retrieve a stored Filter:

1. In the Filter window, click the More>> button.

2. Click the Retrieve... button to open the Select Filter 
window, which displays a list of all the currently stored 
Filters.

3. Select the Filter you want to retrieve and then click OK 
to close the Select Filter window and return to the Fil‐
ter window with the retrieved Filter loaded.

Removing a Stored Filter
To remove (delete) a stored Filter:

1. In the Filter window, click the More>> button.

2. Click the Remove... button to open the Select Filter window, which displays a list of all the 
currently stored Filters.

3. Select the Filter you want to remove and then click OK to close the Select Filter window and 
remove the selected Filter.
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CHAPTER 12:
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Printing
HEMS allows you to print report data from reports generated using either the Reports sidebar or 
by clicking one of the buttons (such as List Report, Detail Report ‐ All, or Detail Report ‐ Current) 
in the dashboards, Information Lists, etc.).

To print HEMS data:

1. Launch the report you want to run. See “CHAPTER 10: Reports” on page 195 for more infor‐
mation about HEMS reports.

2. In the browser window, select your desired filter criteria and then click the View Report but‐
ton.

3. When your report appears, click the Print icon next to the Export link (not in your 
browser toolbar).

4. The Windows Print window appears, allowing you to specify such options as:

‐ Which printer to print to.

‐ Which page(s) to print.

‐ How many copies of the report to print.

‐ Other advanced options (by clicking the Properties button).

5. Select your desired print options and then click the Print button.
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Exporting
HEMS allows you to export report data from reports generated using either the Reports sidebar 
or by clicking one of the buttons (such as List Report, Detail Report ‐ All, or Detail Report ‐ Cur‐
rent) in the dashboards, Information Lists, etc.).

To export HEMS data:

1. Launch the report you want to run. See “CHAPTER 10: Reports” on page 195 for more infor‐
mation about HEMS reports.

2. In the browser window, select your desired filter criteria and then click the View Report but‐
ton.

3. When your report appears, select your desired export format 
using the Export pull‐down menu. The available options are:

‐ XML with report data

‐ CSV (comma delimited)

‐ TIFF

‐ Adobe Acrobat (PDF)

‐ Web archive

‐ Microsoft Excel (1997‐2003 format)

4. Click the Export link, which highlights once you select your desired export format.

5. The Windows File Download window appears, allowing you to specify the drive/folder 
in which to save or open the exported data.
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This page intentionally left blank.
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HEMS Security Modes
HEMS can operate in one of two security modes:

• Network Security: Network (Windows LDAP) security mode allows a user to connect to 
HEMS Server using her or his Windows login.

• HEMS Security: HEMS security mode allows a user to connect to HEMS Server using a user 
name and password that is unique to HEMS.

Note: The security mode used by your HEMS system was determined before HEMS 
was installed. 
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Admin Toolbar
The Toolbar contains buttons that provide quick access to commonly used functions. The but‐
tons included on the Toolbar vary depending on whether the Toolbar is in Normal or Admin 
mode. Please see “Toolbar” on page 37 for information about the Toolbar buttons available in 
Normal mode.

The Toolbar contains the following buttons when in Admin mode: 

Exit HEMS Button
Clicking the Exit HEMS button logs you out of HEMS and exits the application.

Find Button
Clicking the Find button opens the Find window, which allows you to search for the desired 
record. Please see “CHAPTER 11: Finding Data” on page 219 for more information about finding 
data in HEMS.

List Button
Clicking the List button opens the List window, which displays a list of all 
of the records in the current list (such as HEMS users). To use the List 
window:

1. Use the Utilities menu to open your desired window.

2. Click the List button in the Toolbar.

3. Scroll through the list to find your desired entry. You can sort the col‐
umns by clicking the column headers.

4. Click the entry and then click OK to open your selected entry in the window you are working 
in. You may now edit, copy, or delete this entry.

First Button
Clicking the First button opens the first record of the type you are looking at (such as users).

Note: For clarity, this image shows all Toolbar buttons active. The active buttons 
you will actually see depend on the functions available at the moment. Unavail‐
able buttons will appear grayed out.

Exit HEMS

Find

New Copy Delete

Save Refresh

Close

List

First Previous

Next Last
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Previous Button
Clicking the Previous button opens the previous record of the type you are looking at (such as 
users).

Next Button
Clicking the Next button opens the next record of the type you are looking at (such as users).

Last Button
Clicking the Last button opens the last record of the type you are looking at (such as users).

New Button
Clicking the New button creates a new record of the same type you are currently working with.

Copy Button
Clicking the Copy button creates a copy of the record you are currently viewing. You can then 
edit this record as needed. This can speed repetitive tasks such as adding multiple pieces of the 
same type and model of equipment to your inventory.

Delete Button
Clicking the Delete button deletes the record you are currently viewing. A confirmation dialog 
appears, asking you to confirm or cancel the deletion.

Save Button
Clicking the Save button saves the record you are currently working on to the HEMS database.

Cancel Button
Clicking the Cancel button cancels your most recent action.

Note: You cannot delete any record that has had an action performed on it or that 
has been used in HEMS because it is part of your history. You can deactivate a 
record by clearing the selected record’s Active checkbox, and can configure HEMS 
to not display inactive records. Please see “Deactivating Equipment” on page 119 
for more information.

CAUTION: DELETED RECORDS CANNOT BE RECOVERED. DO NOT DELETE 
RECORDS UNLESS YOU ARE ABSOLUTELY SURE THAT THEY SHOULD BE PERMA‐
NENTLY REMOVED FROM THE HEMS DATABASE.
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Refresh Button
Clicking the Refresh button refreshes the record you are currently viewing with the most recent 
information from the HEMS database.

Close Button
Clicking the Close button closes the window you are currently viewing. You will be prompted to 
save any unsaved changes.

CAUTION: UNSAVED CHANGES ARE PERMANENTLY LOST AFTER THE RECORD IS 
CLOSED.
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User Management
This section describes how to add, edit, deactivate, and delete HEMS users.

Adding a User
Your HEMS system includes one Administrator login (user name and password) that is used to log 
into HEMS for the first time and begin adding users.The process you use to add a new user to 
HEMS depends on whether HEMS is set up to use Windows or HEMS security.

Before adding a person as a HEMS user, that person must already be entered as an employee in 
the Employees Information List. Please see “Employees List” on page 126 for more information 
about the Employees Information List.

Windows Security
To add a user to HEMS using Windows security:

1. Contact your Information Services department to add the user to the HEMS network security 
group.

2. Select Utilities>Security>Users to open the Users window.

3. Either click the New button in the Toolbar or 
press [CTRL]+[N] to add a new user to the sys‐
tem. 

4. Enter the new user’s HEMS user name in the 
User Name field.

5. Use the Default Service Area pull‐down menu 
to select that user’s default Service Area. 
Please see “Service Area Configuration” on 
page 263 for information about configuring Service Areas.

6. Select the employee who will use this user account using the Employee pull‐down menu. The 
First, Middle, and Last name fields will automatically fill with the selected employee’s infor‐
mation. These fields use values from the Employees Information List. Please see “Employees 
List” on page 126 for more information about the Employees Information List.

Note: You should create Control Groups and Menu Groups before adding users to 
HEMS. Please see “Control Groups” on page 252 for more information about Con‐
trol Groups and “Menu Groups” on page 257 for more information about Menu 
Groups.

CAUTION: THE USERS WINDOW OPENS IN EDIT MODE. BE CAREFUL NOT TO 
MAKE CHANGES TO THE RECORD THAT APPEARS WHEN YOU FIRST OPEN THE 
WINDOW.
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7. Control permissions regulate the actions (i.e. what a user can do) available to a given HEMS 
user or group of users. If you know the Control Group you want to add the user to, enter that 
group name in the Control Group field, or click the Permissions button to open the Control 
Permissions window. Grant the new user the proper control permissions necessary to com‐
plete her or his work. Please see “Control Groups” on page 252 for more information about 
control permissions in HEMS.

8. Menu permissions control the menu options available to a given HEMS user or group of 
users. If you know the Menu Group you want to add the user to, enter that group name in 
the Menu: Group field, or click the Permissions button to open the Menu Permissions win‐
dow. Grant the new user the proper menu permissions necessary to complete her or his 
work. Please see “Menu Groups” on page 257 for more information about menu permissions 
in HEMS.

9. The Login Status button appears checked when the selected the user is currently logged into 
HEMS. This allows the administrator to see who is logged into HEMS at any given time.

10. The Multiple Login checkbox is checked by default. This allows the user to log into HEMS 
from more than one computer at the same time. 

11. Checking the Security checkbox gives the selected user access to the HEMS security func‐
tions (Users, Passwords, and Permission Groups). Clearing this checkbox denies the selected 
user access to these functions.  

HEMS Security
To add a user to HEMS using HEMS security:

1. Contact your Information Services department to add the user to the HEMS network security 
group.

2. Select Utilities>Security>Users to open the Users window.

3. Either click the New button in the Toolbar or 
press [CTRL]+[N] to add a new user to the sys‐
tem. 

4. Enter the new user’s HEMS user name in the 
User Name field.

CAUTION: RESTRICT ACCESS TO THE HEMS SECURITY FUNCTIONS TO THOSE 
USERS WITH A VALID NEED TO ACCESS THOSE FUNCTIONS, IN ORDER TO 
ENHANCE SECURITY AND DATA INTEGRITY.

Note: The Password Area of the Users window is disabled when using Windows 
security.

CAUTION: THE USERS WINDOW OPENS IN EDIT MODE. BE CAREFUL NOT TO 
MAKE CHANGES TO THE RECORD THAT APPEARS WHEN YOU FIRST OPEN THE 
WINDOW.
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5. Use the Default Service Area pull‐down menu to select that user’s default Service Area. 
Please see “Service Area Configuration” on page 263 for information about configuring Ser‐
vice Areas.

6. Select the employee who will use this user account using the Employee pull‐down menu. The 
First, Middle, and Last name fields will automatically fill with the selected employee’s infor‐
mation. These fields use values from the Employees Information List. Please see “Employees 
List” on page 126 for more information about the Employees Information List.

7. Control permissions regulate the actions available (i.e. what a user can do) to a given HEMS 
user or group or users. If you know the Control Group you want to add the user to, enter that 
group name in the Control Group field, or click the Permissions button to open the Control 
Permissions window. Grant the new user the proper control permissions necessary to com‐
plete her or his work. Please see “Control Groups” on page 252 for more information about 
control permissions in HEMS.

8. Menu permissions control the menu options available (i.e. where a user can go) to a given 
HEMS user or group of users. If you know the Menu Group you want to add the user to, enter 
that group name in the Menu: Group field, or click the Permissions button to open the Menu 
Permissions window. Grant the new user the proper menu permissions necessary to com‐
plete her or his work. Please see “Menu Groups” on page 257 for more information about 
menu permissions in HEMS.

9. Enter the user’s temporary password in the Temporary Password field. Passwords are case‐
sensitive. When the user enters HEMS Enterprise for the first time, s/he will be prompted to 
enter a new password of her or his choosing.

10. If applicable, enter the date that the user’s password was last changed in the Last Change 
field in MM/DD/YYYY format.

11. Enter the number of days that a password will be valid before HEMS will prompt the user to 
set a new password in the Period field. This number does not affect the temporary password, 
which the user will need to change the first time s/he logs into HEMS. HEMS users and 
administrators can change passwords at any time. Please see “Password Management” on 
page 249 for more information about managing passwords within HEMS.

12. Checking the Login Status button indicates that the selected the user is currently logged into 
HEMS. This allows the administrator to see who is logged into HEMS at any given time. Clear‐
ing this checkbox indicates that the selected user is not currently logged into HEMS.

13. Checking the Multiple Login checkbox allows the user to log into HEMS from more than one 
computer at the same time. The user can also reenter HEMS if the application terminates 
abnormally (such as if the power goes out). 

14. Checking the Security checkbox gives the selected user access to the HEMS security func‐
tions (Users, Passwords, and Permission Groups). Clearing this checkbox denies the selected 
user access to these functions.  

CAUTION: RESTRICT ACCESS TO THE HEMS SECURITY FUNCTIONS TO THOSE 
USERS WITH A VALID NEED TO ACCESS THOSE FUNCTIONS, IN ORDER TO 
ENHANCE SECURITY AND DATA INTEGRITY.
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Editing a User
To edit a user:

1. Select Utilities>Security>Users to open the Users window.

2. Find the user you want to edit by either:

‐ Clicking the Find button in the Toolbar and entering the desired user’s Last Name and 
First Name and/or ID in the Find User window and then clicking OK, or

‐ Clicking the List button and using the List window to find the desired user. Please see “List 
Button” on page 239 for information about using the List button and window.

3. The selected user’s information appears in the Users window. Edit the user’s information as 
needed.

4. Save your work by clicking the Save button in the Toolbar.

Deleting a User
Deleting a HEMS user denies that person access to HEMS. It does not remove that person from 
the Employees Information List because this information is part of your organization’ history. 
Please see “Employees List” on page 126 for more information about the Employees Information 
List.

The process of deleting a user depends on whether HEMS is set up using Windows or HEMS 
security.

Windows Security
Users who need to be removed as HEMS users must be deactivated by your Information services 
department. Once deactivated, this person will no longer be able to access HEMS.

HEMS Security
To delete a HEMS user using HEMS security:

1. Select Utilities>Security>Users to open the Users window.

2. Find the user you want to edit by either:

‐ Clicking the Find button in the Toolbar and entering the desired user’s Last Name and 
First Name and/or ID in the Find User window and then clicking OK, or

‐ Clicking the List button and using the List window to find the desired user. Please see “List 
Button” on page 239 for information about using the List button and window.

3. The selected user’s information appears in the Users window. Edit the user’s information as 
needed.

4. Click the Delete button in the Toolbar to delete the selected person. You are prompted to 
confirm the deletion.
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Configuring User Defaults
HEMS allows individual users to configure their own report and work order defaults by Service 
Area. Setting up your own report defaults reduces clutter in the Reports sidebar by displaying 
only those reports that you need to run. Setting up your own work order defaults makes opening 
work orders faster and more accurate by having certain fields (such as Requester, Location, 
Assigned Engineer, Priority, etc.) automatically filled in every time you open a new work order 
from the Work Orders dashboard. HEMS customizes work order defaults by Service Area; if you 
have access to more than one Service Area, you will need to set your defaults for each Service 
Area you have access to. 

Reports Sidebar Defaults
To customize the Reports sidebar: 

1. Select Utilities>User Configura‐
tion to open the User Configu‐
ration window.

2. Select the Reports Sidebar tab 
to view all available HEMS 
reports in a hierarchical (tree) 
format with individual reports 
grouped under their respective 
categories.

3. Expand and collapse report cat‐
egories to view the report(s) 
you want to include or exclude 
in the Reports sidebar:

‐ To expand a collapsed 
report category, click the + 
icon next to the category 
you want to expand.

‐ To collapse an expanded report category, click the ‐ icon next to the category you want to 
collapse.

4. Select which report(s) you want to include or exclude in your Reports sidebar:

‐ To include a report in your Reports sidebar, check the checkbox next to the selected 
report.

‐ To exclude a report from your Reports sidebar, clear the checkbox next to the selected 
report.

Note: HEMS overrides the department, location, and assigned engineer work 
order defaults when opening work orders from the Equipment Inventory dash‐
board because work orders created from that location are associated with equip‐
ment.
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5. Select a report category and then click the Set Reports 
Order button to open the Configure Reports Sidebar 
window with all of the reports in the current report 
category listed. 

6. Arrange the reports in the order you would like them 
to appear by clicking the button next to the selected 
report and dragging it up or down.

7. Repeat Step 6 for each report in each group that you 
want to reorder, until you have all of the reports 
arranged as you would like them to appear in the 
Reports sidebar.

8. Close the Configure Reports Sidebar window.

9. Save your changes by clicking the Save button at the 
bottom of the User Configuration window.

To restore the HEMS reports defaults, click the Reset to 
Defaults button in the User Configuration window and 
then click Save. Reports will now appear as configured in 
the Reports sidebar.

Work Order Defaults
To customize your work order 
defaults: 

1. Select Utilities>User Configura‐
tion to open the User Configu‐
ration window.

2. Select the Work Order Defaults 
tab to view a list of work order 
fields with the current default 
values displayed.

3. Select the first field you want to 
modify and then either:

‐ Click the arrow next to the 
selected field to open a list 
of available values for that 
field, or
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‐ Press [F2] or right‐click the selected field to open the Search window for the selected 
field, which allows you to find and select a value. Please see “Find Button” on page 239 
for more information about the Search window. 

4. Repeat Step 3 for each of the fields you want to customize.

5. Click Save when finished to save your changes.

If you want to customize your work order defaults for a different Service Area, you must first 
change Service Areas by selecting Activities>Change Service Area. Please see “Change Service 
Areas” on page 27 for more information about changing Service Areas. 

You must either restart HEMS Enterprise or change Service Areas by selecting Activities>Change 
Service Area to save the default settings.

User Reports
Selecting Utilities>Security>Users Report opens a separate browser window with a report that 
lists the User ID, Name, Default Service Area, Control Group (see “Control Groups” on 
page 252), and Menu Group (see “Menu Groups” on page 257) of all current HEMS users.

You can print and/or export this report. Please see “CHAPTER 12: Printing & Exporting Data” on 
page 233 for more information about printing and exporting HEMS reports.

Note: Selecting default values for some fields will automatically set defaults for 
other related fields as well. For example, customizing the Requester field auto‐
matically customizes the Location and Department fields as well.

Note: This report is only available if you are using HEMS security.
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Password Management
This section describes how to manage passwords in HEMS, if you are using HEMS security. See 
“HEMS Security Modes” on page 238 for more information about HEMS security modes.

Viewing and Changing Passwords
You can view and or change an individual user’s password and default Service Area, which is use‐
ful in case of a lost or forgotten password. The user must already be a valid HEMS user who has 
been entered as an employee in the Employees Information List (see “Employees List” on 
page 126) and who has a HEMS user account (see “User Management” on page 242). To view 
and change a user’s password:

1. Select Utilities>Security>Passwords to open the Passwords window. 

2. Find the user whose password you want to 
view or edit by either: 

‐ Clicking the Find button in the Toolbar and 
entering the desired user’s Last Name and 
First Name and/or ID in the Find User win‐
dow and then clicking OK, or

‐ Clicking the List button and using the List 
window to find the desired user. Please see 
“List Button” on page 239 for information about using the List button and window.

3. The selected user’s information appears in the Passwords window.

4. To edit the user’s password, enter the new password in the Password field.

5. Checking the Access checkbox grants the user access to this function; clearing it denies 
access.

6. Save your work by clicking the Save button in the Toolbar.

CAUTION: THE PASSWORDS WINDOW OPENS IN EDIT MODE. BE CAREFUL NOT 
TO MAKE CHANGES TO THE RECORD THAT APPEARS WHEN YOU FIRST OPEN 
THE WINDOW.

Note: This function is only available when using HEMS security. Contact your 
Information Services department for password help when using network security.
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Controlling Password Usage
You can specify HEMS passwords requirements for all HEMS users using the Password Setup win‐
dow. To do this:

1. Select Utilities>Security>Password Setup to 
open the Password Setup window. 

2. Set the following values:

‐ Warning Days: The Warning Days field dis‐
plays the number of days in advance to 
warn a user before her or his password 
expires. The warning appears when the 
user logs in and allows them to change 
their password immediately.

‐ Change Character: The Change Character field specifies the character that users can use 
to change their password at any time by appending that character to their password in 
the Login window. For example, if the selected character is “?” and a user’s current pass‐
word is “hello” then entering “hello?” allows the user to change her or his password 
immediately.

‐ Password No ID: Checking the Password No ID checkbox prevents HEMS users from using 
a password that is the same as their user ID. Clearing this checkbox removes this restric‐
tion.

‐ Minimum Length: The Minimum Length field contains a number from 1 to 10 that speci‐
fies the least number of characters that can make up a password.

‐ Maximum Length: The Maximum Length field contains a number from 1 to 10 that spec‐
ifies the greatest number of characters that can make up a password.

‐ Prior Passwords: The Prior Passwords field contains a number that specifies how many 
prior passwords will be checked to prevent duplicate entry. For example, a value of 1 
means that the user cannot reuse her or his current password; a value of 5 means that 
the user’s current and previous four passwords cannot be used.

3. Click OK to save your changes and exit the Password Setup window.

Note: This function is only available when using HEMS security. Contact your 
Information Services department for password help when using network security.
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Password Report
Selecting Users>Security>Passwords Report opens a separate browser window with a report 
that lists the User ID, Name, and Password (see “Viewing and Changing Passwords” on 
page 249) of all current HEMS users.  

You can print and/or export this report. Please see “CHAPTER 12: Printing & Exporting Data” on 
page 233 for more information about printing and exporting HEMS reports.

Note: This report is only available if you are using HEMS security.

CAUTION: ALLOWING UNAUTHORIZED PERSONNEL TO ACCESS THIS REPORT 
CAN COMPROMISE THE SECURITY AND CONFIDENTIALITY OF HEMS DATA. KEEP 
ALL PRINTED OR EXPORTED COPIES OF THIS REPORT SECURE FROM UNAU‐
THORIZED ACCESS.
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Permissions Management
HEMS security allows you to define what users can do (such as adding, copying, editing, or delet‐
ing) in the Control Group and where users can go (such as which Service Areas and security 
options they can access) in the Menu Group. Permissions are assigned by creating Control and 
Menu Groups and then assigning permissions to each group. You can then assign users to differ‐
ent groups. This allows you to quickly and easily assign the appropriate level access to multiple 
HEMS users at once.

 Control Groups
HEMS Control Groups control access to different HEMS functions. Every HEMS user is assigned to 
a Control Group, which makes adding or removing permissions for a groups of employees fast 
and easy for HEMS administrators. Different Control Groups have access to different functions, 
which boosts security by allowing HEMS administrators to grant employees only those functions 
they need to do their jobs.

HEMS includes the following default Control Groups, which may be copied and edited as needed 
to meet your requirements:

• ADM: Administrator

• SUP: Supervisor

• WCO: Work Coordinator

• MWR: Maintenance Worker

• CCR: Call Center

• GEN: Read‐Only

The spectrum of access to HEMS functions is as follows:

• No access: The function cannot be accessed at all.

• Read‐Only Access (RO): Users can read information but cannot alter it.

• Add/Edit Access: Users can read, add, and edit information but cannot delete it.

• Edit Access: Users can read and edit information but cannot add or delete it.

• Full Access: Users can read, add, edit, and delete information.

The table on the following page lists the HEMS Control Groups and the permissions assigned to 
each group by default. You can edit permissions for a given Control Group and can also add, edit, 
and delete Control Groups.
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The following table uses the following notation:

• ADM: Administrator group.

• SUP: Supervisor group.

• MWP: Maintenance worker ‐ Plant.

• MWB: Maintenance worker ‐ Biomed.

• GEN: Read‐only group. 

• X: Full access.

• A: Add access.

• E: Edit access.

• RO: Read‐Only access.

• Blank: No access.

Action ADM SUP MWP MWB GEN
Full Access X

Partial Access X X X X
Activities X

Change Service Area X X
Assign Work Orders X X

Contracts X
Equipment Inventory X A/E RO A/E

Generate Scheduled Work Orders X X
Parts Inventory X A/E A/E

Part Transactions X A/E A/E
Quick Equipment Activities X X X

Quick Work Orders X X X
Schedules X

Work Orders X A/E A/E
Information Lists X

Departments X RO
Device Inclusions X

Employees X RO
Equipment Classes X A
Equipment Groups X A/E
Equipment Models X A/E RO A
Equipment Systems X A
Equipment Types X RO A

Locations X A/E RO RO
Maintenance Specialties X

Part Types X A/E
Predefined Text X RO RO

Procedures and Tasks X A/E RO RO
Purchase Orders X A/E
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Adding a Control Group
To add a Control Group:

1. Select Utilities>Security>Control Permission Groups 
to open the Control Permission Groups window and a 
Find window that helps you select an existing Control 
Group. 

2. Click Cancel to close the Find window.

3. Click the New button in the Toolbar and then enter 
the following information:

‐ Group Code: Enter a 3‐character code for the Con‐
trol Group you are creating in the Group Code 
field.

‐ Description: Describe the Control Group you are creating in the Description field.

‐ Comments: Enter any additional information in the Comments field.

4. Click Permissions to open the 
Control Permissions window, 
which contains the following 
information: 

‐ Forms/Controls: The 
Forms/Controls column 
contains a detailed break‐
down of the HEMS forms 
and controls.

Seasons X
Shifts X RO

Subcodes X RO RO RO
Vendors X A/E RO A

Work Order Codes X
Work Order Priorities X

Work Order Status X
Work Order Types X

medTester X X
Utilities X

Replace Values X
Security X

Service Area & Specialty Rates X
Equipment Management X

Service Area Configuration X
User Configuration X E E E

Action ADM SUP MWP MWB GEN
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‐ Denied: The Denied column displays an X for each form and control that is not available 
to the current Control Group.

5. Specify the permissions for the current Control Group using any combination of the following 
methods in any order:

‐ Double‐clicking an allowed control permission denies the selected control permission 
from the current Control Group and places an X in the Denied column.

‐ Double‐clicking a denied control permission allows that control permission to the current 
Control Group and removes the X from the Denied column.

‐ Clicking the Grant to All button grants all available HEMS control permissions to the cur‐
rent Control Group.

‐ Clicking the Deny to All button denies all available HEMS control permissions to the cur‐
rent Control Group.

6. Click OK to close the Control Permissions window.

7. Click the Save button in the Toolbar to save your new Control Group.

Copying a Control Group
Copying an existing Control Group 
saves time when you want to add a 
new Control Group that is slightly 
different from a current User or 
Control Group. To copy a Control 
Group:

1. Select Utilities>Security>Con‐
trol Permission Groups to open 
the Control Permission Groups 
window and a Find window that 
helps you select an existing 
Control Group.

2. Select the Control Group you 
want to copy and then click the Copy Perm... button to open the Copy Permissions window, 
which allows you to copy the permissions that are currently assigned to an existing User or 
Control Group.

3. Check the User or Control radio button, as appropriate.

4. Select the existing group to copy.

5. Click Copy to copy the selected permissions and close the Copy Permissions window.

6. Follow Steps 4‐7 of the Add Control Group procedure, above.

AUTHORED BY ANTHONY HERNANDEZ - (415)786-2081 - anthony94122@outlook.com
255Copyright 2010, EQ2, Inc. All rights reserved.



CHAPTER 13: Administration
Editing Control Groups
To edit a Control Group:

1. Select Utilities>Security>Control Permission Groups to open the Control Permission Groups 
window and a Find window that helps you select an existing Control Group. 

2. Enter the Control Group’s 3‐character code in the Control Group Code field and then click OK 
to close the Find window and place the desired Control Group’s information in the Control 
Permission Groups window. You may also leave the Control Group Code field blank and click 
OK to retrieve all of the Control Groups, and then select the one you want to edit.

3. Follow Steps 4‐7 of the Add Control Group procedure on page 254.

Deleting a Control Group
To delete a Control Group:

1. Select Utlities>Security>Control Permission Groups to open the Control Permission Groups 
window and a Find window that helps you select an existing Control Group. 

2. Enter the Control Group’s 3‐character code in the Control Group Code field and then click OK 
to close the Find window and place the desired Control Group’s information in the Control 
Permission Groups window. You may also leave the Control Group Code field blank and click 
OK to retrieve all of the Control Groups, and then select the one you want to delete.

3. Click the Delete button in the Toolbar. You are prompted to confirm the deletion.

CAUTION: DELETED CONTROL GROUPS ARE PERMANENTLY REMOVED FROM 
HEMS.
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Menu Groups
HEMS Menu Groups control the windows users have access to, such as Service Area, Activities, 
Information Lists, and Security. Every HEMS user is assigned to a Menu Group, which makes add‐
ing or removing permissions for a group of employees fast and easy for HEMS administrators. 
Different Menu Groups have access to different functions, which boosts security by allowing 
HEMS administrators to grant employees only those functions they need to do their jobs.

Adding a Menu Group
To add a Menu Group:

1. Select Utlities>Security>Menu Permission Groups to 
open the Menu Permission Groups window and a 
Find window that helps you select an existing Menu 
Group. 

2. Click Cancel to close the Find window.

3. Click the New button in the Toolbar and then enter 
the following information:

‐ Group Code: Enter a 3‐character code for the 
Menu Group you are creating in the Group Code 
field.

‐ Description: Describe the Menu Group you are creating in the Description field.

‐ Comments: Enter any additional information in the Comments field.

4. Click Permissions to open the 
Menu Permissions window, 
which contains the following 
information: 

‐ Menu Field: The Menu field 
displays the current HEMS 
menu.

‐ Menu Options: The Menu 
Options column contains a 
detailed breakdown of the 
HEMS forms and windows.

‐ Denied: The Denied col‐
umn displays an X for each form and control that is not available to the current Menu 
Group.
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5. Specify the permissions for the current menu by using any combination of the following 
methods in any order:

‐ Double‐clicking an allowed menu permission denies the selected menu permission from 
the Menu Group and places an X in the Denied column.

‐ Double‐clicking a denied menu permission allows that menu permission to the Menu 
Group and removes the X from the Denied column.

‐ Selecting a menu permission and checking the Grant or Deny radio button adds your 
desired permission to the selected menu position.

‐ Clicking the Next Menu button moves to the next HEMS menu and allows you to grant or 
deny individual permissions for that menu.

‐ Clicking the Previous Menu button moves to the next HEMS menu and allows you to 
grant or deny individual permissions for that menu.

‐ Clicking the Grant to All button grants all available HEMS menu permissions for all menus 
to the Menu Group.

‐ Clicking the Deny to All button denies all available HEMS menu permissions for all menus 
to the Menu Group.

6. Click OK to close the Menu Permissions window.

7. Click the Save button in the Toolbar to save your new Menu Group.

Copying a Menu Group
Copying an existing Menu Group 
saves time when you want to add a 
new Menu Group that is slightly dif‐
ferent from a current User or Menu 
Group. To copy a Menu Group:

1. Select Utilities>Security> Per‐
mission Groups to open the 
Control Permission Groups win‐
dow and a Find window that 
helps you select an existing 
Control Group.

2. Select the Menu Group you 
want to copy and then click the 
Copy Perm... button to open the Copy Permissions window, which allows you to copy the 
permissions that are currently assigned to an existing User or Control Group.

3. Check the User or Control radio button, as appropriate.

4. Select the existing group to copy.

5. Click Copy to copy the selected permissions and close the Copy Permissions window.

6. Follow Steps 5‐7 of the Add Menu Group procedure, above.
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Editing Menu Groups
To edit a Menu Group:

1. Select Utlities>Security>Menu Permission Groups to open the Menu Permission Groups 
window and a Find window that helps you select an existing Menu Group. 

2. Enter the Menu Group’s 3‐character code in the Menu Group Code field and then click OK to 
close the Find window and place the desired Menu Group’s information in the Menu Permis‐
sion Groups window. You may also leave the Control Group Code field blank and click OK to 
retrieve all of the Menu Groups, and then select the one you want to edit.

3. Follow Steps 5‐7 of the Add Menu Group procedure on page 257.

Deleting a Menu Group
To delete a Menu Group:

1. Select Utlities>Security>Menu Permission Groups to open the Menu Permission Groups 
window and a Find window that helps you select an existing Menu Group. 

2. Enter the Menu Group’s 3‐character code in the Menu Group Code field and then click OK to 
close the Find window and place the desired Menu Group’s information in the Menu Permis‐
sion Groups window. You may also leave the Control Group Code field blank and click OK to 
retrieve all of the Menu Groups, and then select the one you want to edit.

3. Click the Delete button in the Toolbar. You are prompted to confirm the deletion.

CAUTION: DELETED MENU GROUPS ARE PERMANENTLY REMOVED FROM 
HEMS.
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Equipment Management
Selecting Utilities>Management Tools>Equipment Management opens the Equipment Man‐
agement window, which allows managers to update multiple equipment items (such as updating 
scheduling information) at once.

The Equipment Management window appears as follows:

To use the Equipment Management window:

1. Search for the equipment item(s) you want to update using the Search Area.

2. Select the equipment item(s) to update in the Search Results Area and then move that infor‐
mation to the Selection Area using the following Selection buttons:

‐ Clicking the >> button moves all of the equipment item records in the Search Result Area 
to the Selection Area.

‐ Clicking the > button moves the currently selected equipment item record in the Search 
Result Area to the Selection Area.

‐ Clicking the < button removes the currently selected equipment item record from the 
Selection Area back to the Search Results Area.

‐ Clicking the << button removes all of the equipment item records in the Selection Area 
back to the Search Results Area.

Note: The technician’s Quick Equipment Activities window includes a subset of 
the functions available in the Equipment Management window. Please see 
“The Quick Equipment Activities Window” on page 101 for more information 
about the Quick Equipment Activities window.

Search Area

Search
Results

Area

Selection
Area

Selection
Buttons

Action 
Area
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3. Update the equipment item(s) by using the Selection pull‐down menu to select the informa‐
tion you want to update and then updating that information in the field(s) that appear. Avail‐
able options are:

‐ Activate: Activate the selected equipment item(s).

‐ Add Equipment Text: Add notes to the Equipment Text field in the selected equipment 
item record(s).

‐ Add Work Order Notes: Add text to the Work Order Notes field. This text will appear in 
the work order Request Text field.

‐ Assigned Engineer: Assign an engineer to the selected equipment item(s). This option 
uses values from the Employees Information List. Please see “Employees List” on 
page 126 for more information about the Employees Information List.

‐ Deactivate: Deactivate the selected equipment item(s).

‐ Department: Department the selected equipment item(s) belong to.

‐ Device Inclusion: Device inclusion for the selected equipment item(s). This option uses 
values from the Device Inclusions Information List. Please see “Device Inclusions List” on 
page 126 for more information about the Device Inclusions Information List.

‐ Equipment Model: Model of the selected equipment item(s). This option uses values 
from the Equipment Models Information List. Please see “Equipment Models List” on 
page 131 for more information about the Equipment Models Information List.

‐ Location: Where the selected equipment item(s) are located. This option uses values 
from the Locations Information List. Please see “Locations List” on page 140 for more 
information about the Locations Information List.

‐ Ownership: Who owns the selected equipment item(s).

‐ Purchase Cost: How much each of the selected equipment item(s) cost to purchase.

‐ Purchase Date: Date the selected equipment item(s) were purchased.

‐ Retire: Retire the selected equipment item(s) and assign an engineer to perform retire‐
ment maintenance on those items. Please see page 263 for information about assigning a 
default retirement procedure for the Service Area.

‐ Schedule by Date: Indicates where the schedule date is defined (such as by equipment 
type, model, or item).

Note: When replacing one model with another, it is recommended that you run 
the impact report by clicking the Run Impact Report button. The report lists all of 
the equipment for the selected model to allow you to review the impact on sched‐
uling before making this equipment model change.
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‐ Schedule Date for Multi Year Schedule: The seed date for multi year scheduling when 
you want to override the default date that comes from an equipment item’s Placed in 
Service Date or Purchase Date. For example, you may need to inspect batteries annually 
and replace them every three years

‐ Service Expiry Date: Date the service contract ends for the selected equipment item(s).

‐ Storage In: Date the selected equipment item(s) were moved into storage, and the loca‐
tion they were moved to.

‐ Storage Out: Date the selected equipment item(s) were moved from storage, and the 
location they were moved to.

‐ Supplier: Supplier who provides the selected equipment item(s). This information is 
drawn from the Vendors Information List. Please see “Vendors List” on page 153 for more 
information about the Vendors Information List.

‐ Warranty Expiration Date: Warranty expiration date for the selected equipment item(s).

4. Checking the Add Text at Top checkbox adds text to the top of the work order Request Text 
field.

5. Either click the Apply button or press [CTRL]+[S] to save your updates to the selected equip‐
ment item record(s).

The Report/Print buttons provide quick access to relevant reports. From the left to right, the 
buttons are:

• List Report: Clicking the List Report button opens a summary report for all of the equipment 
items in the Selection Area.

• Detail Report ‐ All: Clicking the Detail Report ‐ All button opens a detailed report for all of 
the equipment items in the Selection Area.

• Detail Report ‐ Current: Selecting an equipment item in the Selection Area and then clicking 
the Detail Report ‐ Current button opens a report that provides detailed information about 
the currently selected equipment item.

Reports appear in a separate browser window. You can print and/or export these reports, as 
described in “CHAPTER 12: Printing & Exporting Data” on page 233.
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Service Area Configuration
HEMS allows you to configure general, pager/email, and labor rate settings for each Service Area. 
You can configure your current Service Area only; to configure a different Service Area, you must 
first change Service Areas by selecting Activities>Change Service Areas. Please see “Change Ser‐
vice Areas” on page 27 for more information about changing Service Areas.

General Service Area Options
To specify general Service Area options:

1. Select Utilities>Management 
Tools>Service Area Configura‐
tion to open the Service Area 
Configuration window with the 
General tab selected. 

2. Select the Service Area Adminis‐
trator/Coordinator for the cur‐
rent Service Area by selecting 
the appropriate user in the 
Administrator/Coordinator 
field. You must define this per‐
son in order to enable auto‐
matic pager/email work order 
notifications. This field uses val‐
ues from the Employees Infor‐
mation List, which is described 
in “Employees List” on 
page 126.

3. Select the default incoming 
inspection procedure for all equipment added to the Service Area inventory using the Incom‐
ing Inspection field. This field uses values from the Procedures Information List, which is 
described in “Procedures List” on page 146.

4. Select the default retirement procedure for all equipment being removed to storage in the 
Service Area using the Retirement Procedure field. This field uses values from the Proce‐
dures Information List, which is described in “Procedures List” on page 146.
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5. Select the default source for the schedule date for the current Service Area by checking the 
appropriate Schedule By Date radio button. The available options are:

‐ None: No schedule by date default.

‐ EQ Type: The default schedule by date is defined in the Equipment Types Information 
List, which is described in “Equipment Types List” on page 134.

‐ Manf/Model: The default schedule by date is defined in the Equipment Models Informa‐
tion List, which is described in “Equipment Models List” on page 131.

‐ Department: The default schedule by date is defined in the Departments Information 
List, which is described in “Departments List” on page 124.

‐ Location: The default schedule by date is defined in the Locations Information List, which 
is described in “Locations List” on page 140.

‐ Equipment: The default schedule by date is defined by each equipment item recorded in 
the Equipment Inventory window, which is described in “The Equipment Inventory Win‐
dow” on page 89.

6. Check the Show only active items in the list checkbox if you only want to see active elements 
in the HEMS Information Lists.

7. Set your preferences for work order department and location information when creating new 
routine or corrective (unscheduled) work orders from the Work Orders dashboard. The avail‐
able options are, in order of preference:

‐ Manually Specify: Manually enter work order department and location information.

‐ From Control #: Location and department information are based on the equipment item.

‐ From Requester: Location and department information are based on the requester.

‐ From Default Values: Location and department information are based on the work order 
defaults.

‐ Disable auto updating of Work Order department and location in Edit Mode: Checking 
the Disable auto updating of WO’s dept/loc in Edit mode checkbox prevents the work 
order department and location from being overwritten by the system. You can manually 
update this information if needed.

8. Select how many days work orders may be edited before they are locked to prevent any fur‐
ther changes by entering a number in the Lock closed work orders after field. The default 
value is 9,999 days.

9. For equipment items that are on a service contract, you can specify whether or not to auto‐
matically use the contract end date (in the Contracts window) to automatically fill the Equip‐
ment Service Exp Date field by checking or clearing the Use contract end date as the service 
expiration date checkbox. Please see “CHAPTER 9: Managing Contracts” on page 183 for 
more information about working with contracts in HEMS.

10. Either click Save to save your changes, or select the Pager/Email Settings tab to continue set‐
ting up the current Service Area’s notification settings.
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Pager/Email Service Area Options
To specify pager and/or email noti‐
fication options for the current Ser‐
vice Area: 

1. Maker sure that the Adminis‐
trator/Coordinator has been 
defined in the General tab, as 
described in “General Service 
Area Options” on page 263.

2. Select Utilities>Management 
Tools>Service Area Configura‐
tion to open the Service Area 
Configuration window.

3. Select the Pager/Email Set‐
tings tab. 

4. Enter the server address of the 
pager/email address or name in 
the Server Address field. For 
example, if your pager address 
is (415)555‐1212@mypagerservice.com”, then enter “mypageraddres.com” in this field.

5. Specify whether you want email and/or pager notification by checking the Email and/or 
Pager checkboxes, as appropriate.

6. Select the information that will be included in notifications to maintenance engineers/tech‐
nicians by checking the appropriate Information to be sent to the engineer checkboxes. You 
may include any combination of the following:

‐ Requester: Checking the Requester checkbox includes the name of the person requesting 
the work order in the notification.

‐ Department: Checking the Department checkbox includes the name of the department 
requesting the work order in the notification.

‐ Request: Checking the Request checkbox includes the text of the work order request in 
the notification.

‐ Work Order Type: Checking the WO Type checkbox includes the work order type in the 
notification.

‐ Location: Checking the Location checkbox includes the location of the equipment that 
needs servicing in the notification.

‐ Specialty: Checking the Specialty checkbox includes the maintenance specialty required 
for the work order in the notification.

‐ Priority: Checking the Priority checkbox includes the work order priority in the notifica‐
tion.
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‐ Estimated Hours: Checking the Estimated Hrs checkbox includes the estimated number 
of hours required to perform the preventive maintenance in the notification.

‐ Subcode: Checking the Subcode checkbox includes the work order subcode in the notifi‐
cation.

7. Either click Save to save your changes, or select the Pager/Email Settings tab to continue set‐
ting up the current Service Area’s notification settings.

Service Area and Specialty Rates
You may define a standard Service Area labor rate and Specialty Rates. If both are defined, the 
Specialty is the labor rate default, otherwise, the Service Area Standard Rate is used. If neither 
are defined, the employee's labor rate is used (if defined in the employee's record).

To specify a Service Area rate and/or Specialty Rates: 

1. Select Utilities>Manage‐
ment>Service Area and Spe‐
cialty Rates to open the Service 
Area and Specialty Rates win‐
dow for the current Service 
Area with all of the specialties 
from the Maintenance Special‐
ties Information List and a stan‐
dard rate for the Service Area. 

2. Click the Edit button.

3. Click the rate to change in the 
Hourly Rate column that corre‐
sponds to the correct specialty 
or standard rate, and then enter 
the correct rate.

4. Repeat Step #3 for all of the 
rates you want to specify.

5. Click the Save button to save 
your changes. Clicking the Preview button opens a separate browser window with a report 
that displays the specialty and standard rates.

AUTHORED BY ANTHONY HERNANDEZ - (415)786-2081 - anthony94122@outlook.com
266 January 2010 - Revision 1.0



HEMS Enterprise 5.x User & Administrator Guide
Error Logs
HEMS maintains error logs that you can send to EQ2 Technical Support upon request to help 
diagnose any problems that you may be experiencing with HEMS. To retrieve an error log:

1. Select Utilities>Errors... to open a Find window that lets you specify the following informa‐
tion: 

‐ From Date: Enter the earliest date for which you want error information in the From Date 
field.

‐ To Date: Enter the most recent date for which you want error information in the To Date 
field.

‐ Check the appropriate Users radio button to specify whether you want the error informa‐
tion to include data from the Current user or All users.

‐ Check the appropriate Applications radio button to specify whether you want to the 
error information to include the Current HEMS application or All HEMS applications 
(including the optional add‐on modules described in “CHAPTER 15: Add‐on Modules” on 
page 281).

2. Click OK to open the Errors win‐
dow with the most recent error 
that matches your search crite‐
ria displayed. 

3. You may use the List button in 
the Toolbar to display other 
errors. Please see “List Button” 
on page 239 for more informa‐
tion about the List button.

4. You have the following options 
for each error:

‐ View a memory dump in a 
separate window by click‐
ing the Memory button.

‐ View the error’s current sta‐
tus by clicking the Status button.

‐ Copy the error log to the Windows Clipboard for pasting into another application (such as 
Microsoft Word) by clicking the To Clipboard button.

5. Close the Errors window when you have finished viewing HEMS errors.
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Data Management
Over time, data can get cluttered because of typos, variant spellings, etc. For example, variant 
vendor spellings may include, “HP”, “Hewlett Packard”, “Hewlett Packard, Inc.”, etc. HEMS allows 
you to replace terms that you don’t want or use with terms that you do want and use. You can 
replace values in the following Information Lists:

• Accounting Subcodes

• Departments          

• Device Inclusion

• Employees

• Equipment (EQ) Types

• Equipment (EQ) Models

• Locations

• Maintenance Specialty

• Part Types

• Priority

• Procedure Types

• Procedures

• Purchase Orders

• Seasons 

• Task Types

• Tasks

• Vendor Suppliers

• Vendor Manufacturers

• Work Order (WO) Codes

• Work Order (WO) Status

• Work Order (WO) Types

CAUTION: REPLACING VALUES PERMANENTLY ALTERS YOUR HEMS DATA. THIS 
PROCESS CANNOT BE REVERSED. ALWAYS MAKE A BACKUP OF YOUR HEMS 
DATA BEFORE REPLACING VALUES.
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Replacing Values
To replace values:

1. Select Utilities>Replace Values>List (where List is the Information List that contains the val‐
ues that you want to replace. For example, to replace Vendors text (i.e. to replace multiple 
variant spellings of a vendor such as “Gen Elec,” “GE,” etc. with one standard such as “Gen‐
eral Electric”), select Utilities>Replace Values>Vendors. This opens the Replacement Mod‐
ule window.

2. Search for the value you want to replace using the Search Area. The available Search Area 
fields will vary depending on the type of value you are replacing.

3. Move the selected value(s) to the Selection Area using the following Selection buttons:

‐ Clicking the >> button moves all of the values in the Search Result Area to the Selection 
Area.

‐ Clicking the > button moves the currently selected value in the Search Result Area to the 
Selection Area.

‐ Clicking the < button removes the currently selected value from the Selection Area back 
to the Search Results Area.

‐ Clicking the << button removes all of the values in the Selection Area back to the Search 
Results Area.

Search
Area

Search
Results

Area
Selection

Area

Selection
Buttons

Replacement Value Area
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4. Select the value in the Search Results Area that you want to use as the new replacement 
value by either:

‐ Right‐clicking the value you want to use as the replacement value and then selecting Use 
as Replacement, or

‐ Clicking the value you want to use as the replacement value and then clicking the Use the 
selected item as a replacement button.

5. Check the Delete the items after replace checkbox if you want to automatically delete the 
values you replaced (because of typos, bad entries, etc.). Clear this checkbox if you want to 
preserve the old values for future use.

6. If available, check the Global checkbox to make your changes across all Service Areas. Clear‐
ing this checkbox replaces values for the current Service Area only.

7. Click Apply to make the replacement. You are prompted to confirm your decision.

8. When you are finished, click Cancel to close the Replacement Module window.

Note: You cannot delete system values.

Note: When replacing models and types, it is recommended that you run the 
impact report by clicking the Run Impact Report button. The report lists all of the 
equipment for the selected model/type to allow you to review the impact on 
scheduling before making this equipment model/type change.
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Reports
You can run HEMS reports from the Utilities menu in addition to from the Reports sidebar. To run 
a report from the HEMS Utilities menu:

1. Select Utilities>Reports to open the Reports window.

2. Expand and collapse the report categories to locate the report you want to run:

‐ To expand a collapsed report category, click the + icon next to the category you want to 
expand.

‐ To collapse an expanded report category, click the ‐ icon next to the category you want to 
collapse.

3. Select the report you want to run by double‐clicking it to open the selected report in a sepa‐
rate browser window.

Please see “CHAPTER 10: Reports” on page 195 for more information about HEMS reports.
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Frequently Asked Questions
This section answers some of the most frequently asked questions that HEMS users submit to 
EQ2 Technical Support.

I added a new user to both the Employees Information List and the User window but s/he can‐
not log into HEMS.

• Make sure that s/he has typed your password correctly; remember that HEMS passwords are 
case sensitive.

• Check with your Information Services department to make sure that the new user has been 
added to the HEMS network group.

• If you are using Windows security, check with your Information Services department to make 
sure that the user’s Windows Login Account is not locked.

• Verify that your Windows password has not expired by logging out of Windows and then log‐
ging back in.

If you still cannot log into HEMS after checking all of the above, please contact EQ2 Technical 
Support as described in “Technical Support” on page 280.

I am trying to access a report but see a window telling me that, “the server requires a user‐
name and password.” Why am I getting this prompt?

• If you are using Windows security, check with your Information Services department to make 
sure that the new user has been added to the HEMS network group.

• If you are still seeing this message, use this procedure to log into the server:

1. Log into HEMS with the affected user's HEMS user name and password.

2. Open a report in a separate browser window and then click Cancel when you are 
prompted to enter a user name and password.

3. In the browser window, select Tools>Internet Options>Security and then click the Local 
Intranet icon.

4. Click the Sites button to open the Local intranet window and then click the Advanced 
button.

5. Enter the report server address in the Add this website to the zone field (such as http://
hemsserver/) and then click Add.

6. Click Close.

7. Click OK.
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• If you are still seeing being prompted to log into the server:

1. Log into HEMS with the affected user's HEMS user name and password.

2. Open a report in a separate browser window and then click Cancel when you are 
prompted to enter a user name and password.

3. In the browser window, select Tools>Security Options>Security and then click the 
Trusted Sites icon.

4. Click the Sites button to open the Trusted sites window.

5. Enter the report server address in the Add this website to the zone field (such as http://
hemsserver/) and then click Add.

6. Click Close.

7. Click OK.

If you still cannot log into HEMS after checking all of the above, please contact EQ2 Technical 
Support as described in “Technical Support” on page 280.

My report is not displaying results that I know are stored in the HEMS database. I see the mes‐
sage, “Cannot read the next data row for the data set graph (rserrorreadingnextdatarow).”

• Check for bad dates in the Work Orders dashboard, such as 0/01/8200 by performing the fol‐
lowing searches one at a time and correct any results you find:

1. WO Issue Date: >01/01/ of the year after the current year.

2. WO Issue Date: <01/01/1960.

3. WO Status Date: >01/01/ of the year after the current year.

4. WO Status Date: <01/01/1960.

• For labor dates, set the following filters. Please see “Filters” on page 222 for more informa‐
tion about filters.

1. WO Lbr Entries/Start Date: >01/01/ of the year after the current year.

2. WO Lbr Entries/Start Date: <01/01/1960.

If you are still getting this error after checking all of the above, please contact EQ2 Technical Sup‐
port as described in “Technical Support” on page 280.

My monthly scheduled preventive maintenance work orders did not print. How can I print 
them?

1. Open the Work Orders dashboard.

2. In the WO Type field, enter “Scheduled” (or “Sch”).

3. Enter the appropriate dates in the Issue Date To and Issue Date From fields.

4. Make sure that the Pending checkbox is checked. 
AUTHORED BY ANTHONY HERNANDEZ - (415)786-2081 - anthony94122@outlook.com
275Copyright 2010, EQ2, Inc. All rights reserved.



CHAPTER 14: Help & Support
5. Click Search.

6. Print from the Work Orders dashboard by clicking the Print Technician’s Copy (Actual) ‐ 
All button above the Search Results Area.

How can I email a report?

1. Export the report to your desired format after running it. Please see “Exporting” on 
page 235 for information about exporting reports.

2. In your email application, attach the exported report to an email message and send the 
email when ready.

How do I look up equipment history?

There are three ways to do this.

• To view a dynamic interactive history that you can review, update work orders, or print:

1. Open the Equipment Inventory dashboard.

2. Enter the control number for the desired equipment item and then click Search.

3. Click the H button in the Action Area to open the Equipment History window for the 
selected equipment item.

4. Resize or sort the columns by dragging the headers.

5. Double click any work order or select it and then click the Edit button to update, edit or 
close the selected work order.

6. Print the history by either clicking the appropriate Report Type radio buttons (List 
Report, Actual (Technician’s Copy), or Summary) and then clicking the Preview button, 
or by running a report and then printing that report, as described in “Printing” on 
page 234.

• To view an equipment item’s entire history in a report format that includes equipment infor‐
mation, work order summaries, and graphs, open either the Equipment Inventory or Work 
Orders dashboard, and then click the blue Control # link.

To view an equipment item’s history with additional work order details or that falls within a cer‐
tain date range, click the Work Order button in the Reports sidebar, and then select the WO 
Equipment Review (Detail) report.

Why I am I seeing more or fewer records than I expect after entering search conditions?

• HEMS displays 50 records at a time, which means that your result(s) may be on subsequent 
page(s). If you are seeing too many results, navigate through the pages to find the informa‐
tion you are looking for using the Navigation (arrow) buttons. If you are still seeing too many 
results, narrow your search criteria.
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• If your search returns too few results (or no results), you may have additional search condi‐
tions left from your previous search. To clear these extra conditions:

1. Click the Reset button to clear your search.

2. Double‐check your spelling and then click Search.

3. By default, searches return only active records. Select either Inactive Only or Both Active 
and Inactive to include inactive records in your search, if needed.

If you are still having this problem after checking all of the above, please contact EQ2 Technical 
Support as described in “Technical Support” on page 280.

Why am I getting a semiannual scheduled preventive maintenance work order for a piece of 
equipment that is scheduled annually?

• Run the Schedule report from the Equipment Inventory dashboard by clicking the S button 
in the Action Area. This report will display the source of the semiannual scheduling (Risk, 
Department or Location).

I need to update several scheduled work orders with the same Action Text and Labor entries, 
except that each labor entry has different times. What is the most efficient way to update 
these work orders?

1. Open the Quick Work Orders window and the locate the work orders you want to update.

2. Select one of the work orders and make your desired changes, then click Apply to move the 
work order back to the Search Results Area and highlight it in blue.

3. Select the next work order. The changes made to the previous work order will remain, until 
you click the Reset button.

4. Change the labor start time and/or total time, and then click Apply.

5. Repeat Steps 3 and 4 until all of your work orders have been updated.

Why isn’t the assigned technician receiving pager notifications for her or his assigned work 
orders?

• Verify that the pager number for the affected technician is defined in her or his employee 
record using the Employees Information List. Please see “Employees List” on page 126 for 
more information about the Employees Information List.

• Verify that the work coordinator is defined for the Service Area and that s/he has a valid 
email address specified in her or his employee record in the Employees Information List. 
Please see “Service Area Configuration” on page 263 for more information about adding a 
work coordinator to a Service Area and “Employees List” on page 126 for more information 
about the Employees Information List.

• Verify that the pager server address or name is correctly specified by selecting Utilities>Man‐
agement Tools>Service Area Configuration, as described in “Pager/Email Service Area 
Options” on page 265.
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• Verify that the pager is working properly by sending a message to that pager from your email 
client.

If you are still having this problem after checking all of the above, please contact EQ2 Technical 
Support as described in “Technical Support” on page 280.

Why do I get an error message that says, “Unable to load client print” when I try to print a 
report?

This can happen for several reasons:

• When HEMS was installed on your desktop computer, your Information Services department 
forgot to install the RSClientPrint (ActiveX) component. This control can be installed by log‐
ging on to your desktop with local administrator rights and then printing any one report. 
Once this is done, you can log on to your desktop normally and reports should print normally.

• Your desktop computer was updated with a security patch released in late 2008 but the 
server was not updated with the required patch. Contact your Information Services depart‐
ment to install the patch on the server where the Reporting Services are installed.

How can I check equipment items that are not scheduled but that have risk greater than the 
minimum risk value to fall under the equipment management program, and also include the 
unscheduled equipment items with undefined risk? 

Click the Equipment button in the Reports sidebar, and then select the Management Program 
Inventory report.

I use the same incoming inspection procedure for most of my equipment items. How can I 
quickly specify that procedure in HEMS?

Specify the incoming inspection to use by selecting Utilities>Management Tools>Service Area 
Configuration, as described in “General Service Area Options” on page 263.

I use the same retirement procedure for most of my equipment items. How can I quickly spec‐
ify that procedure in HEMS?

Specify the retirement procedure to use by selecting Utilities>Management Tools>Service Area 
Configuration, as described in “General Service Area Options” on page 263.

How can I attach file types that are not listed in the File Types list?

You can attach non‐supported file types by ZIPping the file you need to attach and then attaching 
the ZIP file.
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The document I am trying to attach is too large.

By default, the maximum size of files that can be attached in HEMS is 3MB. If you need to 
increase this size, contact EQ2 Technical Support.

Note: HEMS restricts file attachment size to conserve hard drive space. EQ2 will 
verify that your Information Services department has sufficient space to store 
larger attachments and that adequate low drive space notifications are in place 
before increasing the default limit.
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Technical Support
EQ2 offers three levels of HEMS technical support. Telephone and email support is free to users 
who are on one of the following service plans, subject to the limits described below for each 
plan.

Bronze Plan
The EQ2 Bronze support plan includes the following coverage:

•  All HEMS maintenance releases.

• Telephone support is available Monday‐Friday from 9:00AM until 5:00PM Eastern.

• 24‐hour response time.

• Two custom reports.

Silver Plan
The EQ2 Silver support plan includes the following coverage:

• All HEMS maintenance releases.

• All HEMS 5.x upgrade releases (such as 5.1, 5.2, etc.).

• Telephone support is available Monday‐Friday from 8:00AM until 6:00PM Eastern.

• 4‐hour response time.

• 10 Custom reports.

Gold Plan
The EQ2 Gold support plan includes the following coverage:

• All HEMS maintenance releases.

• All HEMS 5.x upgrade releases (such as 5.1, 5.2, etc.).

• All HEMS full‐version upgrades (such as 5.x to 6.x).

• Telephone support is available Monday‐Friday from 8:00AM until 6:00PM and Saturday on 
call from 11:00AM to 3:00PM. (All times Eastern.)

• 1‐hour response time.

• 20 Custom reports.

Contacting EQ2 Technical Support
You may contact EQ2 Technical Support by phone at (802)865‐0920 ext. 2 or by emailing sup‐
port@eq2.com.
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CHAPTER 15:
Add-on Modules
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EQ2 medTester Interface
HEMS Enterprise works with the Fluke Biomedical medTester to ensure the smooth and predict‐
able evaluation and testing of critical equipment. The HEMS‐Fluke connection combines the 
medTester’s automated, paperless testing with the intuitive and predictable HEMS Enterprise 
Interface to save time while increasing accuracy, reliability, and quality of care. Medical equip‐
ment professionals need only interpret the various data provided by the medical equipment 
rather then trying to synchronize test auto sequences or results.

Some key features of the HEMS‐medTester connection include:

• One‐click connection to send work orders to the medTester directly from the HEMS Home 
screen.

• Ability to quickly find which work orders to send.

• Automated, logged communications between HEMS and however many medTester units you 
have, simultaneously.

• All work orders are automatically checked for compliance with applicable rules and then 
transmitted to the medTester(s). You can see which medTester has received each work order.

• One‐click connection to receive work orders from the medTester from the HEMS Home 
screen.

• Automatic processing of work orders received from the medTester includes entering detailed 
test results, automatic closing, equipment history updates, and logging time spent on each 
work order.
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EQ2 Mobile
Today’s care environment means hundreds of scheduled equipment work orders spread across 
the hospital, several physician office buildings, and cross‐town surgery centers. EQ2 Mobile 
makes tracking completed work and failure documentation fast, efficient, and paper‐free.

EQ2 Mobile provides wireless real‐time work progress tracking and reporting on facilities and 
biomedical equipment activities to technicians in the field. Installing EQ2Mobile on a Pocket PC 
device provides health care equipment professionals with an easy‐to‐use but powerful tool for 
capturing data and reviewing historical information while continuing to work on site. Information 
can be saved electronically with a stylus click and updates are instantly ready for review, report‐
ing, and action with no delay and no paperwork required.

EQ2 Mobile is a Microsoft‐certified “Designed for Windows® Mobile™for Pocket PC” product 
that meets this challenge using the Microsoft Windows® Powered Pocket PC platform. As part of 
the HEMS Enterprise family of products, EQ2 Mobile is based on Microsoft's SQL Server CE and 
SQL Server 2008.
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EQ2 Alert & Recall
Multiple manufacturers and device type classifications make it difficult to identify, track, and 
take action on equipment alerts and recalls. EQ2’s Smart Alert Search (SAS) process provides fast 
inventory searching with a single click that looks across manufacturer ownership trees and ECRI’s 
UMDNS device type classifications to eliminate unnecessary information. This search enables a 
complete view of all alert/recall candidates with just two clicks, even if they are currently owned 
by non‐nameplate companies. If you’d like to dig deeper, the Advanced Search and Find feature 
can narrow or broaden the search to meet your particular requirements.

EQ2’s Alert and Recall add‐on gives you all alert information right on the same easy‐to‐read, 
color‐coded window; no need to open multiple windows to deal with one or several alerts/
recalls. You can label alerts Applicable, Not Applicable, or Not Reviewed for easy tracking and 
follow‐up. After reviewing equipment and alert, a single click issues the workflow and notifies 
department managers or sets the Alert/Recall status. From there, EQ2’s Alert Report puts action‐
able information at your fingertips. Need a progress update or more details? Select an alert to 
review the activities and information associated with it. Both company‐wide and individual hos‐
pital alerts are visible on the same window, making safety committee reports faster and easier to 
compile.

Access to ECRI Institute Alerts/Recall information is provided by ECRI Institute. EQ2 uses the ECRI 
Institute Subscription Web Service as the delivery of this critical information, which require ECRI 
Institute subscriptions.
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EQ2 Web Enterprise
Today’s care environment means that work requests are constantly arriving from across the hos‐
pital, physician office buildings, and cross‐town surgery centers. EQ2 Web Enterprise harnesses 
the power of the web to connect work requesters to HEMS Enterprise. Requests are as easy as 
logging into a secure web page and creating an electronic work request. EQ2 Web Enterprise 
automatically saves the requester’s name, telephone number, department, and location, then 
emails both the requester and work coordinator confirming acceptance of the work request. 
HEMS Enterprise automatically generates a work order, emails and/or pages the work coordina‐
tor, and then prints that order on the specified printer. You can even configure HEMS to notify 
work coordinators if any equipment warranty and/or service deadlines are approaching.

Once a work order has been created, EQ2 Completion Reporter then tracks the status of the 
work order. When this work is completed, EQ2 Completion Reporter sends an email to the work 
requester notifying him/her that the work has been completed. Requesters can check the work 
order status at any time. Engineers can assign and close requests with just a few clicks. HEMS 
Web Request eliminates paperwork, phone calls, and guesswork. After the work has been com‐
pleted, HEMS automatically forwards a customer satisfaction form to the work requester and 
tabulates the result in a result.

Engineers can review pending work, quickly update and/or close their work orders, and open 
work orders.  In addition, they can locate parts across the organization and run key reports.
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EQ2 HEMS Best Practice
Adhering to corporate best practices and standardized equipment and maintenance lists is cru‐
cial for success, especially in multi‐hospital groups. Standardizing lists reduces confusion and 
helps ensure apples‐to‐apples comparisons of various metrics to ensure success.

EQ2 HEMS Best Practice automatically ensures compliance with your best practices and stan‐
dardized lists. EQ2 Best Practice tracks new additions to the equipment type, inventory, manu‐
facturers, and any other list you want to standardize. It even ensures that the fields you require 
are entered before the equipment is approved for inclusion in active inventory. Your lists stay 
standardized because EQ2 Best Practice approves nothing until you or your designated staff have 
reviewed and approved it.

EQ2 Best Practice also standardizes the relationship between equipment inventory and risk by 
using industry standard questions and values to assign a risk value to each type or model. Risk 
values are checked to determine the minimum interval for preventative maintenance scheduling. 
Scheduling and procedure assignment occur automatically with no guesswork or paperwork 
required on your part.

AUTHORED BY ANTHONY HERNANDEZ - (415)786-2081 - anthony94122@outlook.com
286 January 2010 - Revision 1.0



HEMS Enterprise 5.x User & Administrator Guide
EQ2 HEMS RFID/RTLS
HEMS 5.0’s RFID/RTLS integration is an easy to implement and easy to use solution that increases 
patient safety and quality of care while significantly reducing equipment downtime and mainte‐
nance issues. Clinical equipment managers can now better manage technician assignments and 
performance, initiating service within minutes or hours instead days or weeks.

Work requesters simply switch the RFID tag on malfunctioning equipment to automatically gen‐
erate a work order that includes the equipment location. The appropriate clinical engineer 
receives an email from HEMS with the work order attached.
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EQ2, Inc.

Mailing address:
P.O. Box 1483

Burlington, VT 05401

Technical Support: (802)865‐0920 ext. 2 or support@eq2.com

Sales: (888)312‐HEMS or sales@eq2.com
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